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My favorite quote on the subject of portrait photography comes from photo
consultant and author Martina Mettner, who says, “The idea that a portrait photo
can reveal the subject’s soul or psyche is one of the most lovingly fostered but
nevertheless absurd photographic myths.”

This issue focuses on the world of portrait photography with an in-depth look at the
work of pro photographer Olaf Ballnus, who captured the shot reproduced here. Our
comprehensive workshop takes a look at the gear you need and includes a wealth of
insider tips for shooting great portraits, providing proof that the subject doesn’t
have to be a star to make a great photo.

If Adobe’s new licensing model has prompted you to look for alternatives to
Photoshop, this issue will be right up your street. We compare the pros and cons of
GIMP with the tried and trusted Photoshop approach, and our portrait-editing
workshop will help get you started with the powerful GIMP toolset.

Hardware gets a look in too, and we test the theory that full-frame lenses produce
better images than native-format lenses when used with APS-C cameras. Some of
the results might surprise you.

Have fun with this issue of your favorite photo magazine …

Juergen Rink
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DVD Download

If your copy of the magazine contains no DVD, navigate to
www.ct-digiphoto.com/dvd142013  to download the DVD
content for free. 



Early in the morning on October 19 about 60
people gathered for the first c’t Digital
Photography photo seminar in Santa Monica. 

After morning coffee and a buffet
breakfast, the day’s events began with Ralph
Clevenger, who guided the rapt audience
along the ”Path of Seeing“ as he calls it. 
Thanks to Ralph, we will all look at nature’s
myriad subjects in a different way from now
on. Tim Mathiesen followed this inspiring talk 
by sharing his vast experience of panorama
shooting. He explained in great detail 
about suitable cameras and software and
surprised us by revealing that some of 
his greatest panoramas were captured 

using compact cameras and even a
smartphone. 

Have you ever dreamed of earning money
with your photos? Ian Shive and JP Harrison
gave us the inside line on how to pick the right
images for selling at microstock sites. 

The final speaker was George Lepp, 
who is quite a celebrity among nature
photographers. He thrilled the audience with
his combination of macro and stacked images
of the tiniest bugs and details of feathers. 

Lively discussions accompanied all the
lectures and I am convinced that the first ever
c’t seminar has helped a lot of people to
improve their photography skills. (jr)

c’t Digital Photography Seminar Series: Nature Photography
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Reader Community

Reader Forum

We are always happy to receive your
comments and suggestions in a letter,
an e-mail (editor@ct-digiphoto.com) or
at www.facebook.com/ct-digiphoto.
We reserve the right to abbreviate your
input for publication. Our comments
are printed in italics.

Tell us what
you think:

Inspiring Cover
I’m writing as an amateur artist who picked up
your magazine in the summer because of the
artistry of the cover. I’ve since used the cover
as a reference photo for a water-soluble oil
painting. c’t Digital Photography: The in-depth
quarterly also for the art enthusiast!

Tracy Paddock

Great Lenses for
Speed Freaks 

I have been a buyer (soon to
be subscriber) since issue
#1, which helped persuade
me to buy my first M4/3
camera (Olympus E-P2),
based on your article on
using legacy lenses with
adapters on digital cameras.
In your 1/2010 issue in the
article on high-end legacy
lenses, you say, ”A 50mm
Leica Noctilux becomes a
100mm f0.95 telephoto
when used with an MFT
camera. We will be testing
this dream combo in a
future issue.“ Yes please. 

Could you please make it
a test of all ultra-fast lenses
in the f0.95-f1.2 range,
including the Voigtlander Nokton offerings.
Please also include the 50mm f/1.1 (Leica M
mount) and perhaps even the upcoming
Lumix/Leica M4/3 42.5mm f/1.2 with IS and
AF. How about the earlier Canon RF f/0.95
50mm, the Leica Noctilux 50mm f/1 (preferred
by some for its glow) or the sharper f0.95? And
I recall that Nikon also offered a 50mm f/1.2 in
RF or SLR mounts. 

I am a speed freak lenswise, having two
Noktons (25mm f/0.95 and 50mm f/1.1) for my
OM-D, as well as the Lumix/Leica 25mm f/1.4.

I am also planning to buy the Lumix/Leica
42.5mm f/1.2. 

Give us a detailed look at the ultra-fast lane!
And thanks for a fantastic mag.

Giles Hugo

Bright lenses are indeed a fascinating subject.
Look out for our 42.5mm f/0.95 Voigtländer
Nokton test in Issue 15. This lens is a real
low-light treat for Micro Four Thirds
photographers.

This shot was captured at f0.95 using a 42.5mm f/0.95 Nokton 
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Free DVD | Highlights
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This issue’s free DVD provides a rich selection of photo and editing tools, including a special full version
of the Beauty Pilot portrait retouching software. And, if you are looking for a value alternative to
Photoshop, GIMP and the plug-ins we have included on DVD will help you deploy the full potential of
the open source post-production toolset as part of your own photo workflow.

Digital technology has made producing
photos much cheaper than it was. In

today’s photographers shoot many more
photos than their predecessors, often returning
home from a trip with hundreds or even
thousands of photos ‘in the bag’. 

Keeping such enormous numbers of images
sorted is one of the great challenges of the
digital age. Alongside using date and time data,
using geodata to sort and display photos on
digital maps is an increasingly popular
approach. GeoSetter is a powerful tool for
helping you visualize just where you captured
your favorite shots.

Basic geodata such as longitude, latitude,
altitude and angle of view can be captured and
written to a file’s Exif data using the GPS
modules built into many of today’s cameras.
Easily available accessory modules or tracking
apps for smartphones and tablets can also be
used to record tracking data , which can then be
associated with the appropriate photos using
software like GeoSetter, which can also help you
find locations on a map and add appropriate
tags to untagged photo files. The software
includes IPTC editing and date change
functionality and enables you to synchronize
tags between RAW images and their
corresponding JPEGs. 

This issue’s free DVD includes the Windows
desktop version and the portable version of
GeoSetter 3.4.16. (sea)

Portrait Shoot

Video tutorial: Portrait expert Bert
Stephani uses simple but effective
techniques to transform a conventional
hotel room into an attractive location.

Looking good is hard work, and most photo
models go through a rigorous program of

makeup, hair and body styling before stepping
out in front of the camera. 

Particularly in the beauty genre, the creative
possibilities offered by today’s software are
varied and often fascinating. Beauty Pilot is a
dedicated portrait retouching tool, and this
issue’s DVD includes a special full version of the
software for you to try out.

The software is a kind of ‘digital beauty
parlor’ and is perfect for cleaning up all kinds of
skin blemishes. Just a few simple clicks are all
that is required to ‘iron out’ a portrait. 

The ‘Soft-focus Lens’ feature makes it easy to
produce smooth skin tones and the ‘Elastic’
toolenables you to easily manipulate the shape
of your subject’s physical features to fit the job
at hand. Straightening  someone’s nose has
never been easier. The ‘Eye Color’ tool provides
a simple way to alter the look of your subject’s
eyes using colors selected from a dedicated
picker. There are no limits to the alterations you
can make, and the ‘Original Photo’ feature
enables you to compare each change with the
original version of your image while you
experiment.

Our DVD includes a free full version of Beauty
Pilot 2.3.0 and the code you need to activate it.
c’t Digital Photography readers also receive a
special 50% discount on updates. This offer is
valid until May 18th 2014. (sea)

GeoSetter 3.4.16

Free software: Using geodata is a
great way to keep your photos sorted,
and GeoSetter is a powerful
geotagging tool.

Beauty Pilot 2.3.0

Full version software: Producing
’perfect’ portraits free from unwanted
blemishes isn’t always easy, but Beauty
Pilot is here to help. 

Bert Stephani is a pro photographer who
specializes in creative portrait work.

Stephani’s studio is a converted barn that he
describes as “large, creative, lofty and well
equipped.” For photographers who have to
make do with sub-optimal locations, this
tutorial shows you how to use simple
equipment and props to get the best out of a
space – in this case, a hotel room.

Stephani’s aim was to produce atmospheric
photos that communicate the easy, carefree
feeling of a sunny Sunday morning. The
monotone room had a cool atmosphere
dominated by pale colors and the solution lay
in using a combination of flash, ambient light
and a few cleverly positioned props to
transform the scene. This video takes you step
by step through the process Stephani applied
to ‘build’ the resulting shots.

The footage also includes useful tips on
composing foreground and background details
and offers advice on camera settings.
Experimenting with varying angles of view is an
important part of Stephani’s approach.

In situations like this, it is essential for the
photographer to build up a rapport with the
model, and this video demonstrates perfectly
how to keep the communication between
photographer and model casual but
professional. The result is a series of wonderful
photos that really do feel as if they were
captured in Sunday sunshine. (sea)
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Image Processing Tools

Windows

Beauty Pilot 2.3.0 full version

Inkscape 0.48.4

Inkscape Portable 0.48.4

Plug-In Switch 1.3

StylePix 1.13.0.4

StylePix Portable 1.13.0.4

Mac OS

Inkscape 0.48.4

GIMP & Plug-ins

Windows

15 Vector Brushes

Grunge Brush Pack

More Mask Brushes

Scratchies Brushes

GIMP 2.8.6

GIMP Portable 2.8.6

GREYC’s Magic Image Converter (G’MIC) 1.5.7.1

Color to Mask Pro 1.0

Cool Look filter

Export Layers

Layer Effects

MathMap 1.3.5

YUV Temperature

PSPI 1.0.7

UFRaw 0.19.2

Mac OS

15 Vector Brushes

Grunge Brush Pack

More Mask Brushes

Scratchies Brushes

GIMP 2.8.6

GREYC’s Magic Image Converter (G’MIC) 1.5.7.1

Color to Mask Pro 1.0

Cool Look filter

Export Layers

Layer Effects

MathMap 1.2.4

YUV Temperature

Linux

15 Vector Brushes

Grunge Brush Pack

More Mask Brushes

Scratchies

GREYC’s Magic Image Converter (G’MIC) 1.5.7.1

Color to Mask Pro 1.0

Cool Look filter

Export Layers

Layer Effects

PSPI 1.0.7

Photo Tools
Windows

ExifTool 9.37

GeoSetter 3.4.16

GeoSetter Portable 3.4.16

Geotag 0.086

GPSBabel 1.4.4

Helicon Photo Safe 3.90

Hugin 2012.0.0

IrfanView 4.36

IrfanView PlugIns 4.36

IrfanView Portable 4.36

The Rasterbator 1.21

Mac OS

ExifTool 9.37

Geotag 0.086

GPSBabel 1.4.4

Hugin 2012.0.0

MacPorts 2.2.0

Linux

ExifTool 9.37

Geotag 0.086

GPSBabel 1.4.4

Sample Images
Camera Test Sample Images

APS-C Cameras with Full-frame Lenses

Videos
Shooting Portraits with Ring Light

Creating Atmosphere with Background
Patterns

Portraits Lighting Workshop

High-speed Video with Compact Cameras

Wedding Photography: Workshop with 
Mike Larson
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Portfolio 

Jun Ahn
Jun Ahn is a young South Korean who photographs herself in
breathtaking poses in and on skyscrapers. Along with her
Invisible Seascape and Float sequences, these images have firmly
established her presence on the international photography scene.

Self-portrait 2011



Self-portrait 2012



Jun Ahn has been working on her
self-portrait project since 2008, and the

images are sure to get you catching your
breath, even if you don’t suffer from vertigo.
We see her climbing out of windows,
balancing on the edges of roofs or apparently
preparing to leap into nothingness. The
free-fall perspective and the often wrenching
feeling these images produce in the viewer’s
gut guarantee that you won’t forget them.

She wears the same thin blue dress, 
without shoes or jewelry, in many of the
images, emphasizing the impression of a 
defenseless creature trapped in a gigantic 
cityscape. We find ourselves asking whether
she is aware of the danger of the situation in
which we see her.

Jun Ahn only rarely shows her face and
often shoots self-portraits with her back to the
camera – the pose that some of her most
impressive images are based on. Deliberate

blur often underscores the feeling of lifting off
into the unknown. Broad-ranging notions,
such as ‘life and death’ or ‘past and future’
immediately suggest themselves when
viewing these images.

Ahn sometimes has to wait months to get
permission to shoot in her chosen location,
but has already managed to capture images
in and on more than a dozen buildings in
Seoul, New York and Hong Kong. She shoots
using an ‘enough is never enough’ approach,
switching her camera to drive mode and only
stopping when the memory card is full. From
the thousands of shots that result, she selects
the ones in which she doesn’t appear too 
scared, which gives her quite a limited choice! 

In an interview with the British Journal of
Photography (BJP), she talks about the 
concept behind her work. She is always 
on the lookout for scenes that seem 
unconstrained by time and space, in which

14 c’t Digital Photography 14 (2014)

Self-portrait 2011



Self-portrait 2009
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Portfolio | Jun Ahn

she can capture a moment without context
that would otherwise be lost forever. Her
Invisible Seascape project is made up of
full-frontal shots of waves and foam that
scream of fleeting moments, whereas Float
portrays rocks and stones adrift in the middle
of nowhere, and it is not at all clear whether
the subjects are still lifes, the result of a recent
explosion or something else entirely. 

These three projects have been the
launchpad for Jun Ahn’s international career,
and have led to solo shows in St. Petersburg,
Seoul and Hong Kong. She started studying
photography in graduate school and was
awarded an MFA with honors at Parsons The
New School for Design in New York. She is
currently studying for her doctorate at Hongik
University in Seoul. (jr)

Self-portrait 2010

Self-portrait 2011

Jun Ahn
www.ahnjun.com 

Kips Gallery 
www.kipsgallery.com 



Self-portrait 2009
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Self-portrait 2008
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Thomas Hoffmann, Sophia Sieber

Full-frame vs.
APS-C Lenses

In an attempt to squeeze the very last drop of quality out of their gear, some
photographers use full-frame lenses with APS-C camera bodies. Since these cost
more and are much heavier to carry, we decided to investigate whether this
‘hybrid’ concept provides real, measurable benefits.We tested the Canon 
EOS 7D, the Nikon D7100 and the Sony SLT-A77 with a range of full-frame lenses
and compared the results with those produced by the same cameras using their
‘native’ APS-C equivalents. Some of our findings were quite surprising.

21



The lens is the most important part of a
camera, because it not only creates the

image that the sensor captures but also
determines its quality. It is therefore
essential to choose your lenses carefully. The
idea that using full-frame lenses is the best
way to get the best-quality images out of an
APS-C camera is persistently propagated in
countless online forums. 

The arguments in favor of this idea are
clear, and are based on the size of the image
circle produced by a full-frame lens. In the
illustration below, for example, the diameter
of the image circle is about 43.3 mm,
compared with the 27-28 mm diameter of an
APS-C image circle. It is in the nature of
optics that the number of aberrations and
artifacts (such as vignetting effects and
distortion) increases toward the edge of the
image circle, while the center of the image
circle is largely free of such anomalies.
Because an APS-C sensor only covers the
center portion of the full-frame image circle,
images produced this way should,
theoretically, suffer less from vignetting,
distortion and loss of sharpness toward the
edges of the frame. 

Pixel Size is Critical 

There are, however, other details to be
considered too. The size of the individual
pixels that make up the sensor is one such
critical factor. Although APS-C sensors are a

lot smaller than their full-frame
counterparts, they are not small enough to
eliminate all image artifacts when they are
used with full-frame lenses. 

Distortion, chromatic aberrations and
vignetting effects don’t only appear at the
edges; they can occur across the entire
image circle. Contemporary lenses,
especially zooms, have complicated designs
that produce complex ‘mixed’ barrel and
pincushion distortion. Due to the way they
are built, bright, wide-angle lenses are
particularly susceptible to vignetting effects,
and the best way to avoid these is to stop
the aperture down. The only way to
construct a wide-angle lens that produces
very little vignetting and distortion is to use
large, heavy glass elements, which brings us
neatly back to the idea of using larger (i.e.,
full-frame) lenses to do the job instead.

Although specially coated glass can help
to reduce chromatic aberrations, these can
crop up anywhere within the frame and are
often of varying colors, so they are difficult
to eliminate completely.

The size of the individual pixels in relation
to the size of the sensor – known as pixel
density – also affects the quality of the
results. An APS-C sensor with the same
number of pixels as a full-frame sensor will
usually draw the short straw, unless your
lens is capable of resolving an extremely
high number of line pairs per millimeter. If
this is not the case, you will have to deal with

poorer resolution. The Nikon D7100 and the
Sony SLT-A77, with their 24-megapixel
sensors, therefore present a real challenge
to any lens. Extrapolated to full-frame size,
such dense sensors would have a resolution
of 54 megapixels, compared with the
current market leader in this field, the Nikon
D800, which has a 36-megapixel sensor.

Putting It to the Test

So much for the theory! The only way to find
out which lenses really work best with which
cameras is to test them. We got hold of a
Canon EOS 7D, a Nikon D7100 and a Sony
SLT-A77, which cover three different
systems and provide the best APS-C
technology currently on offer. These are all
highly versatile cameras that are well suited
to enthusiast or semi-professional use.

For our comparison test, we selected the
Canon EF-S 17-55mm f/2.8 IS USM Zoom, the
Nikkor 17-55mm f/2.8 and the Sony SAL
16-60mm f/2.8 APS-C lenses and set them up
against their 24-70mm counterparts from
the full-frame world. We chose the Canon EF
24 -70mm f/4.0 variant, mainly because its
f/2.8 sister costs a stratospheric US$2,300. 

To round things out, we also decided to
test some third-party manufacturers in the
shape of a Sigma 24-70mm Sony lens, a
Tamron 24-70mm for our Nikon and a
Tokina17-35mm f/4 for our Canon EOS 7D.
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Lens Test | Introduction

Full-frame sensor 
36 x 24 mm

APS-C sensor
approx. 24 x 16 mm

Full-frame image 
circle, approx.

 43.3 mm across

Rather than exploiting the entire image
circle produced by a full-frame lens, an
APS-C sensor uses a smaller segment in the
center. In theory, this should produce fewer
image errors and artifacts. 



Lab and Real-world Testing

To give us the most objective comparison
values possible, we put our lenses through a
stringent lab test (see ‘How We Tested’ on
the following pages for more details) as well
as taking them for a spin under real-world
shooting conditions in the Herrenhausen
Gardens in Hanover, which challenged 

our test lenses with plenty of color and
detail.

Lenses with constantly bright apertures
require large, high-quality glass elements in
their designs, so they weigh quite a lot – we
felt we could have done with a golf caddy 
or at least a donkey to help us carry all the
gear we collected. Remember to consider
the weight of a lens when you are planning

a purchase – after all, what use is a 
fantastic lens if it is too heavy for your
planned shoot? 

We ended up making several trips carting
more than 10 kg (22 lbs) of gear through
Hanover and back, not including our tripod,
notebook and other odds and ends. You can
read the results of all this effort starting on
page 26. 
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Lens Test | Test Methods

We tested all our camera/lens combos in real-world outdoor situations
as well as in the lab. This is one of the rare occasions on which you will
find our enterprising c’t editors at work in a rose garden! 
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Lens Test | Test Methods

How We Tested

The following sections explain how we conducted our lens comparison
tests. There are also additional detailed lens analyses included on this
issue’s free DVD, and we explain how to interpret these below. 

Resolution
To start with, we had our in-house lab
analyze all our test lenses. Because it is
impossible to rate a lens independently
from a camera, we tested three different
lenses for each of our three test systems,
using the same EOS 7D, D7100 and SLT-A77
bodies. 

Resolution was tested using a chart made
up of 25 Siemens stars with sine
wave-shaped brightness gradients. We
photographed the chart to fill the frame
twice: once using the maximum aperture
and once stopped down by 2 EV. We
focused manually and captured about 10
shots for each combination of aperture and
focal length. We then used custom software
to evaluate the contrast between the
brightest and darkest parts of each image
for all measurable frequencies. As the
frequency increases – i.e., as the details
become finer – this contrast decreases to 
a value of 10 percent, beyond which the
details in question are no longer
distinguishable. We then calculated the
average cutoff frequency, measured as the
ratio of line pairs to frame height for various
directions within each Siemens star. Our
tables of results below and the results we
have included on this issue’s free DVD
consist of separate measurements for the
center and the (averaged) edge of the
frame.

Distortion
For a test like this, distortion is defined as
the tendency of a lens to reproduce
straight lines looking curved – a
phenomenon that is particularly prevalent
at the edges of photographic images. If
distortion is present, a rectangular object
will end up looking either barrel- or
pin-cushion-shaped, or, in the case of
some modern zoom lenses, will show a
wave-shaped combination of both forms.
We analyzed this aspect of our test lenses
using a chart made up of printer’s register
marks and used it to determine the
distance between each point on the
photographed chart and its equivalent
position under assumed ‘ideal’ conditions.
The results for this section are expressed

in terms of the degree of bend in a line at
the edge of the frame in proportion to its
height. 

Vignetting
The term ‘vignetting’ is used to describe the
disproportionately dark tones that often
occur in gray areas at the edges and corners

of the frame – a phenomenon that is not
limited to consumer-grade cameras with
cheap mass-market lenses. This value 
was measured using a frosted glass
illuminated extremely evenly by an
integrating sphere. For the zoom lenses, 
we recorded values in 1,200 places within
the frame at three different focal lengths,
each focused at infinity.

Twenty-five Siemens stars spread across the entire frame gave us a solid basis for
analyzing the resolution of our test lenses

We used a
chart filled with

register marks
to find out how

much edge
distortion our

lenses
produced
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Lens Test | Test Methods

The distortion charts use the x-axis to indicate the
range from the center to the edge of the frame
and the y-axis to indicate the deviation in the
height of the frame at the edge compared to the
height in the center, measured as a percentage

These three-dimensional
charts show the degree of

shading for the entire
frame, measured in

f-stops. The further the
corners sag, the greater

the vignetting effect. 

The PDFs with the individual lens analyses that you can find on this issue’s free DVD include MTF charts like
the one reproduced here. The curves indicate the number of distinct line pairs that the lens in question can
reproduce, measured over the height of the frame. The x-axis represents the frame from the center (0) to the
edge (100), while the y-axis enumerates the number of line pairs recorded for each x value. The far left-hand
vertical axis indicates the degree of contrast (i.e., the perceived sharpness). The bar charts at far right show
the best and worst resolution values recorded by each camera’s autofocus system.
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f11 f22f8f5.6

ISO100 | 55mm | f5.6 | 1/800s
Top left-hand corner of the c’t test scene

Canon EF-S 17-55mm f/2.8 IS USM

Lens Test | Individual Models

The Lens: With its constant maximum aperture of f2.8, this model is one
of the brightest Canon APS-C zooms on offer. It has an equivalent focal
length range of 27-88 mm and weighs 650 g (about 1½ lb), making it one
of the lighter models among the bright lenses we tested. Its light weight
is due mainly to the large number of plastic components, and the zoom
ring especially appeared quite fragile during our test. If you use this lens
with the camera tipped forward, we recommend that you check that the
zoom setting hasn’t changed before releasing the shutter.

Test Results and Image Quality: The lens delivered similar results across
the entire zoom range but showed weakness at its widest aperture,
especially at the telephoto end of the scale. Our EOS 7D achieved center
resolution of 1430 and edge resolution of 1084 line pairs, which equates
to about 60 per cent of its maximum potential. The chromatic aberration
score of 1.1-1.3 pixels is quite high. Vignetting darkened the edges of the
frame by almost a whole stop and the lens produced both barrel and
pincushion distortion. However, these anomalies were fairly uniform and
shouldn’t be too difficult to eliminate digitally. 

Image quality matched our lab measurements, and the lens produced
clear outdoor results with plenty of contrast but very slightly less
sharpness than we would have liked. The flower images clearly
demonstrate the Canon’s edge weakness. Overall, it produced its best
results at apertures between f4 and f11. Beyond f16, images became
visibly less sharp. 

f2.8

EF-S 17-55mm f/2.8 IS USM
Aperture range / Number of blades f2.8-f22 / 7
Focal lengths (35mm equivalent) 17-55 mm (27-88 mm)
Price (approx. US$) 900
Measured at1 maximum aperture / -2 stops

Center resolution 82% / 83%
Edge resolution 72% / 78%
Chromatic aberration 1.1 pixels
Distortion 1.5%
1 Using mid-range focal length



27c’t Digital Photography 14 (2014)

The Lens: This is a versatile full-frame standard zoom with a constant
maximum aperture of f4. It also features a macro setting that offers 0.7x
magnification (see page 29 for a sample macro image). This feature
makes it really stand out among our test lenses. Build quality is very
good in spite of its relatively light weight of 600 g (1⅓ lb). 

Test Results and Image Quality: The uninspiring results we achieved
bore out the fact that this lens is not designed for use with an EOS 7D.
With regard to resolution, the lens performed on a par with its APS-C
counterpart in the center but produced much less fall-off toward the
edges of the frame. The results of using the lens wide open or stopped
down differed only slightly. This particular camera/lens combo
achieved 81 per cent of its theoretical maximum center resolution wide
open and 82 per cent stopped down at its shortest focal length. The
results were more disappointing at a medium (41mm) focal length
setting, delivering just 66 per cent resolution in the corners when wide
open. Chromatic aberration was only slight at 0.6-0.9 pixels and
vignetting effects were minimal, with only half a stop difference at
maximum aperture and 70mm focal length. The lens also scored highly
with its virtually distortion-free rendition.

Outdoor shots generally showed very good detail contrast and well
rendered textures. This model also produced its best results between
f4 and f11, with some muddiness setting in at f16 and beyond.

f11 f22f8f2.8 f5.6

ISO100 | 70mm | f5.6 | 1/800s

Canon EF 24-70mm f/4.0L IS USM

EF 24–70 mm f/4.0L IS USM
Aperture range / Number of blades f2.8-f22 / 9
Focal lengths (35mm equivalent) 38-112 mm (24-70 mm)
Price (approx. US$) 1,500
Measured at1 maximum aperture / -2 stops

Center resolution 77% / 76%
Edge resolution 66% / 78%
Chromatic aberration 0.8 pixels
Distortion 0%
1 Using mid-range focal length

Top left-hand corner of the c’t test scene
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The Lens: This Tokina is a wide-angle zoom designed for use with
full-frame cameras and we tested the Canon version. The lens has no
built-in stabilizer and, to focus manually, the user has to decouple the
focus ring from the camera’s motor by pulling it back toward the
camera, which means that the otherwise solid build suffers from an
unnecessarily ‘loose’ element. In contrast, the zoom ring has a
pleasantly firm movement that doesn’t move unintentionally. The
length of the lens doesn’t change when you adjust focus and/or focal
length. Weighing in at 600 g (1⅓ lb), the Tokina is averagely heavy for
the performance it offers.

Test Results and Image Quality: With this lens, the manufacturer has
concentrated on delivering optimum wide-angle performance. It
produced much better results than those of the Canon 17-55mm,
showing virtually no loss of edge sharpness when used stopped down.
Unfortunately, performance drops off noticeably toward the edges of
the frame at longer focal lengths, and we measured less than 1000 line
pairs at maximum aperture and 35 mm. The difference between wide
open and stopped down performance was particularly clear. Relative
to the other lenses we tested, chromatic aberration was quite high at
1.7 pixels, but distortion and vignetting both landed top marks in the
Canon segment, with just 0.2 stops of shading at the telephoto end and
-1 per cent wide-angle distortion. Autofocus often missed its mark and
could do with improvement.

Outdoors, the lens produced obvious fringing at high-contrast
edges, especially in the corners of the frame, and there was obvious
resolution fall-off at longer focal lengths.

AT-X 17-35mm f/4 Pro FX
Aperture range / Number of blades f4-f22 / 9
Focal lengths (35mm equivalent) 27-56 mm (17-35 mm)
Price (approx. US$) 550
Measured at1 maximum aperture / -2 stops

Center resolution 80% / 81%
Edge resolution 65% / 74%
Chromatic aberration 1.7 pixels
Distortion –0.2%
1 Using mid-range focal length

f11 f22f8f2.8 f5.6

ISO100 | 35mm | f4 | 1/1600s

Tokina AT-X 17-35mm f/4 Pro FX

Lens Test | Individual Models

Top left-hand corner of the c’t test scene



The Canon 24-70mm f/4 has built-in
macro functionality that allows
shooting at distances as close as
40cm and magnifications up to 0.7x

ISO100 | 80mm | f4 | 1/400s | +0.3EV 
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The Lens: Nikon’s APS-C standard zoom is a tank of a lens that is
extremely well built and feels good to use. The only drawback of its
high build quality is that it weighs 755 g (1⅔ lb), which makes it
something of a burden when traveling. This particular model has been
available for nearly 10 years and was designed at a time when DSLRs
offered much lower resolution, so we were really excited to see how it
performed with the D7100’s 24-megapixel sensor. 

Test Results and Image Quality: The Nikkor‘s real strengths lie in its
wide-angle and standard lens performance, recording more than 80
per cent of its potential resolution wide open. Things don’t look quite
as impressive at the long end using maximum aperture, and we
recorded obvious edge weakness (i.e., less than 1000 line pairs) at all
apertures. Wide-angle barrel distortion came in at -1.1 per cent and
vignetting measured almost a whole stop wide open but was virtually
non-existent stopped down. Chromatic aberration remained constant
throughout the aperture range at an acceptable 0.8 pixels.

Our real-world test mirrored our lab values, and the images we
captured had clear, sharp center definition but insufficient detail
contrast at the edges. This weakness is well demonstrated by the gold
statue, which shows a lack of detail and obvious fringing. 

AF-S DX Zoom-Nikkor 17-55mm f/2.8G ED-IF
Aperture range / Number of blades f2.8-f22 / 9
Focal lengths (35mm equivalent) 17-55 mm (24-70 mm)
Price (approx. US$) 1,400
Measured at1 maximum aperture / -2 stops

Center resolution 81% / 83%
Edge resolution 60% / 70%
Chromatic aberration 0.6 pixels
Distortion –0.2%
1 Using mid-range focal length

f11 f22f8f2.8 f5.6

ISO100 | 35mm | f4 | 1/1600s

Nikon AF-S DX Zoom-Nikkor 
17-55mm f/2.8G ED-IF

Top left-hand corner of the c’t test scene
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The Lens: The AF-S Nikkor 24-70mm f/2.8G ED belongs to the ‘holy
trinity’ of Nikon full-frame, constant-aperture f/2.8 zooms. Build quality
is extremely good and includes a rubber diaphragm that protects the
bayonet coupling from dust and water damage. The zoom and focus
rings work smoothly and precisely and the built-in ultrasonic motor
provides fast, almost silent autofocus. All this technology has its
downside: the lens is 13 cm (5.2”) long and weighs 900 g (nearly 2 lb),
which of course makes it less of a joy to lug around. Only its lack of an
image stabilizer keeps it to a usable size.

Test Results and Image Quality: In spite of producing over 90 per cent
resolution (1803 line pairs) in the center at maximum aperture, the AF-S
confounded our expectations and showed a significant loss of
wide-angle resolution toward the edges of the frame, recording values
as low as 50 per cent. This loss of sharpness was not as drastic at
medium focal lengths but was accompanied by lower center resolution
of 1644 line pairs (82 per cent). Chromatic aberration was generally
negligible, increasing only to 0.7 pixels at the telephoto end. Vignetting
and distortion were also minimal and autofocus was extremely
accurate. We were only able to produce better manual focus results at
the very long end of the zoom scale.

Our outdoor test showed that the edge weakness revealed in the
lab didn’t matter so much in the real world. Used at f5.6, the lens
produced consistently high resolution and very pleasing depth of
detail.

AF-S 24-70mm F/2.8G ED 
Aperture range / Number of blades f2.8-f22 / 9
Focal lengths (35mm equivalent) 36-105 mm (24-70 mm)
Price (approx. US$) 1,900
Measured at1 maximum aperture / -2 stops

Center resolution 87% / 85%
Edge resolution 73% / 77%
Chromatic aberration 0.7 pixels
Distortion 0%
1 Using mid-range focal length

f11 f22f8f2.8 f5.6

ISO100 | 24mm | f2.8 | 1/2000s

Nikon AF-S Nikkor 24-70mm f/2.8G ED

Top left-hand corner of the c’t test scene
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The Lens: Tamron’s full-frame standard zoom is equipped with an
image stabilizer, an ultrasonic motor and a bright maximum aperture,
and is very well built and finished. Its moving parts work smoothly
without any looseness and the zoom is stiff enough to remain
unperturbed by gravity. Like its Nikon counterpart, the Tamron is large
and heavy, weighing in at over 800 g (more than 1¾ lb) and measuring
almost 12 cm in length.

Test Results and Image Quality: The lens provided solid performance
in the lab, in spite of an obvious loss of resolution at the edges of the
frame. It produced its best results at its wide-angle setting, losing
sharpness toward the telephoto end of the range. At 70 mm with the
aperture wide open we measured 1526 line pairs in the center but only
1090 at the edge of the frame. Stopping down improves the results
significantly. Chromatic aberration was minimal at all focal lengths and
vignetting of 0.5 stops is a non-issue at wide-angle settings. Distortion
was more obvious, hitting -2.8 per cent at the wide-angle end.
Autofocus was most reliable at medium focal lengths and often missed
the mark at both ends of the zoom scale.

The Tamron benefitted from stopping down in the real world too.
However, our images began to lose sharpness beyond f11. Overall, our
outdoor results mirrored those we produced in the lab and confirmed
the presence of significant distortion at wide-angle focal lengths.

24-70mm f/2.8 Di VC USD
Aperture range / Number of blades f2.8-f22 / 9
Focal lengths (35mm equivalent) 36-105 mm (24-70 mm)
Price (approx. US$) 1,300
Measured at1 maximum aperture / -2 stops

Center resolution 84% / 91%
Edge resolution 66% / 74%
Chromatic aberration 0.6 pixels
Distortion 0%
1 Using mid-range focal length

f11 f22f8f2.8 f5.6

ISO100 | 48mm | f5.6 | 1/13s

Tamron SP 24-70mm f/2.8 Di VC USD

Top left-hand corner of the c’t test scene
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AF-S Nikkor 24-70mm f/2.8G ED | ISO100 | 70mm | f5.6 | 1/800s AF-S DX Zoom-Nikkor 17-55mm f/2.8G IF-ED | ISO100 | 55mm | f5.6 | 1/1000s

Tamron SP 24-70mm f/2.8 Di VC USD | ISO100 | 24mm | f4 | 1/400s
All the lenses that we tested using the D7100 produced equally
good results and we were unable to find any significant differences
in our real-world test images
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The Lens: This lens has been on the market for more than two years and
is very compact, in spite of its large maximum aperture. It is relatviely
lightweight at 580 g (1⅓ lb), although this is partly because only the
bayonet itself is made out of metal. Build quality is good, in spite of the
prevalence of plastic in the design. The focus and zoom rings are nicely
tactile and there is a switch for locking focal length at 16 mm.

Test Results and Image Quality: Like all of our test lenses, the Sony
shows weakness in the corners of the frame. At f2.8 and medium focal
length, we measured just 900 line pairs, which is a meager 44 per cent of
the potential maximum and the poorest value we recorded. Center
resolution was a consistent 80 per cent throughout the entire zoom range,
while edge resolution dropped off by 10-20 per cent. The only distortion
we detected was some barrel distortion (about 1 per cent) at the
wide-angle end. Vignetting came in at 0.8 stops wide open but was
significantly less at smaller apertures. Chromatic aberration of 1.1 pixels
at the long end was the worst we measured.

Our outdoor test shots showed good contrast and fine color and detail
rendition, especially in the image center. Once again, our golden statue
demonstrates the edge weakness that was a feature of the test lenses.

16-50mm f/2.8 DT SSM
Aperture range / Number of blades f2.8-f22 / 7
Focal lengths (35mm equivalent) 16-50 mm (24-75 mm)
Price (approx. US$) 800
Measured at1 maximum aperture / -2 stops

Center resolution 81% / 81%
Edge resolution 44% / 61%
Chromatic aberration 0.8 pixels
Distortion –0.1%
1 Using mid-range focal length

f11 f22f8f2.8 f5.6

ISO100 | 16mm | f5.6 | 1/250s

Sony 16-50mm f/2.8 DT SSM

Top left-hand corner of the c’t test scene
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The Lens: This model has an unusual, rather cool-looking design that
we found really attractive. At almost 1 kg (nearly 2¼ lb), it is one of the
heaviest lenses we tested. Build and finish quality are very high and the
metal lens barrel extremely robust. A Zeiss emblem underscores the
high quality embodied in this lens.

Test Results and Image Quality: This lens produces much better
quality results than those of its 16-50mm counterpart. Center
resolution measured more than 80 per cent at maximum aperture and
only fell off by 5-15 per cent at the edges. Stopping down delivered
even more quality, even in the furthest corners of the frame. The only
weakness we discovered was at maximum aperture at the telephoto
end of the scale and there was virtually no distortion to speak of at
any setting. Chromatic aberration measured a moderate 0.6-0.9 pixels
and was difficult to detect visually in our test shots. The biggest
surprise was the poor autofocus performance, which lagged behind
all the other test models, especially at medium focal lengths and
maximum aperture.

Outdoor contrast was much better than that produced by the
16-50mm model, especially at the edges of the frame. The sample
image below shows that the Sony full-frame lens was one of the few
we tested that was able to reproduce the detail in the statue with a high
degree of realism. Our telephoto test shots turned out slightly less vivid
than the wide-angle ones.

Sony 24–70 mm f/2.8 ZA SSM Vario-Sonnar
Aperture range / Number of blades f2.8-f22 / 9
Focal lengths (35mm equivalent) 38-112 mm (24-70 mm)
Price (approx. US$) 2,000
Measured at1 maximum aperture / -2 stops

Center resolution 81% / 81%
Edge resolution 71% / 76%
Chromatic aberration 0.6 pixels
Distortion 0%
1 Using mid-range focal length

f11 f22f8f2.8 f5.6

ISO100 | 24mm | f5.6 | 1/320s

Sony 24-70mm f/2.8 ZA SSM 
Vario-Sonnar T*

Top left-hand corner of the c’t test scene
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The Lens: Sigma manufactures cameras and third-party lenses for a
range of camera models, and we tested the current full-frame standard
zoom for Sony cameras. At 800 g (more than 1¾ lb), it is one of the
heavier lenses we tested. Build quality is good, but incorporates rather
too much plastic for a lens in this price bracket. It extends way beyond
its otherwise compact dimensions at telephoto settings but is built well
enough not to zoom unintentionally. Although it lacks a built-in
stabilizer, this model does have an extremely quiet ultrasonic focus
motor.

Test Results and Image Quality: The Sigma delivered its best overall
image quality at the telephoto end, but resolution dropped off by more
than 20 per cent in the corners at maximum aperture. Stopped down,
it measured 1400 line pairs across the entire APS-C image circle and
throughout the zoom range. Its distortion value of -2.6 per cent at the
wide-angle end was very poor and chromatic aberration values of
1.3-1.5 pixels were worse than the others we recorded using the Sony
camera. On the plus side, vignetting of just 0.4 stops at maximum
aperture is a very good result indeed. 

Our test images clearly show fringing at the edges of the frame and
a loss of sharpness at wide-angle focal lengths. Generally speaking, the
images it produced at the long end were more pleasing.

24-70MM f/2.8 EX DG HSM
Aperture range / Number of blades f2.8-f22 / 9
Focal lengths (35mm equivalent) 36-105 mm (24-70 mm)
Price (approx. US$) 900
Measured at1 maximum aperture / -2 stops

Center resolution 78% / 81%
Edge resolution 62% / 74%
Chromatic aberration 1.3 pixels
Distortion –0.3%
1 Using mid-range focal length

f11 f22f8f2.8 f5.6

ISO100 | 24mm | f2.8 | 1/1600s

Sigma 24-70mm f/2.8 EX DG HSM

Top left-hand corner of the c’t test scene



The Sony/Zeiss 24-70mm was the most
expensive lens we tested and also
produced the best contrast. The
corresponding APS-C lens simply couldn’t
compete with this kind of quality.

ISO100 | 55mm | f2.8 | 1/4000s
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The third-party lenses we tested produced the
biggest surprises, with Sigma, Tamron and
Tokina all offering full-frame lenses that are
great value, especially in view of the features
they offer. Some even come with built-in
stabilizers that are not part of the deal in their
more expensive brand-name counterparts. If
you don’t put too much emphasis on the
quality of the materials or the overall ‘feel’ of
the product, these lenses make great
alternatives and produced test values very
close to those of their more costly competitors. 

If build quality is your holy grail, you are
probably better off sticking to lenses made by
the same manufacturer as your camera, even
if this does mean spending more money. The
Sony/Zeiss lens is a case in point, offering
superb quality at a very high-end price.
Overall, the own-brand lenses we tested
produced slightly better-quality images and,
if you are not specifically looking to acquire a

full-frame camera,
you are just as well off
using a good-quality
APS-C lens. You will
simply have to decide
for yourself whether
that little extra
sharpness and the
heavy-grade feel of a
full-frame ‘original’
are really worth the
extra expense. 

At the end of the day, there are no real
arguments for using full-frame lenses with an
APS-C camera. Full-frame lenses are larger and
heavier than their small-sensor counterparts
and, because optical errors can occur
anywhere in the frame, even their larger
image circle doesn’t completely eliminate the
optical anomalies and artifacts that affect
smaller lenses. 

The other thing to consider is that 
the extremely high resolution (and
correspondingly small pixel size) of many of
today’s APS-C sensors make high demands on
the optical qualities of a lens. Apart from the
Nikon D800 ‘pixel monster’, full-frame sensors
give you more room for maneuver when
composing an image and their larger pixels
make it easier to get the best out of a lens.

Canon Overview

Conclusions

The Canon EOS 7D and the EF 24-70mm
f/4.0L IS USM make a great team. In our
test, the lens produced well-balanced
images that were sharp all the way to the
edges of the frame.

CANON RESOLUTION COMPARISON
Focal range Wide-angle Medium Telephoto
Zone Center Edge Center Edge Center Edge
Maximum aperture

EF-S 17-55mm f/2.8
EF 24-70mm f/4
Tokina 17-35mm f/4 
Stopped down

EF-S 17-55mm f/2.8
EF 24-70mm f/4
Tokina 17-35mm f/4

Resolution was determined visually in units of vertical line pairs [lp/h]. The larger the value, the sharper the image.

1371
1401
1470

1376
1418
1394

1092
1303

1201

1322
1354
1323

1418
1346
1378

1439
1321
1400

1247
1152
1125

1355
1362

1284

1430
1438

1254

1359
1421
1373

1084
1268

947

1282
1350

1136

The APS-C EF-S 17-55mm shows significantly
poorer image quality toward the edges of the
frame, losing as many as 346 line pairs of
resolution at maximum aperture. Stopping
down improves the situation markedly . The
24-70mm avoids this problem entirely by
offering a maximum aperture of f4, which
enables it to produce much more balanced
results throughout the zoom range and

consistent sharpness right up to the edges
of the frame. Nevertheless, the larger lens
does not offer significantly better quality
its APS-C opposite number.

The Tokina 17-35mm f/4 was our
third-party Canon alternative and,
apart from its rather obvious
chromatic aberrations, proved to be
a match for both brand-name lenses
when used stopped down. The build
quality of the Canon lenses is clearly
superior to the Tokina with its slightly
wobbly manual focus mechanism. The
most convincing argument for the
Tokina is its price, which is half that of its
Canon full-frame equivalent and is even
slightly less than that of the Canon-brand
APS-C model we tested.

Lens Test | Conclusions
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Nikon Overview

The Tamron SP 24-70mm f/2.8 Di VC USD
surprised us with consistently balanced
detail rendition. This model rewards its user
with sharp, high-contrast shots, even if
lighting conditions are less than perfect.

Sony Overview

Focal range Wide-angle Medium Telephoto
zone Center Edge Center Edge Center Edge
Maximum aperture

AF-S 17-55 f/2.8
AF-S 24-70 f/2.8
Tamron 24-70 f/2.8
Stopped down

AF-S 17-55 f/2.8
AF-S 24-70 f/2.8
Tamron 24-70 f/2.8

Resolution was determined visually in units of vertical line pairs [lp/h]. The larger the value, the sharper the image.

1782
1803
1784

1787
1771
1795

1093
1077

1339

1006
971

1405

1621
1734
1670

1677
1697
1810

1201
1454

1314

1402
1548
1486

1405
1644

1526

1661
1729
1782

958
1211

1090

1049
1473
1507

SONY RESOLUTION COMPARISON
Focal range Wide-angle Medium Telephoto
Zone Center Edge Center Edge Center Edge
Maximum aperture

SAL 16-50 f/2.8
Zeiss 24-70 f/2.8
Sigma 24-70 f/2.8
Stopped down

SAL 16-50 f/2.8
Zeiss 24-70 f/2.8
Sigma 24-70 f/2.8

Resolution was determined visually in units of vertical line pairs [lp/h]. The larger the value, the sharper the image.

1656
1646

1511

1676
1639
1608

1245
1357

1137

1351
1492
1468

1622
1621
1565

1631
1621
1618

889
1421

1236

1236
1532
1484

1599
1596

1494

1606
1618
1570

1068
1108

1330

1391
1322

1484

c

NIKON RESOLUTION COMPARISON

The Nikon D7100 makes heavy demands on
the lenses you use with it. Its 24 megapixels of
resolution and lack of a low pass filter are
features designed to produce extremely sharp
images, but it will only do so if the lens you use
is capable of resolving detail finely enough to
capture it adequately using the relatively small
pixels. We couldn’t wait to find out how well
the 10-year-old AF-S 17-55mm APS-C lens
performed with the new, high-performance

camera. All the lenses we tested had
problems retaining edge resolution,
but our ‘oldie’ took the prize with
nearly 700 line pairs of fall-off at its
wide-angle setting. In spite of this
shortcoming, the full-frame Nikkor
delivers very good central resolution
throughout the zoom range and loses
very little sharpness in the middle and at the
long end. It also shows very few other artifacts
and aberrations. 

The Tamron 24-70mm f/2.8 costs half as
much as the equivalent Nikkor and produces

stopped-down results that are just as good or
better. Its built-in stabilizer also performs very
well in low light situations and the build
quality is very good indeed.

Sony, too, raises the resolution bar with the
24-megapixel A77, and the performance we
recorded for the 16-50mm APS-C bears
witness to the challenge this presents.
Resolution is extremely poor toward the 
edges at medium focal lengths and comes in
at just 35 per cent (700 line pairs) in the upper
right-hand corner at maximum aperture.
However, stopping down does alleviate the
situation somewhat. 

The Zeiss Vario-Sonnar performs much
better, as it should for US$2,000! Edge
weakness is negligible at wide-angle and
medium focal lengths but increases toward

the telephoto end. Stopped down, the lens
produces virtually no distortion or vignetting
and autofocus only proved less reliable than
manual focus at medium focal lengths. 

The full-frame competition from Sigma is
less than half the price but still performs
almost as well in the resolution stakes,
especially at the telephoto end, where it
produces very even performance throughout
the image circle. Stopped down, it performs
well throughout the rest of the zoom range
too. On the downside, there is obvious
wide-angle distortion and visible chromatic
aberration at all focal lengths. (tho/ssi)

Used with the SLT-A77, the Sigma 24-70mm
produced decent results that weren’t far
behind those of the full-frame Sony lens,
although we did notice some distortion and
chromatic aberration. 

Lens Test | Conclusions
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Dr. Klaus Peeck

Wi-Fi System
Cameras   
This issue’s camera test covers three system
cameras, two of which have new Micro Four Thirds
sensors, while the other offers a conventional
APS-C-format sensor. All three include built-in Wi-Fi
functionality that includes camera remote control
via smartphone or tablet apps and are aimed at
photographers who demand high-quality images.
Only one of our test candidates hit the spot on the
Wi-Fi front but this wasn’t the one that produced
the best images. Read on to find out more.



Our test cameras this time around are the Olympus PEN E-P5 and
Panasonic Lumix DMC-G6 Micro Four Thirds models and the

APS-C Samsung NX300. Like its predecessor, the Panasonic looks rather
like a slimmed-down DSLR, with its big grip and electronic viewfinder
built into the top of the body. The other two cameras have no built-in
viewfinder and are both wider and lower than the Panasonic. The
Olympus has a relatively small textured plastic bulge on its front that
serves as a grip of sorts and which can, for a fee, be swapped for a solid
wood version that nicely sets off the camera’s high-quality metal body.

The Panasonic looks cheap and ‘plasticky’ compared to the Olympus
but is solidly built and has useful rubberized pads on its front and back
that make it easier to hold. The front of the Samsung is covered in faux
leather and has a nice-looking aluminum top plate. Both Micro Four
Thirds cameras offer 16-megapixel resolution, while the Samsung’s
larger sensor ups the ante to 20 megapixels. The PEN is the only one of
our test models to use sensor shift image stabilization, and its unique
‘five-axis’ system claims to be able to stabilize even the roughest
lurches – a claim that was also borne out in our test. Both the Panasonic
and the Samsung depend on appropriately equipped lenses for image
stabilization, and both supplied kit lenses do the job perfectly well. The
kit lenses provided with all three cameras are relatively modest
wide-angle zooms with equivalent focal lengths of 28-80 mm and

apertures that range from f3.5 to f5.6. We were very happy to see that
Panasonic and Samsung (in some markets) supply a lens hood as
standard.

In brightly-lit situations, the Panasonic benefits greatly from its
built-in viewfinder, which enables the user to compose images and
continue navigating through the camera’s menu system, even when
reflections make this impossible using the monitor. Compared with the
flickery unit built into the previous model, the viewfinder in the G6 has
been swapped for a much better 1.4-million-dot unit, providing a much
clearer image, even if it does still sometimes suffer from banding. A
sensor beneath the viewfinder window switches the viewfinder on
automatically when you raise the camera to your eye and can also be
programmed to automatically activate autofocus. The PEN E-P5 offers
a simple optical viewfinder or the extremely expensive VF-4
shoe-mounted electronic viewfinder. The VF-4 costs US$280 but offers
almost 1.5x magnification, 2.4 million dots of resolution, built-in diopter
adjustment and up to 90 degrees of tilt. There are no viewfinder options
available for the Samsung.

All three cameras have articulated touch screen monitors. The PEN
E-P5 and the NX300 allow only vertical tilt (90 degrees upward and
around 45 degrees down), while the fully articulated monitor built into
the G6 enables you to fold the monitor in to face the camera body,
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All three of our test candidates have built-in Wi-Fi functionality
that can be used to control the camera and view the camera
monitor remotely or transfer image files to other devices using a
smartphone or tablet app. The Samsung implementation offers a
choice of 2.4 or 5 GHz wavebands.

The wireless functionality offered by Olympus in the PEN E-P5 is
limited to use with the proprietary Olympus Image Share app,
which includes a rudimentary remote shutter release (that only
works in ‘iAuto’ mode), a self-timer and touch-driven AF. Other
functions include basic retouching tools and writing GPS data to
image files. 

Because the E-P5 has no NFC (near-field communications) module,
it generates a QR code that, once scanned, is used to automatically
configure the smartphone. In the case of problems making a
connection, the camera can also display the appropriate Wi-Fi
connection data in human-readable form.

The Panasonic and Samsung cameras have built-in NFC
functionality, which automatically configures a wireless
connection between the camera and a second device if you
hold the two close together. You can also use conventional WPS
functionality or enter a PIN to make a connection. Both cameras
also enable you to use a wireless access point to transfer image
files to a computer, social networks or to the cloud without the
use of additional 
software. The Samsung even has a built-in e-mail client for direct
sharing. 

The NX300 can send captured images automatically to a
smartphone in the background, and the ‘MobileLink’ function
(accessed by setting the mode dial to ‘Wi-Fi’) allows you to transfer
media files to and from your mobile device. You can also use the
app to control the self-timer and flash settings, and choose a
location for saving your images. Remote shooting is only possible
in Program mode. 

The Panasonic smartphone app completely eclipses the other two,
offering manual, semi-automatic and program mode shooting, as
well as the option to switch shooting modes remotely. You can
adjust the aperture, exposure time and a range of other settings
using virtual dials in the app interface, and there is even a
stripped-down version of the camera’s ‘Quick’ menu available.
Alongside all this stills functionality, video capture can be
controlled remotely too.

The Panasonic’s remote live view displays most of the data shown
on the camera monitor. New images are not transferred
automatically to your device if you are using it as a remote control
and you have to use the ‘Play’ button to access the camera’s
memory and transfer selected images. Our test camera crashed
twice while attempting to make a connection in ‘Wi-Fi Direct’
mode and we were only able to reset it by completely removing
the battery. Data connections for image transfer only are rather
clunky to set up and cannot be automated.

Camera-based Wi-Fi

The Wi-Fi-based remote
control functionality built
into the Panasonic Lumix
DMC-G6 is much more
comprehensive than that
offered by Olympus and
Samsung



offering great protection when it is not in use. The drawback of this
system is that you have to fold the monitor out sideways to alter its
vertical tilt.

All three cameras use capacitive touch screen technology. The
Olympus and Panasonic monitors both have about 1 million dots of
resolution and provide stable color rendition, while the Samsung has a
768,000-dot AMOLED (active-matrix organic light-emitting diode)
screen that tends to give images a green cast when viewed at an angle.

Our test cameras use between 21 and 35 AF zones or a movable spot
mode to adjust focus and also offer touch-based autofocus controlled
via the monitor. In addition to its conventional contrast AF functionality,
the Samsung also offers sensor-based phase detection AF support and
manual focus with the help of the ‘MF Assist’ monitor magnifier
function.  The Olympus offers an optional focus peaking display to help
you attain precise manual focus.

All three models use an established range of exposure modes,
including program, aperture priority, shutter priority, program shift
and various specialized scene modes. The two Micro Four Thirds
cameras offer four custom modes and both the DMC-G6 and the PEN
E-P5 have a 60-second maximum exposure time as compared to the
NX300's 30-second maximum. Shortest exposure times are 1/4000 s
(Panasonic), 1/6000 s (Samsung) and 1/8000 s (Olympus). The G6 and
the NX300 have B (long exposure) settings of up to two and four
minutes respectively, while the Olympus allows exposures of up to 30
minutes’ duration, accompanied by the unique ‘Live BULB’ function
that shows the accumulated result of such long exposures in real time
on the monitor. There is also an optional live histogram display.

The PEN and the Lumix have built-in flash, while the Samsung relies
on a fairly weak (supplied) accessory unit that also produces vignetting
affects at close subject distances due to the proximity of the lens barrel.
In contrast, the Olympus offers an unusually short flash sync speed of
1/320 s and – unlike the Panasonic – excellent close-range flash
performance. The Panasonic also scores well with its optical wireless
flash control functionality that allows you to control three remote flash
groups on four separate channels. The Olympus, too, offers optical
wireless flash functionality – an option that is not available with the
Samsung.

All three cameras use Li-Ion batteries, and Panasonic and Samsung
also sell proprietary AC adapters. Though the AC adapter for the
Samsung cannot be used with the camera powered on, limiting its use
to simply recharging the camera, the AC adapter for the Panasonic
allows the camera to be used for photographic work while the adapter
is attached. The Olympus doesn’t provide a constant battery level

indicator while the Samsung’s indicator proved to be imprecise and
gave us insufficient warning before the battery died.

Handling

The Panasonic’s DSLR-style body provided the best overall handling in
our test, with plenty of easily reachable controls distributed over both
sides of the camera back. The main mode dial is large but slightly stiff,
and the function lever close to the shutter release can be used to zoom
the lens and dial in exposure compensation values. Unfortunately,
some of the buttons are too small and too flush with the camera body,
making then too easy to press unintentionally. The main dial is also
positioned too far to the right for easy adjustment using your thumb.

Panasonic’s higher-end Lumix cameras are well known for their long
menu pages that you can scroll through using the zoom lever, and the
G6 augments this approach with touch-screen tabs. The familiar ‘Quick’
menu for fast access to major functions is included and you can also
opt to display a single screen covering all the current main settings,
which you can then adjust via touch control. At the expense of battery
life, leaving the monitor info display permanently switched on provides
a useful way to adjust camera settings, especially if you are using the
viewfinder to frame and compose an image. 

The Samsung’s handling is just as flexible as the Panasonic’s and is
squarely aimed at touch screen operation. The NX300’s monitor supports
many of the smartphone-style gestures that users will be familiar with
and pressing the ‘Fn’ button opens a main menu in which all major
camera settings can be adjusted. Nonetheless, the camera can still be
operated using the relatively narrow range of hardware buttons built into
its body. The jog dial on the top plate can also be used to perform various
actions including scrolling through menus. The ‘iFn’ button is designed
for use with ‘i-Function’ lenses and displays a row of icons at the bottom
of the monitor, which can then be used in combination with the focus
ring to adjust various camera and lens settings. 

The Olympus PEN E-P5 offers a huge range of settings that are packed
into an 85-line (!) menu spread across 10 main tabs. You can navigate
through these using either the arrow pad or the main and sub-dials.
Olympus has decided to do without touch functionality for menu
navigation and has limited the E-P5’s touch control to focus, shutter
release and ‘live guide’ functionality. There is no main status screen for
direct adjustment of the main settings, which puts the Olympus behind
the other test cameras with regard to overall ease of use.

Having said that, the E-P5 has a good range of user-configurable
control buttons that work smoothly and precisely. The lever
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surrounding the movie button can be used to switch quickly between
various major exposure settings (exposure compensation, ISO, white
balance, aperture value etc.), which can then be adjusted using the
main and sub-dials. 

Hardware Performance

All three cameras performed very well in our real-world tests. The
Olympus, with its extremely fast autofocus, was the most agile, even in
poor lighting conditions. The Panasonic only reached its full potential
speed in good light and the Samsung came in a definite third under all
conditions, taking up to twice as long as the others to focus, in spite of
its phase detection sensor elements.   

The live view images provided by the Lumix and the NX300 are slow
to adjust in low light, while the Olympus produced an image that was
much easier to follow. All three cameras offer effective image
stabilization technology, although the Olympus ‘five-axis’ approach
was generally the most effective. 

Burst mode worked fine in all three test models, although the buffers
in the Samsung and the Panasonic filled up after just five and seven
images respectively in RAW shooting mode. In Large JPEG mode, the
Panasonic captured as many as 100 images in a single burst, while the
Samsung threw in the towel after just 13.

Image Quality in the Real Worldˇ

Image quality, too, was of consistently high quality, with none of our
test candidates producing any serious exposure anomalies in any of
our varied outdoor test situations. All three rendered colors faithfully
and only the Samsung showed a slight tendency toward cool colors
when used with standard exposure settings. 

Considering the relatively modest quality of the kit lenses we were
using, the resolution results were all very good. The Samsung was the
clear leader in this respect, followed by the Panasonic and the Olympus,
which regularly produced rather flat-looking images at all focal lengths. 

The Olympus also tended to produce more diffusion artifacts than
the other two cameras (possibly because of its lack of a lens hood), but –
along with the Panasonic – produced good edge sharpness. The
Samsung’s 3:2 aspect ratio helped to put it firmly in third place in this
respect. Panasonic and Samsung obviously have chromatic aberration
under better control  than Olympus.

All three cameras produced balanced Full HD video results that
mirrored their stills quality characteristics. Focus tracking wasn’t always
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ISO 200 ISO 800 ISO 3200 ISO 128̌00

Detail enlargements of images shot at the harbor in Hamburg,
Germany using the Panasonic Lumix DMC-G6 

At its maximum telephoto setting, the Olympus PEN E-P5
produced rather flat detail contrast



as precise as we would have liked, and the kit lenses we tested were
generally too loud and their zoom actions not smooth enough for
effective video capture.  

…ˇand in the Lab

Under lab conditions, our test cameras produced slightly different
results from those we captured in the field, and you can check the
differences yourself in the sample images that we have included on
this issue’s free DVD. Under these conditions, the Olympus produced
the best detail rendition, and even managed to accurately reproduce
the texture in the black cloth in the center of our test scene. Both the
other cameras’ processing engines smudged these details, even at ISO
100.  Generally, the Olympus produced good details for a camera with
a 16-megapixel sensor, although overall sharpness was best with the
lens stopped down. The same is also true of the other two cameras,
with the Samsung showing a stronger loss of sharpness toward the
bottom of the frame. The Olympus produced bright, slightly warm
colors with slightly variable white balance, while the Panasonic
captured accurate but slightly low-key colors with a slight tendency
to overexposure. The Samsung, too, recorded accurate colors but
underexposed consistently, giving its images a slightly matte look. At
the end of the day, it was the Olympus that produced the most
balanced overall exposure results.

As far as noise is concerned, all three cameras produced acceptable
results. Both Micro Four Thirds cameras suffer obviously from the high
pixel density of their smaller sensors, although the Samsung wasn’t
really able to pull ahead in spite of its larger sensor. All three are only

capable of delivering clean results up to ISO 400 and show obvious
texture fall-off and general softness from ISO 800 onward, making this
the limit for passable 100% viewing on a monitor.  Full-screen views
were generally OK up to ISO 3200, although at this level, the Samsung
smudges some details and the Olympus shows a lack of visible texture
and unnatural-looking increases in contrast. The Panasonic, on the
other hand, frays some edges and produces ‘dirty’ black tones,
although only begins to really lose detail at ISO 6400.

Conclusions

These three cameras represent a potent combination of small size,
interchangeable-lens flexibility and very good image quality. Out there
in the real world, the Samsung delivers the best results straight out of
the box, especially with regard to sharpness and detail rendition,
although the kit lens doesn’t produce great results right into the
furthest corners of the 3:2 frame. From its position as an experienced
manufacturer of smartphones, Samsung has produced the most
well-thought-out and effective touch control system of our three test
cameras but hasn’t neglected the continuing need for conventional
button-driven control. Combined with its sensibly limited range of
settings and the useful ’iFn’ functionality, the Samsung outdistances
the other two in the handling stakes. 

The Olympus scores well with its high-end retro look and
well-finished metal body, as well as with its small overall dimensions
and compact kit lens. It’s lightning-fast autofocus is also a great feature
and the only thing that really lets the PEN down is its complex and
slightly confusing menu system. 
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Auto exposure in backlight: the Samsung NX300 (left) produced much cooler colors than the Panasonic Lumix DMC-G6

WI-FI SYSTEM CAMERAS: TEST RESULTS, PART 1
Sensor
resolution
[lp/h]

better >

Relative center
resolution
(ISO 100, wide-
angle) in %

better >

Center
resolution
(ISO 100)
[lp/h]

better >

Center
resolution
(ISO 400)
[lp/h]

better >

Center
resolution
(ISO 1600)
[lp/h]

better >

Center
resolution
(ISO 3200)
[lp/h]

better >

Center
resolution
(ISO 6400)
[lp/h]

better >

Center
resolution
(ISO 12 800)
[lp/h]

better >

Center
resolution
(ISO 25 600)
[lp/h]

better >

Olympus PEN E-P5 with M.Zuiko 60mm f/2.81

Panasonic Lumix DMC-G6 with Lumix 20mm f/1.72

Samsung NX300 with NX 30mm f/2.03

WI-FI SYSTEM CAMERAS: TEST RESULTS, PART 2
Signal-to-noise
ratio  
[S/Nx] ISO 100

better >

Signal-to-noise
ratio
[S/Nx] ISO 400

better >

Signal-to-noise
ratio
[S/Nx] ISO 1600

better >

Signal-to-noise
ratio
[S/Nx] ISO 3200

better >

Signal-to-noise
ratio
[S/Nx] ISO 6400

better >

Signal-to-noise
ratio
[S/Nx] ISO 12 800

better >

Signal-to-noise
ratio
[S/Nx] ISO 25 600

better >

Visual noise 
OECF20 
ISO 100

< better

Olympus PEN E-P5with M.Zuiko 60mm f/2.81

Panasonic Lumix DMC-G6 with Lumix 20mm f/1.72

Samsung NX300 with NX 30mm f/2.03

1 AF measurements made with an M.Zuiko 12-50mm f/3.5-6.3                       4 Measured at the lowest level of ISO 200                        Resolution was determined visually in units of vertical line pairs [lp/h]. The higher the value, the sharper 
2 AF measurements made with a Lumix 14-42mm f/3.5-5.6 OIS                         (without  ‘Low-light ISO’)                                             the image. The results listed were recorded using hardware available in Europe. Results may vary 
3 AF-Measurements made with an NX 18-55mm f/ 3.5-5.6 OIS                        5 Measured at the lowest level of ISO 160                        for lens and/or camera versions available in other territories.
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Even with its rubberized grips, the Panasonic Lumix DMC-G6 cannot
disguise its plastic body, although the great overall build quality does
compensate somewhat for the cheapness of the materials. We have
already mentioned its ergonomic shortcomings. A big plus is the new,
high-resolution electronic viewfinder, which allows you to hold the
camera in a traditional eye-level position and continue composing images

in bright sunlight. Panasonic’s comprehensive Wi-Fi-based remote control
functionality is by far the best of this particular bunch and offers a fine
range of pro-grade tools. The NFC (near-field communications) modules
built into both the Panasonic and the Samsung make child’s play of the
increasingly important job of wireless file transfer between the camera
and an Android-based smartphone or tablet. (pen)
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Contrast range
/subject range
ISO 100
[in f-stops]
better >

Contrast range
/subject range
ISO 400
[in f-stops]
better >

Contrast range
/subject range
ISO 1600
[in f-stops]
better >

Contrast range
/subject range
ISO 3200
[in f-stops]]
better >

Contrast range
/subject range
ISO 6400
[in f-stops]
better >

Contrast range
/subject range
ISO 12 800
[in f-stops]
better >

Contrast range
/subject range
ISO 25 600
[in f-stops]
better >

Real subject
range
[# of tonal values]

better >

Color Checker 
SG & Δ E 
ISO 100

< better

Visual noise 
OECF20 
ISO 400

< better

Visual noise 
OECF20 
ISO 1600

< better

Visual noise 
OECF20 
ISO 3200

< better

Visual noise 
OECF20 
ISO 6400

< better

Visual noise 
OECF20 
ISO 12800

< better

Visual noise 
OECF20 
ISO 25600

< better

Power up time 
[s]

< better

Shutter Lag 
Wide-angle >1000 lx
in live view [s]

< better

Shutter Lag
Wide-angle at 30 lx [s]

< better

Real subject range represents the range of tonal values contained in an 8-bit rendition of a test image. Higher Signal-to-noise values indicate less disruptive noise. ‘Visual noise’ is a physiologically based judgment of how
‘irritating’ certain image noise artifacts appear to the viewer. The values are calculated based on the intensity, frequency and color of the perceived artifact. Values below 0.8 represent virtually noise-free images, values below 2 low-noise
reproduction and those between 2 and 3 visible but acceptable noise levels. Values above 3 represent disruptive levels. Values of 5 and above represent extreme, unacceptable noise.
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WI-FI SYSTEM CAMERA OVERVIEW
Manufacturerer/Model Olympus PEN E-P5 Panasonic Lumix DMC-G6 Samsung NX300

URL www.getolympus.com/us/en www.panasonic.com www.samsung.com
Digitization

Native resolutions (in pixels) 4608 x 3456, 2560 x 1920, 1280 x 960, 
1024 x 768, 640 x 480 (4:3, with 16:9, 3:2, 
6:6 or 3:4 selectable)

4608 x 3456, 3264 x 2448, 2336 x 1752 
(4:3, with 3:2, 16:9 or 1:1 selectable)

5472 x 3648, 3888 x 2592, 2976 x 1984, 
1728 x 1152 (3:2, with 16:9 or 
1:1 selectable)

Sensor type, effective megapixels / Size / Self-cleaning Live MOS, 16 / Micro Four Thirds 
(17.3 mm x 13.0 mm) / v

Live MOS, 16 / Micro Four Thirds 
(17.3 mm x 13.0 mm) / v

CMOS, 20 / APS-C (23.5 mm x 15.7 mm) / v

Image format(s) / Compression rates / Video format RAW, JPEG, RAW+JPEG / 4 / MPEG-4 H.264, AVI RAW, JPEG, RAW+JPEG / 2 / AVCHD or MPEG-4 H.264 RAW, JPEG, RAW+JPEG / 3 / MPEG-4 H.264
Video: max. resolution [pixels], length (H.264), fps Full HD 1080p, approx. 29 min, 30 Full HD 1080p, approx. 29 min, 50/60 (PAL/NTSC) Full HD 1080p, 29 min 59 s, 60
Memory card type / average file size3 SD(HC/XC) / 7.5 MB SD(HC/XC) / 8.5 MB SD(HC/XC) / 9.1 MB
Features

Crop factor (35mm equiv.) / Lens mount approx. 2x / Micro Four Thirds approx. 2x / Micro Four Thirds approx. 1.5x / Samsung NX
ISO settings Auto (200 to max. selectable), 

(100) 200-25 6̌00 in 1/3 or 1/1 increments
i-auto, Auto (Max. up to 12 800 selectable), 
160-12̌ 800 (25̌ 600) in 1/3 or 1/1 increments

Auto (100-200/400/800/1600/3200), 
100–25̌ 600 in 1/3 or 1/1 increments

Shutter speeds [s] / Default flash sync [s] bulb (max. 30 min.), 60 -1/8000 / 1/320 (extern. 1/250) bulb (max. 2 min.), 60-1/4000 / 1/160 bulb (max. 4 min.), 30-1/6000 / 1/180
Focusing / Image stabilizing AF (one-shot, touch AF, continuous, tracking, 

face detection), MF / v (Sensor shift)
AF (one-shot, touch AF, continuous, tracking, 
face detection), MF / v (in-lens)

Hybrid AF (one-shot, touch AF, continuous, 
face-detection), MF / v (in-lens)

AF areas / Focus assist lamp 35, 9-area group or 1 (35 positions) / v (orange) 23, 5 or 6 (can be grouped) or
1 (1798-7752 positions) / v (red)

21 (macro: 35) or 1 (247/105 positions, contrast/phase
detection ) / v (green)

Metering: Matrix / Center-weighted / Spot v (324 sectors) / v / v v (1728 zones) / v / v v (221 sectors) / v / v
Programmed auto / Scene modes / Custom presets v (with shift) / 23 / v (4 custom presets) v (with shift) / 23 / v (4 custom presets) v (with shift) / 14 / –
Exposure: Aperture priority / Shutter priority / Manual v / v / v v / v / v v / v / v
Exposure compensation [EV] / Depth-of-field preview ±3 EV in 1/3, 1/2 or 1/1 increments / v

(via Fn button)
±5 EV in 1/3 increments / v (via one of several 
programmable Fn buttons)

±3 EV in 1/3 incrments / v (via Fn button)

Bracketing: Exposure / WB / Focus /  Interval timer /
Sound

v / v / – / v / v (16-bit, stereo, 48 kHz) v / v / – / – / v (16-bit, stereo, 48 kHz) v / v / – / – / v (16-bit, stereo, 48 kHz)

Self-timer / Continuous shooting speed (JPEG/RAW)6 12 or 2 s or 1-30 s, 1-10 shots,  0.5-3 s interval / 
9.1 fps, 23 shots; 9.1 fps, 19 shots 

10 or 2 s or 3 shots / 6.7 fps, >100 shots; 
5.9 fps, 7 shots

2-30 s / 7.7 fps, 13 shots; 7.7 fps, 5 shots

White Balance: Auto + Man. / Presets / Fine-tuning v (2 custom presets) / 6 / v (+ Kelvin) v (manual: 2 presets) / 5 / v (+ Kelvin) v / 7 / v (+ Kelvin)
Sharpness, Contrast, Saturation adjustable / Color
spaces

v / sRGB, Adobe RGB v / sRGB, Adobe RGB v / sRGB, Adobe RGB

Viewfinder: Type / Magnification / Coverage / Eyepiece
distance

– (optional optical or electronic) / 
– / – / –

electronic (1.4 million dots, eye sensor) / 0.7x / 
100 % / 17.5 mm (with adjustable diopter setting)

– / – / – / –

Monitor: Diagonal / Resolution [dots] / No. of brightness
settings

3.0" touch screen (capactive, vertically tiltable) / 
1.1 million dots / 15 (+ color correction)

3.0" touch screen (capacitive, fully articulated) / 
1 million dots / 7 (saturation, color and contrast 
adjustable)

3.3" AMOLED touch screen (capacitive, 
vertically tiltable) / 768 000 / 5 (color adjustable)

Live View / With AF using sensor / Dedicated sensors v / v / n/a v / v / n/a v / v / v (Hybrid elements built into sensor)
Body material / Control panel / Auto monitor rotation Metal / – / – Plastic / – / – Metal and plastic / – / –
4-way selector / Multi selector / Command dials v (+ OK button) / 1 / 2 v (+ center button) / 1 / 1 v (4 buttons + OK) / 1 / 1
Flash guide number (meters) / Charge time / Connector 10 (ISO 200, built-in flash) / 3.3 s / v (TTL shoe) 10.5 (ISO 160, built-i flash) / 4.5 s / v (TTL shoe) 8 (ISO 100, accessory flash)7 / 3.1 s / v (TTL shoe)
Playback

Multiple [# of images] / Zoom / Histogram 100, 25, 9 or 4 or calendar / v (up to 14x) / v
(+  RGB)

30, 12 or calendar / v (up to 16x) / v (+ RGB) 40, 15 or 3 each with calendar / v (up to 7.6x) /
v (+ RGB)

Connectors/Dimensions

Power source Li-Ion battery Proprietary AC adapter, Li-Ion battery USB charger, Li-Ion battery

Interfaces / A/V out / HDMI / Remote control Wi-Fi, USB 2.0 / v (+ accessory port) / 
v (Type D) / v (Wi-Fi + cable)

Wi-Fi, USB 2.0 / v (+ Mic in) / v (Type C) / 
v (W-Fi + cable)

Wi-Fi, USB 2.0 / – / v (Type D) / v (Wi-Fi + cable)

Dimensions (W/H/D) / approx. weight6

Body only / With test lens 
122 mm x 69 mm x 37 mm / 420 g, 535 g 123 mm x 85 mm x 71 mm / 390 g, 550 g 122 mm x 64 mm x 41 mm / 335 g, 535 g

What’s in the Box

Manual / User guide Quick start guide, PDF manual Quick start guide, PDF manual Quick start guide, PDF manual
Accessories Li-Ion battery BLN-1 (7.6 V, 1220 mAh, 9.3 Wh),

 charger, body cap, shoulder strap, USB cable, 
kit lens and Vf-4 viewfinder (if applicable)

Li-Ion battery DMW-BLC12 (7.2 V, 1200 mAh, 8.7 Wh),
charger, body cap, shoulder strap, USB cable, kit lens
(if applicable) with hood

kit lens (if applicable) BP1130 (7.6 V, 1300 mAh, 8.6
Wh),  charger, body cap, flash shoe cover, 
 accessory flash, shoulder strap, USB cable, 
kit lens (if applicable) with hood

Optional accessories Memory cards, camera case, interchangeable lenses, 
microphone set, underwater housing and 
accessories, other PEN system accessories

Memory cards, camera case, accessory flash, Four
Thirds adapter, AC adapter and DC coupler, cable
remote release, accessory microphone, HDMI cable,
other Panasonic system accessories

Memory cards, AC adapter, GPS receiver, camera case,
accessory microphone, other Samsung NX system 
accessories

Software

Included software (Platform) Olympus Viewer 3 (Win/Mac) PHOTOfunSTUDIO 9.2 PE (Win), 
SILKYPIX Developer Studio 3.1SE (Win/Mac)

Adobe Photoshop Lightroom 4 (Win/Mac)
Samsung i-Launcher

Ratings

Test images1 (c’t test scene shot in daylight) Evaluated with M.ZUIKO DIGITAL 14-42mm 
f/3.5-5.6 II R MSC

Evaluated with G Vario 14-42mm f/3.5-5.6 Asph. OIS Evaluated with Samsung NX 18-55mm f/3.5–5.6 OIS 
i-Fn III

Color rendition / Exposure + / + + / ± + / ±
Sharpness / Detail rendition + / ++ + / + + / +
Image noise / Other artifacts2

± / + ± / + ± / +
Ease of use 4/ Printed manual + / - + / ± ++ / -
Feature set 4, 5 / Included accessories 4 ++ / ± ++ / ± ± / +
MSRP: Body only / With kit lens (US$) 1000 / 1100 650 / 750 – / 800

1 Judged by eye on a calibrated monitor 3 Average values, measured using largest native image size and best JPEG quality 6 With battery and memory card
(applies only to these cameras and therefore not comparable with earlier tests) 4 In relation to cameras in a similar price range                                                                      7 Accessory flash supplied

2 Sharpening and compression artifacts, moirés and axial and longitudinal chromatic aberrations      5 Photographic features only        

++ˇexcellent         +ˇgood         ±ˇsatisfactory         -ˇpoor         --ˇinadequate                                         vˇincluded         –ˇnot included         n/aˇnot applicable c







Olaf Ballnus

Portrait
photography
In this workshop, professional portrait photographer Olaf
Ballnus lets you in on some of his favorite tricks and strategies
for capturing top-notch ‘people pictures’. Look over his
shoulder as he uses his unique skills to produce great location
shots of stars and less well-known people, often using a bare
minimum of props and equipment. He also invites us to look
into his kit bag and tells us about the gear that has proved
indispensable over the years.
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In this article



Olaf Ballnus is a dedicated portrait
photographer. Most of his clients are

high-circulation magazines, for whom he has
photographed countless musicians, sports
personalities and movie stars, but his job also
involves using his skills to portray less
well-known people and make them look just
as special as his celebrity subjects. For an

effective portrait, you need a strong concept,
the right gear for the situation, the right
viewpoint and a wealth of technical tricks. “As
long as there is an atmosphere of trust
between the photographer and the subject,
you can take interesting photos of anyone,
even if you only have 15 minutes. Interest in
the person I am portraying and emotional

Portrait Workshop | Introduction 

1 Sony Vaio VPCS12V9E (13.3 inch) notebook computer with 6 GB

of memory

2 Nikon D700 DSLR with Multi Power Battery Pack 

and a 24-70mm f/2.8 Nikkor lens

3 Backup Nikon D700 DSLR with Multi-Power Battery Pack

4 Eizo Foris FS2331 23-inch monitor

5 Canon PowerShot G12 high-end compact and Canon WP-DC34

underwater housing 

6 Nikkor 500mm f/8 mirror telephoto lens

7 Micro-Nikkor 45mm f/2.8D ED tilt/shift lens

8 Nikkor 70-200mm AF-S VR f/2.8G lens

9 Nikkor 16-35mm f/4 lens

10 Micro-Nikkor 105mm f/2.8 macro lens

11 Memory cards

12 Nikon Speedlight SB-400 flash (guide number 21)

13 Nikon Speedlight SB-800 flash (guide number 38)

14 Flash sync cable

15 Fujifilm X-E1 system camera and Fujinon 35mm f/1.4 XF R lens

1

2

3

4

5
6

7
8 9

10

11 12

13

14
15
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A Portrait Photographer’s Bag of Tricks



exchange are much more central than
technique,” says Ballnus.

Nevertheless, technique still plays an
important role that should never be
underestimated – a notion borne out by the
mound of gear that Ballnus uses regularly (see
the previous page). We asked him which parts
of his kit are absolutely indispensable for jobs

that require him to carry the bare minimum.
“The Nikon D700 with the 24-70mm zoom,
memory cards, a sun hat (essential with a
haircut like mine), sunshine and a Nick Cave
CD” was the wry answer, to which he added,
“I also carry a backup D700 with a 50mm lens
for emergencies. You never know when you’ll
need a reserve camera, and I recently had to

deal with a blocked shutter release and
damage to two dropped lenses.”

Many of Ballnus’ images are created on
location, so he often has to improvise to make
the most of less-than-perfect conditions. The
following pages go into detail on some of the
techniques he uses, many of which are
surprisingly simple.

Portrait Workshop | Introduction 

Olaf Ballnus (left) and his assistant on location. Ballnus always carries a
tripod and a monopod, although he rarely ends up using them. He prefers
to move around on set to find the best perspective for the upcoming shot.
Staying mobile also helps to keep the atmosphere on set relaxed.
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In a studio, you can usually take time to
prepare for a shoot and set up your lighting
in advance, but, on location, you often have
to shoot quickly in unfamiliar or unusual
surroundings. Ballnus tells us that when 
he is shooting media personalities, the
locations are often full of useless junk or

furnished with nothing more than a huge TV
and a black sofa. Hotels and offices are no
better as photoshoot locations either. He
Prefers to shoot in places where the history
and charm of the location surprise and
inspire him and help him develop his ideas.”
He often arrives at a location an hour or so

in advance to check out the area and scout
for potential alternative scenery in case the
shoot doesn’t turn out as planned. Setting
off early also helps to prevent the additional
stress caused by traffic problems or finding
somewhere to park.

Portrait Workshop | Locations 

Locations

Backstage in a TV studio with the actor 
and singer Peter Kraus – I taped a simple
piece of checked fabric to the wall to
change the background. I find the ‘Gerband’
brand the best tape to use, as it hardly 
ever leaves sticky marks when I remove it 
after a job. The tight crop using a 50mm
lens completely eliminated the rather dull
surroundings.

ISO 200 | 24mm | f6.0 | 1/30s
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ISO 200 | 50mm | f6 | 1/30s



Portrait Workshop | Locations

ISO 1250 | 45mm | f6.0 | 1/160s

I like to use highly textured
backgrounds, and brickwork is often
just right. I took this shot of the
musician Kim Frank outside the
‘Hasenmanufaktur’ (‘Rabbit Factory’)
in Hamburg, Germany. The
reflections in the glass in the smaller
shot on the left, which was taken in
Hamburg’s Portuguese quarter,
make it slightly less balanced.

ISO 1250 | 45mm | f5.0 | 1/1250s
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“I like to use apertures of f3.3 to f3.5 when
I’m shooting with my 24-70mm zoom in
daylight. Opening right up to f2.8 produces
images that are generally not sharp enough,
while apertures of f5.6 and less provide too
much depth of field and too much

background sharpness for my taste.” The
sequence opposite demonstrates the effect
of decreasing aperture on a portrait. 

Olaf Ballnus says that optimum sharpness
can often be found at apertures of around f8,
although this is only a ballpark figure and

optical performance varies from lens to lens.
See page 20 for a comprehensive lens test
that covers a range of portrait-friendly
optics.

c’t Digital Photography 14 (2014)

Portrait Workshop | Depth of Field 

Using Depth of Field Effects

For this portrait of the boxers
Vitali and Vladimir Klitschko 
I chose a wide-open aperture to
keep the composition interesting
and give it extra depth.
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ISO 200 | 35mm | f2 | 1/1600s ISO 200 | 35mm | f4 | 1/800s

ISO 200 | 35mm | f8 | 1/100s ISO 200 | 35mm | f22 | 1/13s

Playing with the degree of background sharpness is one of the simplest and most common ways to alter the look of a portrait
photo. This sequence of shots of a model demonstrates the principle very well. Using an aperture of f2 keeps background detail
nicely blurred, while decreasing the size of the aperture from shot to shot progressively increases the background sharpness.
The disadvantage of smaller apertures is the longer exposure times they require.



50mm standard or 85mm short telephoto
prime lenses make great portraiture tools
that produce natural-looking images without
the distortion produced their wide-angle
counterparts. Some portrait specialists swear

by long telephoto lenses, citing framing
flexibility without the need to change
shooting positions as the main motivation
for their choice. Fixed-focal-length lenses
such as the 50mm and 85mm ones Ballnus

prefers mean that you have to keep moving
around to find the right perspective.
Alongside his prime lenses, his bright
24-70mm F/2.8 zoom is the lens he uses most
often.
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Portrait Workshop | Focal Length 

Wide-angle lenses are great for
framing group shots, but be
careful to position your subjects
as close to the center of the
frame as possible if you want to
avoid producing unflattering
distortion. This shot works very
well in spite of the short focal
length used to capture it.

ISO 400 | 16mm | f5.0 | 1/250s

Choosing the Right Focal length

Telephoto lenses ‘compress’ the field 
of view, bringing the foreground and
background visually closer together. 
The 500mm Nikkor mirror telephoto I
used for this shot of the blind marathon
runner Henry Wanyoike and his guide
Joseph Kibunja made the giraffe appear
much closer than it really was. This shot
was captured during filming for the
award-winning documentary Gold – You
Can Do More Than You Think.
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Portrait Workshop | Focal Length 

ISO 1000 | 16mm | f4 | 1/640s ISO 1000 | 20mm | f4 | 1/640s

ISO 1000 | 28mm | f4 | 1/640s ISO 1000 | 48mm | f4 | 1/640s

ISO 1000 | 70mm | f4 | 1/640s ISO 1000 | 190mm | f4 | 1/640s

This sequence demonstrates how different focal lengths can affect the look of an image by altering the framing
and perspective. I generally prefer to use ‘standard’ focal lengths of around 50mm for my portrait shoots.



Ballnus is an early riser, especially in
summer: “I really like shooting portraits at
around five or six in the morning in summer.
If I have the luxury of planning a day’s shoot
myself, I prefer to shoot indoor scenes or
sort the photos I have already taken in the

middle of the day. Then I can wait for the
wonderful light of dusk between about six
and seven in the evening to continue
shooting portraits.” Online tools like
stardate.org make it relatively simple to find
out when sunrise, sunset and the ‘blue hour’

will occur at your chosen location. Ballnus
likes to squeeze as much as possible out of
the ambient light before resorting to
artificial light sources, often using much
higher ISO values than normal, as in the shot
opposite.

58 c’t Digital Photography 14 (2014)

Portrait Workshop | Light 

I used no artificial light at all for
this portrait of the actress Sibel
Kekilli, shot in Istanbul. The cool
ambient light was perfect for the
mood and was so bright that I was
able to shoot handheld at ISO 100.

ISO 100 | 50mm | f3.0 | 1/320s

Unwanted shadows can be
problematic in portraits shot in
bright sunshine, but handheld
reflectors provide a simple way to
attenuate the effect. This photo is
part of a sequence about life on
the North Sea island of Langeness.

ISO 200 | 50mm | f3.0 | 1/3200s

Natural Light
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For this shot of TV chef Sarah Wiener, I increased the sensitivity setting all the way up to ISO 1000 to take
advantage of the pleasing ambient light. Today’s high-end, noise-reduced DSLRs make such high ISO settings
much less of a problem than they used to be. 

ISO 1000 | 29mm | f3.0 | 1/80s



If possible, Ballnus prefers not to use built-in
flash or a flash unit attached directly to the
camera’s accessory shoe. He has a couple of
simple tricks to get better flash results and says
photos shot using direct, frontal flash often
look ‘cheap’, whereas a flash sync cable or

remote release can cost as little as US$30 and
allows you to position your flash off-camera,
giving you much more creative flexibility. Pro
photographer Tom Ang describes the
experience of using freely movable, off-camera
flash as “intoxicating”. Ballnus also likes to use

colored foils to alter the effect of the light his
flashes produce: “Colored foils give flash
photos a much more personal feel. I like to
experiment and have found, for example, that
shooting using LEE 105 Orange foil gives
photos a really attractive warm look.“
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Portrait Workshop | Flash 

ISO 640 | 24mm | f3.0 | 1/30s

Using Flash

Using remote flash is a great way to produce unusual
images (see opposite). I also like to attach colored foil to
my flash to give the light it produces a slight tint. 

Holding your hand in front of the flash
during an exposure is a great way to
produce unusual flash effects like the
one shown on the left
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This shot was captured using just the ambient
artificial light

ISO 1000 | 50mm | f3.0 | 1/30s

This shot was captured using the flash unit
built in to my Nikon D700

ISO 2000 | 45mm | f4 | 1/100s

Here, I lit the subject from above using a handheld
Speedlight SB-400 flash (without colored foil)

ISO 2000 | 48mm | f4 | 1/100s

This shot was lit like the one on the left, but this
time with an orange foil covering the flash

ISO 2000 | 48mm | f4 | 1/100s



Black and white photos still fascinate many
photographers. Many subjects simply 
look more spectacular if captured in
monochrome, and removing the color
element is a clever move when it comes to
giving your images more impact. “Black and
white is often a great solution in mixed-light
situations or when the colors in the subject

and the surroundings clash,“ says Ballnus.
Shooting successful black-and-white photos
involves making a composition less complex
while underscoring the shapes and forms
rather than the colors themselves. Pro
photographer Michael Freeman has
described how a lack of color influences
image composition, shifting the emphasis

from color to tonal contrast and the outlines
and graphical forms within the frame. This
effect is particularly clear in the portrait
opposite. In spite of the obvious allure of
monochrome, it only plays a minor role in
commercial photography. Ballnus receives
just “one or two” requests a year for black
and white work.
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Portrait Workshop | Black and White 

This shot of members of the band Beautiful
F***ing Sabine in their ramshackle
rehearsal studio is much more effective in
black and white

ISO 2000 | 24mm | f3.0 | 1/13s

Black and white is often a
good choice for portraits of
distinctive individuals like
musician Rita Marley 

Shooting in Black and White



63c’t Digital Photography 14 (2014)

I like to use clear lines like
those found in door and
window frames to give my
images structure. Using
black and white in this shot
of the actress Hannelore
Hoger further emphasizes
the clarity of this approach.



Ballnus thoroughly researches each portrait
project before starting a shoot: “I always try to
gather as much information as possible about
the person or story involved. This gives me a
stronger basis for developing ideas for the
shoot. I’m always taking notes and making
sketches, and I can refer back to my personal

archive of ideas when an appropriate situation
comes up.“ 

Celebrity portraits are, of course, the most
intense jobs. “The shoot with soccer coach
Juergen Klopp accompanied a magazine
article on his terrific abilities as a motivator,
and I had already formulated the ‘tearing up

trees’ idea before we began.” Always aim to
be flexible and be prepared to allow
unplanned events to influence a shoot. For
example, in the shots of author and
ethnopharmacologist Christian Raetsch, his
cat played an interesting spontaneous role in
the session.
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Portrait Workshop | Ideas 

Sometimes, simply switching from portrait to
landscape format gives a shot a completely
different atmosphere.

ISO 200 | 7 mm | f4 | 1/30s

A session comes close to perfect if everybody
plays their part and has fun turning the
photographer’s ideas into reality. This happened
in this shot of soccer coach Juergen Klopp, who
claims to want to “tear up trees” with his team.

ISO 100 | 38mm | f5.0 | 1/80s

Developing Ideas

ISO 200 | 27mm | f4 | 1/30s



This scene, captured in Goa, India, 
was perfect for playing with the contrast
between blur and sharp details



When preparing a shoot, Ballnus always thinks
about bringing along props such as a sailor’s
jersey, artificial blood or a piece of patterned
fabric for a background. “If I’m working with a
suitable subject, I love to introduce bizarre
and offbeat elements into an image. Bar
owner Joerg Meyer (see opposite) was just
such a subject and his bar is full of

architectural and decorative details that
create a great atmosphere for a shoot.” Props
often add spice to a portrait, and emphasizing
selected details in the subject can also help to
give an image extra punch, as in the sequence
below. 

The photos below were all shot within a
very short space of time. Herlinde Koelbl

(herlindekoelbl.de) takes a very different
approach, portraying powerful politicians in
exactly the same pose at intervals of several
years. The changes that power can make to a
person’s appearance over time can be quite
astonishing (sea)

Portrait Workshop | Sequences/Props 

Shooting Sequences and Using Props

Sequences of images often make
an interesting way to show
multiple facets of a subject’s
character, as shown here in a
session I shot with nonagenerian
German politician Helmut
Schmidt. Bringing tiny details
like the wedding ring and the
cigarette into sharp focus give
this series its final polish.
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Some jobs cry out to be pepped up using props typical to the person being portrayed. 
In this case, it was an obivious choice to introduce a cocktail (here, a gin basil smash)
into this shot of Joerg Meyer, the owner of the Le Lion – Bar de Paris in Hamburg. c

ISO 200 | 48mm | f5.0 | 1/50s
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Michael Jordan

GIMP
or Photoshop?

Adobe’s new licensing model means that in future it will only
be possible to rent their sofware products. This change has
prompted many users to look for alternatives to Photoshop,
and the open source GIMP package is high on many people’s
lists. We took a closer look at this powerful free tool.
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There is no simple answer to the question
of whether GIMP is a real alternative to

Photoshop, as there are too many users with
their own ideas and too many ways to use
both programs to compare them directly.
Whether a potential GIMP user already has
experience using Photoshop.also makes a
difference: image processing beginners are
bound to be less biased than old Adobe
hands.

GIMP is available for Windows, Mac OS X,
Linux and various other UNIX derivatives and
can be downloaded for free from
www.gimp.org. The current 2.8.6 version 
is included on this issue’s free DVD. The
current CC (Creative Cloud) version of
Photoshop is part of Adobe’s new rental-only
licensing model and offers users the benefit
of software that always contains the latest
updates and improvements. At the moment,
a Photoshop-only subscription costs US$20
per month, while access to the entire range of
CC (Creative Cloud) apps – including
Illustrator, InDesign, Dreamweaver etc. – costs
US$50-75 per month, depending on whether
you take out a monthly or yearly subscription.
There are also special offers available for
existing users who switch to a CC plan.

If you are interested in 3D image
processing or work in a pre-press
environment, then Photoshop is doubtless the
more powerful and useful of the two
programs. The disadvantages of GIMP are that
working in Lab mode is only possible via a
workaround and it doesn’t offer the advanced
Apply Image and Calculations functions that
are available in Photoshop. 

In view of these differences, GIMP is a less
likely choice for imaging professionals, but
can still be extremely useful for other groups
of users. On the following pages, we
investigate its strengths and limitations lie.

The User Interface

Experienced users will probably have an easier
time than beginners getting used to the GIMP
interface, and many tools and functions will
appear familiar, even if their names are
confusing at first. 

Many of the menu entries and settings
options are the same in both programs, which
even have the same number of main menus.
However, while GIMP has dedicated Colors
and Tools menus, Photoshop tucks them away
in various sub-menus. On the other  hand,
Photoshop offers dedicated 3D and Type
menus that are not part of the main interface
in GIMP. Generally speaking, Adobe’s menus
are more comprehensive than those offered
by GIMP.

Both applications offer a range of standard
keyboard shortcuts, although some have
different functions. For example, Ctrl+D
deletes a selection in Photoshop but
duplicates the current image in GIMP. If you
want to use both programs, it is a good idea
to manually set the shortcuts you use most
often so that they are identical in both
programs. 

Just as Photoshop has its own native PSD
format, GIMP offers its own proprietary XCF
format for saving layers, paths and text
losslessly with 8-bit files. GIMP also supports
output to JPEG and TIFF, although these
formats have to be selected using the
File>Export dialog.

The multiple windows that made up the
standard interface in earlier versions of GIMP
proved an insurmountable hurdle that put
many potential and experienced users off
further experimentation. Version 2.8
introduced the long-awaited single-window
mode that makes editing images and
managing multiple files much easier. Now,

each open image has its own thumbnail
located above the main image pane.
Multi-window mode still has its advantages if
you use multiple monitors, but single-window
mode is the better option for single-monitor
and notebook computing environments.

Layers

Layers functionality simplifies many aspects of
the image editing process. Although not
strictly necessary for performing basic
adjustments to an image, layers  are an
indispensible tool if you want to merge
multiple images into one or perform
non-destructive editing steps, layers. 

Layers offer a multitude of editing options
and one of the most powerful is the use of
blending (or ‘blend’) modes to merge the
pixels of one layer with the corresponding
pixels in another. The current version of
Photoshop CC  offers 27 different blend modes. 

GIMP offers 21 blend modes with
adjustable opacity just like their Adobe
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GIMP Special | GIMP or Photoshop?

Files have to be exported to save them in conventional non-GIMP
formats such as JPEG and TIFF

Single-window mode is not
the default view and has to
be selected manually



counterparts. Photoshop goes one better by
offering the Layer Style dialog for fine-tuning
blending operations by excluding predefined
tonal ranges from individual channels, while
GIMP offers no such sophisticated additional
functionality.

The ability to insert a file as a new layer in
an open image is often extremely useful,
especially if you need to merge multiple files
into a single HDR (high dynamic range) image.
In GIMP, this is achieved using the File > Open
as Layers command, whereas Photoshop uses
the File > Place command. Multi-layer images
opened this way retain their layers in GIMP but

appear as a single layer in Photoshop. If you
need to adjust individual layers in a placed
image in Photoshop, you first have to convert
the inserted image into a Smart Object. 

Batch Processing

Nowadays, most photographers who need to
process multiple images using the same
settings use dedicated RAW converters that

have effective built-in batch processing
functionality, such as Lightroom or Aperture.
This is often the case when photo sequences
are shot under consistent lighting
conditions – for example, using studio flash. 

The Batch Image Manipulation plug-in
supplied with GIMP enables you to apply
identical changes to parameters such as size,
cropping, rotation and color correction to
multiple images at the click of a button.
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GIMP Special | GIMP or Photoshop?

The GIMP
interface (right)

shown in
single-window

mode with light
gray padding.
Dark padding

makes the
program difficult
to use with some

monitors.

Smart Filters and Smart Objects are
Photoshop’s way of providing
non-destructive editing functionality



Photoshop offers much more comprehensive
automation in the form of Actions, which
allow you to record sequences of processing
steps that can then be applied to a selected
image. Actions can be halted at any time to
allow you to fine-tune the current step and
can also be saved as ‘droplets’ – micro-
programs that can be applied to multiple
images. You do not need any programing
experience to create a droplet: the File >

Automate > Create Droplet command simply
asks you to select the Action(s) that the
droplet should contain and the locations for
saving the droplet and the images that result.
Once a droplet has been saved, you can apply
the Action(s) it contains by dragging images
to its icon. This is a quick and practical way to
customize batch processes. 

Smart Objects

When Smart Objects were introduced with
Photoshop CS2, it was the first time Adobe
users had ever had the option of performing
non-destructive processing directly from the
Photoshop interface. Image editing suddenly
became a whole lot more flexible, as
adjustments made this way can be undone or
tweaked at any time. GIMP does not offer
non-destructive editing functionality or the
adjustment layers that allow Photoshop users
to apply Levels, Curves and other adjustments
to si-ngle or multiple underlying layers.

RAW Conversion

Developing ‘digital negatives’ (i.e., RAW
conversion) is one of the most challenging
aspects of the digital photographic workflow.
Portrait photographers need to optimize skin
tones and product photographers have to
find the best possible way to achieve realistic
color reproduction. Photoshop includes the
Adobe Camera Raw (ACR) conversion module,
which can convert source images to 8- and 16-
bit output files. The UFRAW conversion
module supplied with GIMP can only create 8-
bit output.

Both modules offer a wide range of
options and leave little to be desired in the
way of conversion flexibility. The GIMP
module takes a rather more ‘technical’
approach and uses terms that require prior
knowledge of RAW processing, for example
when selecting the best interpolation method
for a white balance adjustment. However, for
technically minded users, this approach offers
plenty of scope for making complex custom
edits. 

If you belong to the subset of users who
rarely require editing functionality beyond
that offered by RAW converters such as
Lightroom, Aperture, Capture One and iPhoto,
you probably won’t need the powerful tools
provided by  Photoshop CC and you will most
likely find that the range of editing options
offered for free in GIMP is sufficient to cover
your basic needs. If, however, you use your
RAW converter to preserve image data only
and prefer to use specialized software with a
greater range of options for editing tonal and
color settings, you will probably find that
Photoshop CC is more up your street.
Composited images always require separate,
complex processing.
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GIMP Special | GIMP or Photoshop?

The dark default interface in Photoshop
CC gives it a professional look. The
individual windows and panels can be
arranged and docked as you please and
each arrangement can be saved as a
preset view for use with a specific task.

The basic order of Photoshop’s
27 blend modes is different from that 
of the 21 modes offered by GIMP



Conclusions

Is a bicycle tour a real alternative to overseas
travel? Both provide a change of scenery and
help you to unwind, but do so in very different
ways with differing degrees of comfort. 
The  question of whether GIMP offers a real
alternative to Photoshop is similar. 

Both programs enable you to process
images digitally, and it really doesn’t matter
which you use to perform basic corrections to
levels and tones or to sharpen the results. The
same is true for selective adjustments to
contrast, brightness and color. 

Photoshop, with its Actions and ‘droplet’
functionality, offers distinct advantages when
it comes to automating multiple recurring
tasks while retaining the ability to intervene in
the process and fine-tune the results where
necessary. 

On the other hand, GIMP offers a number
of interesting and sometimes surprising tools
whose effects can only be duplicated in
Photoshop using multiple steps or
workarounds. For example, the Filter >
Combine > Filmstrip command uses a single
click to insert multiple images into a frame
that looks like a strip of analog negatives.

The overall look of the GIMP interface is
slightly less cohesive than Adobe’s offering, 
but this doesn’t detract from its effectiveness
or the quality of the results. Again, for the
technically minded, GIMP presents an
interesting, sometimes challenging, but always
rewarding approach to digital image editing. 

GIMP’s strengths lie in its basic editing 
and simple retouching functions and in 
its comprehensive and effective print
management module. If you only need the
tools offered by GIMP, the results will be just
as good as those Photoshop can provide.
However, Adobe’s tools still offer more
options and sometimes simpler handling too.

While most imaging professionals will
probably subscribe to the Creative Cloud
model sooner or later, amateurs and semi-pro
users no longer have the option of ‘missing
out’ a particular upgrade to save costs or
simply because a new version doesn’t provide
any relevant improvements. In future, anyone
who wishes to continue using Adobe imaging
products will have to decide whether they are
worth a monthly investment of at least US$20.

However, going back a few years, no-one
would have believed how much people are
now prepared to pay for their monthly mobile
communication needs. Perhaps Adobe will
come up with a prepaid model that only
charges users for the time they actually spend
using the software – until then, that old CS
version or GIMP might just be all you need
after all. (pen/keh)  c
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GIMP Special | GIMP or Photoshop?

Version 8.0 of the Adobe Camera Raw conversion module offers complete
RAW processing functionality in a single easy-to-use interface

The UFRAW module built into GIMP is rather ‘technical’ and only works in 8-bit mode

The Batch Image
Manipulation plug-in
provided with GIMP takes
a much simpler approach,
enabling you to adjust
size, color and other
image parameters for
multiple images with a
single click





For many photographers, Photoshop is still the image
processing program that matters the most. However,
since Adobe introduced its new subscription-only
licensing model, many seasoned users have begun to
experiment with the open source competition. In this
article, Bernhard Stockmann uses hands-on examples
to show just how capable GIMP has become. 

Bernhard Stockmann

Editing
in GIMP
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There is no question that Photoshop
remains the de facto standard image

processing software for many imaging
professionals. However, since the introduction
of the new subscription-only licensing model,
Adobe’s largely unchallenged hold on the
market has begun to crumble. Many users
have been scared off by the new pricing
structure and end up trying out GIMP sooner
rather than later. 

GIMP has been under constant
development for more than 13 years and now
includes many of the features requested by
users. The latest version features the
long-awaited single-window mode, which 
has been widely celebrated by the GIMP
community. The latest Windows version 2.8.6

has been downloaded more than five million
times in the last few months, and that figure
doesn’t even include the predecessor 2.8.4
and 2.8.0 versions or Linux and Mac builds. 

As well as being entirely free (we have
included the current version and a selection
of plug-ins on this issue’s free DVD), GIMP is
also a highly versatile application. I have been
using it professionally for more than seven
years for Web design and for compositing
images that I publish regularly at 
gimp users.com.

The following pages provide an overview
of the GIMP interface, an introduction to some
of the most important tools and functions and
a series of step-by-step portrait-editing
tutorials.

In this article
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An Overview of the GIMP Interface

Navigation Bar for Open Images:
You can scroll through open files using 

Ctrl+Page Up/Page Down. Individual images 

can be activated using Alt+number key.

Toolbox:
This is where you can 

select which tool you 

want to use to process 

your image. You can hide 

tools you use less often 

in the Toolbox section of 

the Preferences dialog. You 

can also select smaller icons 

under Preferences > 

Theme > Small.

Tool Options: 
This is where you make 

the settings appropriate 

to the currently active 

tool

QuickMask Toggle:
Shows the current 

selection as a translucent 

screen overlayed on the 

active image. 

Right-clicking the icon 

reveals a context menu 

with configuration 

settings  for the mask.

Active Colors:
Click on the foreground 

or background color to 

open the Change Color 

dialog.

If selected in the 

Preferences dialog, this 

panel also shows the 

current brush, pattern 

and gradient settings.

Menu Button:
Click the Menu Button to display the Image Menu in a 

column (essential in full screen mode). Right-clicking within 

the image window is another way to open the same menu.

Active Image:
Here, the canvas has been configured with  dark padding. 

This setting can be adjusted in Preferences > Image 

Windows > Appearance > Canvas padding mode.

Status Bar:
Displays the current pointer coordinates, the Units menu, and the current zoom setting. 

Pressing the 1 key switches to the 100% view and the 2, 3 and 4 keys each double the previous 

zoom ratio. Use Ctrl+scroll wheel to scroll through the zoom steps incrementally. 

The amount of system memory used by the current image is also displayed.

The GIMP interface is complex and contains a wealth of information and settings
options. The new single-window mode (Window > Single-Window Mode) is an
important addition for potential converts from Photoshop. The most important
components of the GIMP program window are shown below.
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Blend Mode and, beneath it, 

the opacity setting

This is where dialogs can be dragged to a single dock. In this example, the 

Layers, Channels and Paths dialogs are grouped in one dock, while FG/BG, 

Histogram, Undo History, Brush and Paint Dynamics are grouped in another.

Click and hold the Navigation 

Control  to navigate the preview 

pane within the image area

The active image is automatically 

zoomed when you alter the size of 

the image window

Dialog Buttons:
This example shows the buttons 

included in the Layers dialog. These 

are: Create a New Layer, Create a New 

Layer Group, Move Layer Up Stack, 

Move Layer Down Stack, Duplicate 

Layer, Anchor Floating Layer and 

Delete Layer. The Anchor and Create 

New Layer buttons determine 

whether content you insert is added 

to the active layer or a new layer.

The Active Layer Entry:
Here, you can see the eye icon for 

showing and hiding the layer and 

the linkage icon that indicates 

whether the layer is linked with others. 

Right-clicking the layer name reveals a 

comprehensive context menu that 

contains (among many others) 

commands for merging layers, 

creating layer masks and adding an 

alpha channel.

You can lock the pixels on a layer 

and the opacity setting to prevent 

unintentional changes. Locking 

opacity helps to adjust only pixels 

that have a value other than 100% 

transparent.

If you have activated this option, 

you can fill a shape with a selected 

foreground color without altering 

the layer‘s non-transparent areas. 

Title Bar: 
The * at the start of the filename means that it has not yet 

been saved. Also displayed are the color space, the number 

of layers and the dimensions of the image.

The Tab Configuration 
Menu is inconspicuous 

but very useful. Here, you 

can alter the tab style to 

include icons, text or both, 

and alter the size of the 

icons to save space. In our 

example, the icons have 

been hidden and only the 

text-based tab names 

are shown.



GIMP is an extremely versatile program
and has a correspondingly large range
of tools and dialogs. The following
sections describe some of the most
common of these.

We begin by taking a look at the two most
important tools for adjusting image contrast,
the Curves and Levels dialogs. (The Levels
dialog can also be used to adjust white
balance.) We also provide some tips on how
to crop images effectively and point out

pitfalls to be aware of when saving and
exporting edited image files. The save and
export functions were radically rejigged in the
latest version and have been the subject of
some serious controversy within the
community.

78 c’t Digital Photography 14 (2014)

Important Processes and Tools

The effect of applying an S-curve

Of all the editing tools offered by GIMP, the
Curves dialog (Colors > Curves) is probably
the most important. Using the manipulable
curve superimposed on the histogram, you
can precisely adjust the brightness and
contrast of an image. Clicking on the curve
automatically creates a new ‘anchor’ that you
can then shift up or down to lighten or darken
the image.  

The dialog provides tools for loading and
saving preset curves, adjusting individual
color channels and altering the type of curve
that is applied. The ‘Smooth’ curve type
smooths the transition between anchors and
increases or decreases the brightness of
neighboring pixels accordingly, while the
‘Freehand’ curve type enables you to address
specific brightness values individually. You

can toggle your change on and off by
checking and unchecking the Preview box, or
simply leave it checked to see the effect of
your changes in real time. An inactive (black)
anchor can be deleted either by pressing the
Del key or dragging it out of the histogram
frame. 

The Curves Dialog

Applying an S-shaped curve is a simple and
effective way to simultaneously brighten the
highlights and emphasize the shadows in an
image. This is achieved by shifting the upper

anchor upward and the lower anchor
downward. The result of these two shifts is an
increase in overall contrast, which is
illustrated very well by the more intense

appearance of the clouds in our example
below. An inverted S-curve reduces contrast
and makes an image look paler.

Applying an S-Curve

The Curves dialog
automatically saves all your

recently used curves

GIMP Special | Program Basics
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The Alpha channel in the Curves dialog can be
used to adjust the transparency of
semi-transparent objects. To achieve this
effect, we created a text object with reduced
opacity, opened the Curves dialog and
switched to the Alpha channel (i.e., the
channel that contains the transparency
setting). We then shifted the upper right-hand
and lower left-hand anchor points toward the
center of the top and bottom axes. This
change makes semi-transparent pixels
completely transparent while the darker,
partially filled pixels become completely filled
and well defined. 

Controlling Transparency

The Levels dialog (Colors > Levels) is another
tool that is often used to adjust brightness
and tonal values. While the Curves dialog is
good for adjusting individual tones, the Levels
dialog is better suited to adjusting the
distirbution of brightness values (i.e., tonal
levels) within an image. It is most often used
to adjust white balance. 

The two eyedroppers located beneath the
Input Levels graph are extremely important
and are used to select the darkest and
brightest tonal values in the image.  Once you
have made these selections, GIMP
automatically adjusts the contrast between all
the pixels in the image to match. The black,
gray and white triangular sliders beneath the
histogram are used to determine which tones
are clipped – in other words, the point at

which dark gray tones tend to black and light
gray tones tend to white. The center
(‘gamma’) slider determines the level of the
mid-gray tones and can thus be used to adjust
the overall brightness. The ‘Auto‘ button
adjusts white balance automatically and has
the same effect as using the Colors > Auto >
White Balance command. However, use this
button with care, as the results are often
imperfect and are better used as a starting
point for your own manual adjustments.

Adjusting White Balance Using the Levels Dialog
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The Levels dialog can be
used to adjust image

brightness and tonal range

Low contrast Increased contrast

100% transparency

Semi-transparent text

AfterBefore



If you need to crop an image for whatever
reason, basic rules of aesthetics such as the
‘rule of thirds’, the ‘rule of fifths’ and the
’golden section’ help to produce a final image
with a pleasing composition. GIMP includes
overlay guides for all these rules and more to
help you find just the right position for the
most important elements of your subject.
Simply activate the Crop tool (Shift+C), and
select the appropriate guide from the drop-
down menu at the foot of the Tool Options
panel.

Artistic Cropping

Version 2.8 introduced a completely new
approach to saving and exporting files. The
File > Save As... command now only saves 
files to GIMP’s native XCF format (or the
.xcf.bz2/.xcf.gz compressed formats). This is
the only format that guarantees to preserve
all the channel, layer and path data included
in an image, and is thus the best option when
saving heavily edited images. Using the File >
Export command saves a copy of the current
file to a selected conventional format such as
JPG, TIFF, PNG or one of a range of other
options. GIMP currently only supports 8 bpc
(bits per color channel) files, but the
upcoming version 2.10 will support 16-bit file
formats too. The File menu also includes the
new Overwrite command, which is useful if all
you want to do is open a file, make a quick
adjustment and save it. This command
requires you to confirm the changes you have
made before overwriting. 

If you need to use the Overwrite command
regularly, why not set up a custom accelerator
(hotkey) using the Edit > Keyboard Shortcuts
dialog? This will speed up your daily workflow
significantly.

Lossless Save and Export
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The Crop tool include various
overlay guides to assist you in

selecting your final composition

The proprietary XCF format is the
best option for saving heavily edited

image files. If you are absolutely
certain that you no longer need the
original, you can use the Overwrite

command in the File menu.
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The best way to get a feel for the colors in an
image and how to adjust them is to use the
color wheel tool (Windows > Dockable Dialogs >
Colors). The color to look out for is the one
opposite the one you want to adjust (i.e., its
complementary color). In this case, we want to
reduce the yellow tone, so we need to adjust the
cyan and blue tones accordingly. 

Step 1

The portrait shown below left has a warm color cast
that makes the photo look incorrectly exposed. The
following pages detail three different ways to
effectively remove this cast.

Mixed light sources, the wrong white balance setting or some
other unforeseen factor can cause an incorrect exposure, and GIMP
offers various ways to tackle this type of problem.

AfterBefore

Three Ways to Remove a Color Cast

Method #1: Using Color Balance

The simplest and most obvious method is to use the
Color Balance dialog (Colors > Color Balance – see the
illustration in Step 2). In this case, the shadow, midtone
and highlight tones are altered in relation to the tonal
values in the active layer.

It is important to
identify the
complementary of the
color you wish to adjust
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Step 2

Begin by creating a new layer
above the image layer. Now
select the eyedropper and use it
to select an area that shows the
color cast you wish to remove
(we selected our subject’s upper
arm). In order to retain the base
color in the selected image
element, brighten it slightly – for
example, by shifting the cursor
along the appropriate axis
within the color wheel.

Step 1

Method #2: Using Blend Modes

An intuitive way to remove color casts is to use a new layer to ‘tell’ the
original image which color is incorrectly depicted (i.e., the tone or tones
that are too yellow in the original).

Because GIMP doesn’t yet support adjustment layers, it is
best to perform color corrections on a duplicate image
layer. We already identified the colors that require tweaking
in step 1, so open the Color Balance dialog (Colors > Color
Balance) to proceed. Begin by selecting the range that
requires the most adjustment (in this case, the highlights)
and intensify your chosen tone by shifting the appropriate
slider toward the name of the corresponding color. We
selected values of +15 Yellow/Blue and -10 Cyan/Red and
left Magenta/Green as it was. The midtones in our original
image were also a little too yellow, so we adjusted these
too, using less severe values of -5/0/10.

These types of adjustments can reduce color intensity in
the shadows (in the darker parts of our subject’s hair, for
example), and shifting the Cyan/Red slider toward the red
end of the scale can help to alleviate any imbalance. We
used values of 10/0/0.
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Fill the new layer with the color you have just selected
(Edit > Fill with FG Color)Step 2

Set the new layer’s mode to Divide. This divides the pixel
values on the lower layer by the ones in the newly filled
layer, thus removing them. If the resulting effect is too
strong (i.e., too much color is removed), you can attenuate
it by reducing the opacity of the color layer (in our case we
set it to 70%). This method is highly intuitive and quickly
leads to satisfying results. Once you are happy with the
effect you have produced,
selecting the Layer > New from
Visible command merges the
background (image) layer with the
subtracted color layer and creates
a new combined layer which you
can then edit further.

Step 3
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Method #3: Using Color Temperature

The quickest way to remove a color cast is by way of the color
temperature sliders, which are part of an experimental GEGL filter
in the current version of the program. This works very well indeed
and is slated to be fully integrated in the upcoming 2.10 version.

To perform a color temperature correction, navigate to 
Tools > GEGL Operation and select the color-temperature

option in the drop-down menu at the top of the dialog that
opens. You can alter your image by entering Kelvin-based
values to either increase the original color temperature or
reduce the “intended temperature”. In our case, a difference 
of 800 K between the two values produced the result we were
aiming for.

Always perform significant
adjustments on a duplicate
of the original image
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The first step involves using the Healing tool to
remove skin blemishes. Unlike the Clone tool,
this tool is capable of detecting the brightness of
the surrounding pixels and adapts the cloned
elements to match the brightness of the target
area (i.e., the place where you insert the copied
pixels). Use a soft brush tip with a size setting of
about 45 for this type of work.

Step 1

Now we have removed the underlying color cast we can
concentrate on improving our new, ‘clear’ portrait image. The

following sections explain how to produce even-looking skin tones,
apply ‘digital make-up’ and add shine to the subject’s eyes.

AfterBefore

Retouching Portraits
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Select source pixels with the Ctrl key pressed, then
release the Ctrl key and click on the area where you
want to insert the source material. The circle with the
‘plus’ sign in it shows the location of the source pixels.
Repeat this process as often as necessary for all minor
blemishes.

Step 2

Step 3

We added an additional soft-focus effect to give our
portrait a smooth overall look. Conventional blur
effects such as Gaussian Blur are not suitable for
portrait work, as they blur the entire image to the
same degree.  Instead, we used  the Filter > Enhance >
Despeckle tool. We unchecked the Adaptive and
Recursive options and set the Radius to 16. Applying
this filter doesn’t affect the base tonal values or
contrast.

Another great trick for making skin look natural is
to add simulated ‘pores’ using a mild application of
the RGB Noise filter (Filter > Noise > RGB Noise). We
unchecked the Correlated noise option and used a
value of 0.30 for all three RGB channels. This step can
be repeated until the desired effect is achieved.

Step 4

We used the Clone tool to cover the dark circles
beneath our subject’s eyes. For tasks like this, it is best
to set opacity to 30-50% and cover any blemishes
successively. If you use too high an opacity value you
run the risk of overdoing the effect. We will address
the slight blur that this
step produces in the steps
below.

Reduce skin blemishes
slowly and carefully but
never completely. A face
with a few wrinkles looks
much more natural than 
a portrait in which all 
the wrinkles have been 
‘ironed out’.

Here, we used the Clone tool with a brush
size of about 100px and 40% opacity
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We then applied the Blur filter (Filter > Blur >
Blur) to take some of the sharpness off the
pixels created by adding noise. 
As an option, you can also accentuate the pores
using the Filter > Enhance > Sharpen tool. The
amount of sharpness you need to add will vary
from image to image.

Step 5

The simplest way to apply your newly
generated skin tone to the original image is to
hide all but the areas you wish to alter and
apply the remainder. Because your edited skin
tones are saved on a separate layer, you can do
this by creating a layer mask. The quickest way
to do this is using the Add Layer Mask
command in the layer’s context menu. In the
dialog that results, select the Black (full
transparency) option.

Step 6

Now select a soft brush with a size setting of
about 150 px and 70% opacity. Leave the
foreground/background colors at their
standard settings and press the D key to switch
the foreground color to black. Now all you have
to do is use the brush to paint the new skin
structure into the original image (in our case,
mainly in the subject’s cheeks). Pressing the X
key toggles the foreground and background
colors, enabling you to correct mistakes
immediately if you apply too many brush
strokes to a particular area of the mask.

Step 7
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If you click on the layer mask with
the Alt key pressed, GIMP
automatically superimposes the
mask on the image and displays a
magnified view. This is a great aid
when it comes to making precision
adjustments to a mask.

Step 8

To add a little blusher, create a new
transparent layer and use the Brush
tool and a deep red color to add a
few dabs to the cheeks. We used
code aa0909, which equates to RGB
values of 170/9/9. You can then use
the Filter > Blur > Gaussian Blur tool
with a Radius value of about 200 to
fine-tune the effect. 

Setting the blend mode to Hue
produced the best results for our
example, but you can experiment
with other modes, such as Overlay,
Soft Light or Merge Grain, to vary 
the effect. Try different opacity
settings too. 

Step 9
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bitte löschen!

We darkened the pupil using the
Dodge/Burn tool in Burn mode in the
Shadows range. Eyelashes can benefit
from this treatment too.

Step 12

Finally, we used a black layer mask (see
step 6 above) and a white brush to paint
the adjustments we had just made into
the original image.

Step 13

We then increased contrast around the
subject’s eyes. To do this, we created a
new layer (Layer > New from Visible) and
sharpened the whole layer using the
Filter > Enhance > Unsharp Mask tool
with its default settings of 5/0.50/0.

Step 10

To brighten the whites of the eyes, we
selected the Dodge/Burn tool with a
small, soft brush tip that was slightly
larger than the pupil. We set the tool
type to Dodge and the Range setting to
Highlights and used it to brighten the
reflections in the pupil and iris too.

Step 11
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Selecting Fine Details

If you want to add a new, more interesting background to a
portrait, fine details such as stray hairs can make it quite tricky to
make a clean selection. The steps outlined on the following pages

show you how to create a mask that follows even the finest lines in
the original photo precisely.

If you have just finished an editing process like the
one described on the preceding pages, the first thing
to do is merge the various layers you have created
into one using the Layer > New from Visible
command. The editing steps we already performed
have been gathered in a layer group, shown here in
its collapsed state. Now duplicate the new layer and
activate the duplicate. 

Step 1

The next step involves creating a black-and-white
copy of the original image layer with the aim of
using the Colors > Components > Channel Mixer
command to increase the contrast between the
subject’s hair and the background. Zoom in using
the + magnifier to get a better view and then adjust
the red, green and blue sliders until the
background is as near white as possible while
retaining a clear view of the detail you wish to
preserve. For details as fine as human hair, it often
helps to adjust the green channel, which often
contains the greatest contrasts. The red and blue
channels usually contain mostly bright details.

Step 2

AfterBefore
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Step 3

Now select the entire mask layer (Ctrl+A), copy
it (Ctrl+C) and activate the layer beneath.
Create a new layer mask and use Ctrl+V to
insert the copied mask.

The inserted content is initially floating (i.e.,
can still be moved and edited), so you need to
anchor it to the new layer mask by clicking the
‘Anchor floating layer’ button at the bottom of
the Layers dialog. 

Step 5

Step 4

Now invert the channel mixed layer using the
Colors> Invert command and edit out any
remaining skin blemishes using a black brush.
You can now use the Colors > Levels dialog to
adjust the tonal range. Shifting the triangular
white (highlights) slider to the left converts
light grays to white, and shifting the black
(shadows) slider to the right converts dark
grays to black. The gray (gamma) slider in the
center determines the level at which neutral
gray is set. To preserve detail in the hair in our
example, we shifted the gamma slider to the
left so as to retain more of the light gray tones
in our subject’s hair. 

To enlarge or reduce the size of the brush 
tip on the fly, press AltGr+8 or 9. Remember,
too, that you can toggle between the 
current foreground and background colors
using the X key.

We have already mastered the most difficult
details, so it is now time to take a white brush
and precisely trace the outlines of our
subject’s face and blouse. The easiest way to
do this is to reduce the opacity of the
black-and-white layer so that the ‘real’ edges
show through. When outlining details like
these, it is important to periodically switch to
a 100% opacity view so that you can still see
the remaining gray tones. The finished mask
should look something like the one shown on
the right, consisting mainly of pure black and
pure white areas and some gray tones where
individual hairs are visible (see step 5 below).
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Step 7

Step 8

Click the eye icon to hide the
black-and-white layer, then
create a new transparent layer
beneath the image layer and
select the Blend tool

Step 6

Set the foreground color to
white and the background
color to whatever color you
like. Set the Shape option to
Bi-linear in the Tool Options
and drag a gradient diagonally
down to the left, starting at
the subject’s forehead.

Our image is finished.
One final tip: if you are
using a dark background
color, switch to the layer
mask and shift the midtone
(gamma) slider in the Levels
dialog slightly to the right.
This ensures that any details
in the hair that are too
bright disappear and that
no gray background shows
through where the
individual hairs have been
selected.

c





Ralph Altmann

The Future 
of Digital Imaging

Bigger, better, sharper! While the major trends in photography
over the last few years have given rise to a lot of exciting
technical innovations, very little has changed in the way we
actually capture photos. However, research institutes and camera
manufacturers don’t just hone existing technology – they are also
working on completely new approaches to digital imaging that
promise to give the photographers of the future imaging
possibilities that the rest of us can barely imagine.
Conventional image optimization and error correction
processes are already becoming part of in-camera
firmware, giving us the freedom to concentrate on
getting really creative.



To predict the future, we must first look at the
past. The photos we shoot today are not very
different from those captured 170 years ago,
but technology has come a long way since the
pioneering days, and recent changes have
made it much easier for just about anyone to
capture sharp, shake-free and well exposed
images without a great deal of equipment.

For more than a century, photo engineers
made incremental progress as they
concentrated on improving the established
physical and chemical techniques involved 
in image capture, development and
enlargement. Then digital sensors
revolutionized the photographic workflow.
Suddenly, an image was ‘finished’ a fraction 
of a second after it was captured. An entire
industry was rendered obsolete and
renowned companies such as Kodak and
Polaroid went bankrupt.

However, the basic principles of image
capture have not changed since Louis
Daguerre made his first historic
daguerrotypes. A lens (often larger and
heavier than the camera itself) forms a
miniature image of the subject on a
light-sensitive surface where it is transformed
into a virtual image. The fundamental
shooting parameters of aperture, exposure
time, focal length and focus setting are just as
important now as they were in the very first
camera, even though the transformation is
achieved by microelectronics instead of
chemicals.

Today’s image creation options are not all
that different to those of our forebears either.
It’s true that we can generally shoot handheld,
whereas earlier photographers had to use a
tripod and today’s zooms replace the multiple
lenses of old, but there’s still not much we can
do to alter the actual content of an image
once the shutter has been released.

Subsequent changes to brightness quickly
exhaust the camera’s dynamic range, the
focus setting used at the moment of capture
is ‘set in stone’ and the resulting depth of field
is just as immutable. Focal length can only be
altered a little (using crop or ‘digital zoom’
techniques) before the loss of image quality
outstrips the potential improvements. We
cannot increase the angle of view and the
subject will look forever as it
did at the moment of
capture. If the bridegroom
blinked or looked away at

the crucial moment, then that’s what we get
to see.

A combination of experience, planning
and covering all the bases by taking multiple
shots of each scene used to be the only way
to avoid such pitfalls. ‘Light painters’ (as
photographers often see themselves) could
only dream of the freedom enjoyed by ‘real’
painters. Now, following a decade of
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Photo Technology
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Inventions such as liquid drop
image sensors (on the left) and
lenses made of fluids that
change their refractive index
when an electrical current is
applied (like the Philips camera
unit including such a lens is
pictured above), have the
potential to make camera
technology a lot simpler and
cheaper

A young man has been asked to take photos at a family wedding using his
brand new camera, but no-one is paying any attention to his requests to

pose or get into groups. Then the weather turns and he has to simply
shoot as many photos of all the guests as quickly as he can before the
rain starts. Later on, he manages to get a group shot of the bride and
groom and all 60 guests from behind the altar. He is much too close to
the subject, but his camera’s software enables him to capture a sweep

panorama and merge the individual source images as he likes later on.
Then comes the big moment – the kiss, spoiled only by the massed

clicks of everyone else’s smartphone cameras and the quiet ‘beep’ that
tells us our hero’s memory card is full.

Looking into the
Future #1
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discussion about the legitimacy of digital
image manipulation, this situation is now
beginning to change. ‘Smart’ software has
simplified and automated image processing
techniques that used to be the exclusive
preserve of pro photographers and have
made them available to the mass market.
Research institutes and companies, too, are
hard at work on innovations that are sure to
change not only photographic techniques,
but also the very idea of what photography is,
possibly to an even greater degree than the
digital revolution has already.

Paradigm Change

The term ‘image processing’ can be
interpreted in two main ways. It may be used
to describe the correction of technical or
aesthetic errors such as bad framing, blur, a
slanted horizon or color casts or the ability to
chemically or electronically reinterpret the
imperfections of nature. One of my key
photographic experiences was adding
dramatic clouds to a photo of my elementary
school building using a sponge and a
deliberate overdose of developer fluid. Back
then, this kind of adjustment was the limit of
what an amateur could do to alter a the look
of a photo.

This aspect of
photography has
changed dramatically, in
that changes that would
have taken a whole team
of experts days to realize
just a few years ago can
now be applied with 
the click of a mouse.
‘Creative’ tools such as
Photoshop’s Clone
Stamp, Quick Selection,
Smudge and Blur, and other tools based on
the PatchMatch algorithm (Content-Aware
Move, Spot Healing Brush etc.) are redefining
the border between photography and
painting.

Many conventional image processing tasks
are now performed automatically in the
camera or invisibly in the background during
RAW conversion. Automatic white balance,
sharpening, brightness correction, contrast
adjustment, color balance, black-and-white
conversion and even cropping are all standard
features in many of today’s cameras. Useful
features such as red-eye correction and face
and blink detection that started life as
consumer-level gimmicks are rapidly finding
their way into high-end image capture
devices too. Under normal lighting conditions,
it is now virtually impossible to shoot
technically substandard photos, although

seriously high-key and low-key situations 
still cause many cameras problems.
Complementing this technical near
perfection, modern camera gear offers
photographers countless ways to make their
results more aesthetically pleasing, including
artificial horizons, built-in ND filters and
composition grids.

The more automatic image processing is
built into the camera, the less relevant it
becomes at the post-processing stage, so,
unless you are intent on squeezing the very

last drop of quality out of an image, you can
often do without post-processing altogether.
Most cameras have a print interface built in
and many cameras and smartphones are
equipped with wireless upload functionality
for Twitter, Facebook and other social media.

However, the digital revolution has also
made some things more complicated. In
earlier times, if our images showed significant
distortion or chromatic aberration, we would
have gone out and bought a new lens.
Nowadays, such errors can be removed
electronically, but only using dedicated
software and proprietary lens profiles that
usually cost money. Very few cameras have
built-in functionality for combating these
types of errors, and even where it does exist,
it usually only works with same-brand lenses.
Color management is a fine invention that
helps us to display and output consistent
colors on a huge range of device, replacing
the analog technique of combining particular
film and paper types to ensure color
consistency. But why is it still being
implemented so inconsistently, 20 years after
its introduction? 

The ability to use software to compensate
for hardware errors has led to the production
of increasingly cheap hardware, and many in-
camera processes exist only because the
hardware surrounding them doesn’t do its job
properly.
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Maybe the analog world was better after all! ‘Retro’ developing styles that can be applied
at the click of a button are a standard feature of just about all contemporary imaging
processing software, from Paint Shop Pro (above) to Hipstamatic.



To be able to manipulate image content,
software has to be capable of recognizing
different elements rather than just seeing an
image as a random collection of pixels. In a
two-dimensional image, a program can only
differentiate between areas with different
brightness, color or texture. This is why
PatchMatch technology fails when faced with
replacement tasks (such as replacing curved
lines) that humans perceive as relatively simple.
Although the human eye initially sees an image
as a collection of different colors and degrees
of brightness, our brain quickly switches in and

compares these apparently random patterns
with ones saved in our memory and assigns
appropriate objects to them.

Such ‘knowledge-based’ recognition
methods are not the exclusive preserve of
humans, and they already provide reliable face
recognition functionality in programs like
Photoshop Elements and Picasa. However, it is
much easier to simply recognize a face for
what it is than to separate it from its
‘non-facial’ surroundings. Things become even
more complex if we want to remove an object
that partially covers a face and restore the

resulting areas to match. Simply duplicating
neighboring pixels isn’t sufficient, and
software has to have prior knowledge of
human anatomy or be capable of mirroring or
copying similar nearby features to perform the
task successfully. To make things even more
complicated, subjects don’t always look
straight into the camera, so software has to
extrapolate any information it recognizes into
three dimensions. Generally speaking, object
recognition is easier if depth-related data is
available. Read on to find out how such
information can be recorded and used.
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From a Pixel to an Object

A standard feature of many free and
commercial image processing programs, 
the PatchMatch algorithm enables us to
intervene almost undetected to move,
remove and scale selected objects. The
‘new’ background is constructed from the
pixels surrounding the moved object.

Our hero uses the source images he has captured to create a group portrait on his
tablet computer using the source images he has captured. The object detection

functionality built into the software has already selected individuals and separated
them from the background, so he only has to move them to the right place with a
fingertip gesture. Some of the original images were shot in the sun, so he uses an
app that caclulates the real brightness and reflectivity of the objects contained in
the 32-bit images to unify the lighting. He uses the universal standard Lab color

space that replaced the sRGB space a number of years ago. As a joke, he transplants
the entire wedding party to a tropical island. All he has to do is use his sketch app to

draw a couple of palm trees and an elephant or two – the software then searches for
appopriate images on the Web and inserts them into the finished image.

Looking into the
Future #2



Hyper-real Images

Object recognition is just one step on the
way to producing ‘images’ that simulate
photographed reality instead of just
producing a two-dimensional copy, and two
other aspects of this process have already
become the state of the art. HDR imaging
techniques can be used to convert
bracketing sequences into single 32-bit
images that contain the entire dynamic
range originally present in a subject (see
Issues 7 and 8 of c’t Digital Photography for
more on HDR techniques and color
management). Because a single source
image can never capture the entire range of
tonal values in a subject, an HDR (high
dynamic range) image is, in fact, a small
piece of virtual reality. Taking an HDR image
as a basis, you can select a range of tonal
values that you then use to create under- or
overexposed ‘photos’ in which you can also
manipulate the range of tonal values (using
tone mapping techniques) to alter exposure
and/or contrast. The effects you can achieve
range from simulating fill flash to creating
artificial lighting conditions that simply
don’t exist in reality.

Just as HDR techniques are used to
overcome the limited dynamic range that
cameras can capture, panorama techniques
can be used to create images with a much
broader angle of view than any existing lens
can capture. In a panorama, a series of
source images are overlapped to form
extended-view images that can cover the
entire circular (or even spherical) field of
view surrounding the photographer. Each
element of a spherical panorama represents
an individually created virtual photo with its
own virtual angle of view. A detail taken
from a spherical panorama has the same
problem as any photo shot using a wide-
angle lens or any map representing a section
of the Earth’s surface, namely: distortion. If
you are prepared to accept distortion as part
of the overall effect, you can use panorama
software to project an entire 360-degree 

(or spherical) view into a single
two-dimensional image according to the
dictates of geometry and optics. The
technique has its limitations, but
nevertheless creates a scene that no camera
can capture. These, often called ‘little
planets’, are one of the most spectacular
hyper-real image effects available to today’s
digital photographers. See the title page of
this article for an example.

Simulated Super-lenses

Panorama stitching techniques can be used
to create images that appear realistic at a first
glance but simply cannot be photographed
using conventional equipment, due to
‘impossible‘ viewpoints or lens geometry.
‘Bokehrama’ images (see Issue 12 of c’t
Digital Photography) are a good example of
this type of contradictory technique.
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Hyper-reality
in practice: 

can you see the
difference? One half

of this image is a
photo and the other
was rendered using
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Chinese researchers have created an app
(Sketch2Photo (http://cg.cs.tsinghua.
edu.cn/montage/) that shows it is
possible to transform a sketch into a
photo – at least in principle.
Sketch2Photo analyzes the sketch and
searches for appropriate elements on the
Web, which it automatically inserts into
the finished photo. 
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Stereographic projection of spherical
panoramas can be used to create ‘little
planet’ images, like this one of the
German Chancellor’s office in Berlin



Stitching images together in a way that
enhances the angle of view and pixel count
but retains the shallow wide-angle depth of
field, they simulate the effect of using a
camera with an impossibly huge sensor. This
approach makes it relatively simple to
simulate DSLR or medium-format results
using a compact camera. To produce such
results using conventional equipment, 
the lens would have to have an extremely
short focal length and a huge maximum
aperture. Apertures of f1.0 and more can 
be simulated using this method, and 
even the absolute maximum of f0.25 is
theoretically achievable. The online tool 
at http://brettmaxwellphoto.com/Brenizer-
Method-Calculation/ calculates the effective
focal length and aperture of a ‘bokehrama’
image.

Aside from the the bokeh effects it 
can help you achieve, shooting multiple
neighboring images is a great way to simulate

the effect of an ultra-wide-angle lens. Most
stitching software is capable of compensating
for the slight parallax errors that shooting
handheld causes, and the result is an image
with increased resolution. Shooting in
precisely calculated increments using a
telephoto lens, you can shoot the source
material for ‘gigapixel’ images (see Issue 7 of
c’t Digital Photography), which you can then
stitch together using dedicated software 
and a powerful computer. We are sure that
the processing power built into modern
digital cameras is capable of automatically 
aligning and stitching 10 or 12 images into a
‘pseudo-ultra-wide-angle’ shot, but we
haven’t yet heard of it being done. The ‘sweep
panorama’ functionality built into many
compact cameras and smartphones is a step
in the right direction but not the high-quality
solution we would prefer to see.

While bokehrama techniques aim to
reduce depth of field, macro situations

require us to extract the greatest possible
depth from a situation. Once again,
sequences of source images come to the
rescue, this time using the same camera
position but differing focus settings from
shot to shot. Specialized software is then
used to extract the sharpest areas from each
source image and merge them into a single
image with enhanced depth of field. Camera
do not provide any direct support for this
technique either. The most complex aspect
of the process, which could easily be
automated, is precise sequential adjustment
of the focus setting. The underused
potential and ‘hidden’ functionality
contained in many cameras has recently
been revealed by determined camera
hackers, most notably the creators of the
Canon Hack Development Kit (CHDK) for
Canon compacts (chdk.wikia.com) and
Magic Lantern (www.magiclantern.fm) for a
range of Canon DSLRs. 
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A sequence of images taken at slightly varying focus
settings can be merged to form a single image with
enhanced depth of field. This technique, called ‘focus
stacking’, uses only the sharpest areas of each image in
the final result. To achieve this effect, Photoshop creates
‘hard’ borders between the individual image areas (see
the stacking sequence on the right), while other
programs, such as Helicon Focus, use ‘soft’ transitions.
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A video is really only a sequence of photos
shot at high speed, and we are sure that
these two media will soon merge into one.
Burst shooting rates are getting faster all the
time, and video formats are constantly
increasing in size. The largest video format
so far, 8K UHDTV, captures 7680 x 4320-pixel
(33.2-megapixel) frames that exceed the
resolution of most of today’s high-end stills
cameras. RAW and HDR, too, are no longer
taboo terms in the world of digital video.
Video shot with a DSLR uses only a fraction
of the available sensor cells to capture 
each frame. The merging of the photo and
video media will be complete when 
hard- and firmware are sufficiently well
developed to capture full-sensor video

frames at today’s frame rates. This change
will enable publishers to use individual
frames in multiple situations but will mean
less work for TV and print journalists. Sport
and action photographers will also be able
to choose the best shot in a sequence and,
provided that they start the sequence in
time, will never have to miss another key
shot again.

Casio has already taken the synthesis of
photo and video capture to a new level 
with its ‘Prerecord Movie’ functionality, which
feels like genuine moving picture magic. What
actually happens is that the camera
continually updates a buffer that stores up to
five seconds of movie images. When you start
movie recording, these images are stored,

followed by real-time movie recording, which
means you never miss an important shot
because you pressed the record button too
late. Nikon has been quick to catch up with
the ‘Smart Photo Selector’ built into the 
‘1’ series of cameras.

This kind of technology frees photography
from its apparently immutable ‘capture the
moment’ niche, and makes the actual
moment at which you press the shutter
button increasingly irrelevant. The negative
side of this development is that
photographers, rather than selecting shots
carefully, keep up a kind of ‘sustained fire’ in
the hope that one or other of the captured
frames will fit the bill – a truly awful scenario
for many photography enthusiasts.

Photo/Video Synthesis

Photo meets Video: the ‘Prerecord’ mode built into some of Casio’s Exilim cameras records burst sequences
in the camera’s internal memory buffer if you keep the shutter button pressed halfway, enabling you to
record a clip and choose the best part later. Some cameras can merge the frames in a short video sequence
into a single photo, enabling you to effectively capture movement in a still image, as shown here.

The ultra-wide-angle shot of the crowded church is a simple task for the
software to master – panorama software has been able to create this kind

of image for years. Our hero e-mails it to the local store, where he can
collect his prints a few minutes later from the machine outside, even
though it is Sunday and the store itself is closed. Thanks to his camera’s
8K video format, he can also make some high-quality large-format prints
from his footage of the party. The best bits show the bride’s father falling

into the wedding cake in a moment of high jinks. Moments like this can’t
be predicted, so it was just as well he was shooting in video mode,

otherwise he would have missed the best photo opportunity of the day!

Looking into the
Future #3
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Traditional photos are still limited by their
two-dimensionality and their inability to
suggest depth except by way of selectively
placed blur. The usefulness of depth data goes
way beyond the ability to create stereoscopic
photos and videos (see Issue 5 of c’t Digital
Photography), for which the term
‘three-dimensional’ is something of a
misnomer. Conventional ‘3D’ images don’t
actually show the sides or back of the objects
they represent, but the industry is working on
this shortcoming too.

The first step toward recording true 3D
image data is reliably capturing the distance
between the sensor and the object reflecting
the beams of light it records. Stereoscopic
techniques are not suitable because they first
have to find matching points in each partial
image before the corresponding subject
distance can be be calculated by means 
of the offset between the two. True
three-dimensional data recording requires a
completely new approach to data capture.
The techniques that exist today are based on
capturing of sequences of images. The
‘moving depth’ approach (realized by the
Microsoft Research ‘KinectFusion’ method,
amongst others) involves moving the entire
camera and extrapolating a 3D model of the
surroundings from the detail shifts within the
frame. ‘Depth from focus’ methods, which
use a stationary camera and varying focus
settings, are much more practical. In this
case, the camera records maximum local
sharpness values throughout the frame and
uses them to calculate the distance between
the camera and individual details. A kind of
automated focus stacking, this concept is
sure to win the approval of macro
enthusiasts.

‘Depth from defocus’ methods are more
ethereal and require the use of complex
mathematical formulae to construct a

three-dimensional image using two or more
differently focused source images. These
methods compare the degree of blur
produced by moving the sensor in tiny
increments (usually a couple of tenths of a
millimeter) along the optical axis of the lens –
an approach that requires extremely
sophisticated stabilizing technology. This
little-known technology has been developed
by Panasonic and is called ‘Half-Sweep
Imaging for Depth from Defocus’.

Active 3D capture with ‘Time of Flight’
(TOF) cameras measures the time taken 
by specially modulated LED light to 
be reflected from its surroundings on a
pixel-by-pixel basis. Alternatively, the
surroundings can be scanned using a laser
beam, which takes longer but is more
accurate. Both methods deliver a depth map
in the form of a ‘point cloud’, making an
additional conventional necessary photo for
reference. 

Although no-one ordered stereo images (the 3D hype of his youth only really took hold in the
video arena), our hero is pleased with the depth map data his camera saved with each

image. Now able to alter the focal point and the depth of field of his images at will, he
immediately composes a few images with the bride and groom in focus and the rest of
the scene nicely blurred. He uses simple two-finger gestures to draw the area that is to
remain in focus, although he could just have set the appropriate distance and aperture
settings on a virtual scale instead. and selects the shape of the aperture separately to

produce a custom bokeh effect. Not until he saves a completely sharp group portrait
alongside his more artistic efforts does he make the annoying discovery that his uncle

apparently has eyes for his cousin rather than for the bridal couple in every shot. To rectify
the situation, he simply selects his uncle’s head and rotates it slightly.

Looking into the
Future #4

The Third Dimension
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Once captured, depth map data can be used to produce various views of an
object. For this technique to work properly, the surface of each object has to
be fully sampled. Details that are partially covered cannot be correctly
reproduced, as the flower in this example shows.



Light Field Cameras

‘Plenoptic’ (or ‘light field’) cameras (see Issue
9 of c’t Digital Photography), which are already
commercially available for industrial
customers (Raytrix) and end-users (Lytro)
achieve the same effect in a similar way. Light
entering this type of camera is captured by a
conventional lens but passes through an array
of microlenses positioned between the lens
and the image sensor. The microlenses direct
light arriving from different distances to
different sensor cells, resulting in multiple
images that provide visual and depth data
corresponding to the details contained within
the frame. The downside of the sheer amount
of data this process requires is a reduction in
resolution by a factor of at least four.

Once you have captured a sharp image
and corresponding depth data for each pixel
you can adjust the focal point and depth of
field at will. Because it reproduces the nature
and position of reflections and shadows

accurately, this technique can also be used to
make realistic-looking adjustments to overall
exposure. In fact, because the depth data for
the structures within the image is known, you
can even adjust the perspective and apparent
shooting position in a light field image. This
type of adjustment ‘stretches’ oblique
surfaces and ‘compresses’ straight ones,
occasionally reducing the quality of the
corresponding details. While this method
cannot, of course, ‘look behind’ objects, it can
be used to ‘rotate’ them, as long as no
important elements are completely covered
up in the original image. Some missing detail
can be retrieved using ‘smart’ interpolation
technology like that built into the Photoshop
Healing Brush tool.

Depth data therefore gives photographers
several new degrees of freedom. Pro
film-makers have been waiting a long time to
be able to adjust focus (or shifts in the plane
of focus) after shooting. Such functionality
would significantly reduce the number of bad

takes and the effort involved in getting a
video shot ‘in the can’. 

Nevertheless, the light field principle is not
the do-it-all solution for producing greater
depth of field. Here too, the real obtainable
depth of field depends on the aperture and
focal length and the size of the sensor used to
capture an image. Greater depth of field
requires a small aperture, which necessarily
reduces the amount of light entering the lens,
thus making the sensor less sensitive. The lens
built into the Lytro camera has a fixed
aperture of f2 across its entire 43-350mm
zoom range which, because of the small
sensor, equates to an equivalent full-frame
aperture of f10. But even this relatively small
aperture cannot capture all distant detail in
sharp focus. Raytrix cameras use three
different types of microlenses optimized for
different applications. The current generation
of light field cameras uses conventional lenses
to capture light, which makes their bodies
quite bulky. Maybe this will change too.
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Raytrix light field cameras produce a conventional
two-dimensional image and a ‘depth map’, which we have
colored here to emphasize the multiple layers it contains

The Future of Imaging | The Third Dimension
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Raytrix light field cameras are squarely
aimed at industrial users. The current
top-of-the-range R29 model has a
29-megapixel medium-format sensor that
produces images with an effective
resolution of 7.25 megapixels, which is
simply not sufficient for a demanding
shoot. Pro photographer Martin Haeusler
has developed a technique that combines
multiple DSLR and Raytrix cameras that
shoot simultaneously. The DSLRs capture
high-resolution stereoscopic images, while
the Raytrix cameras capture the
corresponding depth data. He then uses a
powerful computer to produce spectacular
3D images of his subjects, which he prints
at life size using lenticular techniques to
preserve the 3D effect. As well as
producing 3D images, Haeusler uses his

data to refocus images after shooting, as
shown in the lower two images on the
right.

He has also conducted experiments with
his own ‘microraster’ light field devices,
which he builds using components from
several dismantled medium-format digital
cameras. However, the quality of the
resulting images is only sufficient if he uses
custom microlens arrays and sensors,
which are hugely expensive to build. Major
camera manufacturers have shown some
interest in the project, but have yet to
commit any resources to further
development. Haeusler’s techniques will
probably remain an exotic footnote in the
history of 3D photography – unless, of
course, an agile and ambitious company
such as Lytro decides to take up the
challenge.

High-end Light Field Imaging

Light field cameras capture multiple
images of the same scene at a slight 
offset (left), and can be used to create
stereoscopic images, albeit with a very
small stereo base and a correspondingly
weak stereo effect. Martin Haeusler has
developed a technique that employs
multiple cameras to produce a much
‘deeper’ 3D effect. This is illustrated in the
two images above, which you can ‘merge’
by looking ‘through’ them.

The two images below were focused
after shooting. Focus is centered on

the toe of the model’s shoe in the
left-hand image and shifts to her face

in in the right-hand one.
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Insect Eyes

Constructed to imitate insects’ eyes, digital
compound eyes also use microlenses to
create multiple images on the camera’s
sensor. Because this approach doesn’t
require a lens large enough to illuminate the
entire sensor, it can be used to build really
slim cameras. The engineers at the
Fraunhofer Institute of Applied Optics in
Jena, Germany have managed to build a
prototype digital compound eye that is 
just 1.4 mm thick, which is ideal for use 
in smartphones and other portable
applications. Because the partial images
captured by the microlenses overlap even
though they are captured from slightly
differing persepctives, they can be used to
produce enhanced-resolution images that
include additional depth data. 

Once again, using multiple lenses reduces
image quality, and the prototype shown in the
illustration below uses a 3-megapixel sensor to
capture images with VGA (640 x 480-pixel)
resolution. The Fraunhofer researchers have

already developed a similar sensor for
capturing 720p video. The individual
microlenses have a focal length of 0.8 mm and
the compound lens has an angle of view of 
70 degrees (i.e., equivalent to a moderate
wide-angle). The physics of the design prohibit
the use of larger, smaller or zoomable angles
of view, but nevertheless enable the
construction of extremely flat cameras that do
not require any moving parts to focus.

Matrix Calling

Whichever mathematical tricks and
sophisticated optics you use, it is still
impossible to create a true 3D image without
looking at the backs of the objects you want
to depict. The same is true of holography,
which can only reprode angles of view that
have actually been recorded. In other words, if
the photographer is to be freed of the
restriction of a specific standpoint, the camera
has to be able to capture data from every
imaginable angle.

This approach has been realized using a
huge circular array cameras with shutters that
are fired simultaneously. The resulting ‘bullet
time effect’ and was used to great effect in the
‘Matrix’ movies, where the film-makers used
multiple stills cameras fired in sequence
milliseconds after one another. The resulting
images were then put together by a computer
to produce an effect equivalent to a slow
motion clip that had been decelerated by a
factor of 500. The extremely accurate planning
and preparation required make it almost
impossible to alter perspective or focus after
the event. Such finesse would only be possible
if all the cameras in the array were used in
burst or video capture mode.

Pans through ‘frozen’ or extreme
slow-motion scenes are thus a question of how
much hardware is available, and you can
achieve similar effects at a fraction of the 
cost of the Hollywood version using
video-equipped compact cameras. There is
already some impressive footage on the Web
of surfers captured using an array of
waterproofed GoPro cameras, and you can
evenuse a single high-speed camera to
simulate the bullet time effect by moving it 
to follow the precise route taken by the
subject. The technicians at the German 
special effects company The Marmalade
(www.themarmalade.com) use an
ultra-controllable robot arm mount to shoot
slow-motion scenes. 

Main aperture array

Microlens array

Spacer

Glass substrate
with aperture 
arrays to suppress 
stray light

Schematic cross-section of a digital
compound eye. The offset between
the four aperture grids determines

the angle of view for each microlens.
The greater the parallax between

neighboring images, the more
accurate the resulting depth data.

A light field camera uses a microlens
array to separate the incoming image
into multiple micro-images before 
it reaches the sensor. The offset
between neighboring micro-images 
is then used to calculate the
corresponding distance data.
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Photoshop epitomizes the kind of high-end
image processing software that most
photographers would like to have, but is too
expensive for many to consider. The program
costs as much as a mid-range DLSR and comes
in two versions, both of which have left their
clientele feeling dissatisfied. The pro version
includes an enormous range of tools and
functions that no-one really uses to the full,
while the much cheaper ‘hobby’ version of the
program, Photoshop Elements, lacks some of
the fundamental functionality that is essential
to the modern image processing workflow.
Nobody has yet come up with a pricing model
that enables you purchase individual tools for
a reasonable price, but things are changing
rapidly in this respect too, and the future of
image processing promises a world without
conventional programs and a significant shift
toward needs-based software usage and
pricing. Before long, we probably won’t have
to actually install software on our own
computers and will only pay for the
functionality we really need.

Adobe’s ‘Creative Cloud’ model has taken
the first step in this direction, although the
current approach only replaces the purchase
of a conventional software license with a
subscription payment model that includes
cloud-based disk space. The only customers
who really benefit from this model are pro
users who always need the latest version of
the software. Hobby and occasional users
are faced with much higher costs and are
obliged to subscribe to software that they
don’t need in order to have access to one or
two basic functions. The ability to carry on
using an old, amortized version of the
program will disappear with time, and the
market for used software is also destined to

vanish. The new approach turns software
that can be bought and owned into a service
that is only available for as long as the
customer continues to pay, in the form of
money or annoying adverts.

Even if it is stored in the cloud, Adobe
software and the user’s own data still have
to be present on a local hard disk during use,
whereas other image processing apps such
as Instagram, Hipstamatic and Pixlr are
designed with direct, cloud- and social
network-based processing in mind.
Hipstamatic is a kind of virtual toy camera
that allows you to apply various lens and
filter effects that give your images a
deliberately down-market look. Pixlr takes a
more serious approach, using Flash-based
software to adjust the look of a limited range
of image file types (PSD but no TIFF) in a
browser window. It works with image files
stored on the Web or locally and processing
takes place (as of Flash version 10) on a local
level, wherever the source images are
stored. Pixlr is a full-blown image processing
package with an interface that looks a lot
like Photoshop. Adobe's flash-based
Photoshop Express offers only automatic
tools. The size of images that can be
processed is also limited and the program
sometimes scales images without warning.

The main advantage of browser-based
processing software is that locally stored
files don’t have to be uploaded for
processing and only the tools and effects
you apply have to be transported via the
Web. The limitations of Flash-based
functionality make applications less agile
when applied to images stored in the cloud
and the range of functions you can use also
depends on the computing power available

locally. Server-based ‘back-end’ image
processing takes place on much more
powerful computers, although these
machines are shared by multiple users. The
bandwidth joining a local machine to the
cloud is still an issue, although the
increasing capacity of everyday Internet
connections should solve this particular
problem within the next few years. Once
image processing has been completely
outsourced to the cloud, users will no longer
have to deal with software installation,
security updates and incompatibility issues.
Who knows, in future our images may even
be processed by poorly paid technicians in
China or India instead of by complex
software. Seriously – we have already come
across magazine and book layout services
that work this way.

As with so many other innovations, the
increased freedom that cloud-based
processing promises also creates new
dependencies. Not everyone feels
comfortable storing important image files in
a place run by someone they don’t know or
at a company that could go broke or decide
to use other people’s images for its own
purposes. Instagram has already tried to
include the right to use its members’ images
in its terms of business. It is also possible
that, once the market is established and the
initial hype is over, the remaining players
will set their prices as they see fit. 

Technological progress is freeing us from
many of the hitherto intrinsic limitations of
the photographic medium. The other side of
this particular coin appears to imply that, in
order to enjoy the resulting luxury, we users
have to relinquish control of the tools we use.
The ‘Matrix’ is creeping nearer! (anm)  c

Cloud-based Services

Everything has gone pretty smoothly so far, although our hero is still rather embarrassed
about missing the the actual high point of the day. But didn’t he read somewhere about a

new cloud service that automatically inserts photos into 3D scenes? (“This month only for
our unbeatable tryout price!”) He gets in touch with all the guests and asks them to upload
their photos and videos to the wedding website. He quickly collects more than 50 GB of
material and uploads it to the new service, selects the highest possible output resolution
and pays US$10. A few minutes later, he receives a download link to a five-second 3D

video sequence made up of 2,000 individual images that can be viewed from every angle
filmed by the party guests and slowed down at will. The online service has adjusted the

color temperature, unified the image and video formats, automatically synchronized the
soundtrack and even improved the image quality using super-resolution. 

Looking into the
Future #5



Some movements, such as a snowboarder’s
monster air, are simply too fast to take in.

Wouldn’t it be great if you could rewind them
and watch them again, step by step? Or how
about that cannonball at the outdoor pool?
That would make a great frame-by-frame
sequence! Other events – your wedding kiss,
for example – are ripe for viewing time and
time again. Whether an emotional moment or
a memorable event, some scenes simply look
better if viewed unhurriedly and precisely –
and slow motion is the answer.

Some camera manufacturers are
beginning to build high-speed functionality
into their products, enabling the user to shoot

at up to 1,000 frames per second (fps) and
producing results that are usually quite
presentable.

We got hold of a BenQ G1, a Casio
EX-ZR200 and an Olympus TG-820, and
checked out the quality of the slow-motion
footage they produce. As a comparison, 
we also captured some footage using a
Canon EOS 60D and ‘slowed it down’ using
Twixtor, a plug-in for various video editing
applications, including Premiere, After Effects
and Final Cut. 

To help us compare the quality of the clips,
we also shot some standard 25fps footage
using a Canon EOS 5D Mark II and some

pro-grade slow-motion footage using a
MegaVis SpeedCam from HSVision.

What is Slow Motion?

Most video clips – including HD – are shot and
played back at a constant frame rate of 25 fps,
which is fast enough to make subject and
camera movements appear smooth and
jump-free during viewing.

When a sequence is shown at a slower
speed – for example, to analyze part of a
sports event – each frame of the sequence is
played back multiple times. This ‘stop-and-go’
process shows a series of snapshots with no
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Kumaran Herold

How to Shoot 

Slow-motion Video 
with a Compact Camera

It used to be complex and expensive to shoot the high-speed footage that
slow-motion sequences are based on, but the digital revolution has changed all
that. Now it’s possible to shoot slow-motion clips on a budget, using compact
cameras and easy-to-use software that give you great results without the need
for professional know-how and specialized gear. To whet your appetite, we have
included some sample sequences on the free DVD that comes with this issue.
Read on to find out how to get started shooting your own ‘slow-mo’ videos.
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intermediate images to fill the gaps between
the individual frames, resulting in shaky and
unnatural-looking movements.

If we increase the capture frame rate, the
camera shoots more frames per second (50 or
100 fps, for example). If these are played back
at a ‘normal’ rate of 25fps, they appear to run
in slow motion. The ‘extra’ frames fill the gaps
and make the slowed-down movements in
the clip appear smooth and detailed (see the
illustration on page 110).

For example, if we shoot three seconds of
50fps footage of a ball thrown into the air and
then play the clip back at 25 fps, it will last
twice as long and the ball will appear to move
half as fast as it did in reality. The action still
appears smooth because we captured twice
as many individual moments while the ball
was in flight than we would have at a standard
frame rate.

High-speed video is often used in industry
to capture movements that are too fast to
view normally. For example, when production
line equipment is filmed at speeds of up to
2,000 fps the footage can be played back so
slowly that any hitches in the machine’s
activity can be analyzed in detail and
corrected as necessary. Specialized high-
speed cameras are even capable of capturing
the flight of a bullet fired from a gun – action
that takes place at speeds of up to 4,000 km/h
(see the sample video on this issue’s free
DVD). High-speed equipment is also used in
advertising and movies to emphasize specific
action.

Capturing ultra-high-frame-rate footage
requires the use of high-end electronics, fast
sensors and smart memory, and the
‘high-speed’ compacts we tested need to be
developed a lot further before they can be
compared with true high-speed gear. Instead
of capturing footage at the usual 25 or 30 fps,
the models we tested capture action at up to
120 fps or, in the case of the Casio, at up to
1,000 fps. However, such high speeds demand
serious technical compromises.

If you want to include a slow-motion
sequence in a clip shot at normal speed, it
helps if your camera supports ‘speed
ramping’, which involves switching to a preset
(faster) frame rate during capture. This helps
to keep transitions from one capture speed to
another smooth and consistent.

Whichever equipment you use,
high-speed shooting requires more light than
conventional capture techniques. The time
available to expose each individual frame
decreases as the frame rate increases,so you
need more light to achieve the same
exposure. You can compensate to a degree by
using a wider aperture, although compact
cameras have fairly limited scope in this
respect. This basically means that slow-
motion sequences are best shot outdoors in
sunlight.

Our Camera Test

Essentially, our test involved checking out
how well ‘high-speed’ compacts deal with

fast-moving subjects. We headed off to a
skatepark with cross bikers Florian Faubel and
Alexander ‘Gismo’ Reisdorff and set up our
test cameras to capture various jumps
simultaneously. Although it was complex to
set up, this approach helped us to capture
directly comparable footage with all five
devices.

We shot our test clips at 120 fps, the
highest frame rate supported by all the test
compacts. The HSVision MegaVis SpeedCam,
which can capture Full HD footage at up to
2,000 fps (and low-resolution footage up
160,000 fps), served as our ‘official’ reference
device.

We also had a Canon EOS 5D MK II running
at 25 fps to help us judge overall image
quality. The jumps we captured lasted about
1½ seconds in real time, so we were able to
stretch the resulting clips to about six seconds
in length at 120 fps.

The 60fps footage that we processed 
using Twixtor was shot using a Canon EOS
60D. For logistical reasons, we had to 
shoot this sequence on a different day, so 
it shows a slightly different scene from the
others.

Comparing stills from a video clip is not a
realistic way to compare the quality of the
footage, so we have included all our test clips
on this issue’s DVD for you to view and
compare at leisure. We have also included
clips captured at between 1,000 and
160,000 fps using the MegaVis camera kindly
loaned to us by HSVision.
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Capture 0.05 s 0.10 s 0.15 s

Sequence 1 
(100 fps)

Sequence 2 
(50 fps)

Sequence 1 
(25 fps)
Normal speed

1a 1b 1c 1d 2a 2b 2c 2d 3a 3b 3c 3d 4a 4b 4c 4d

1a 1c 2a 2c 3a 3c 4a 4c

1a 2a 3a 4a

Playback 0.2 s0.1 s 0.3 s 0.5 s0.4 s 0.6 s

Sequence 1 
(25 fps)

Sequence 2 
(25 fps)

Sequence 3 
(25 fps)

1a 1b 1c

1c

1d 2a

2a

2b 2c

2c

2d 3a 3b 3c 3d 4a 4b 4c 4d

3a 3c 4a 4c1a

1a 2a 4a3a

This shot shows our test setup in action.
From left, the computer-controlled MegaVis,

one of our DSLRs and the three compacts.

A high-speed clip shot at 100 fps contains four times as
many frames per unit time than the same clip shot at 25 fps.
Playing the 100fps sequence back at 25 fps results in a
sequence that lasts four times as long as the original.
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BenQ G1

BenQ’s G1 produces colors that are much
more saturated than those captured by any of
the other models we looked at. The clips we
captured nevertheless displayed blocky
artifacts that are especially obvious in the
asphalt in our test sequence. As well as
producing relatively high levels of noise and
stripe artifacts in the clouds, the camera had
trouble metering for backlight. The footage is
generally very high-contrast, lacks shadow
detail and shows obvious blooming at
high-contrast edges. In spite of these
shortcomings, at 120 fps the G1 produced
acceptably smooth slow-motion clips with
good detail.

The BenQ has just one high-speed frame
rate and, like the Casio, captures VGA video
with a 4:3 aspect ratio. The image size is set
automatically to 640 x 480 and sound is
turned off when you switch to high-speed
mode.
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These screenshots are taken from the
120fps high-speed sequences we shot
using our test cameras and the 
comparison clip shot using our Canon EOS
5D MK II. 

Because of their 4:3 VGA resolution, the
BenQ G1 and the Casio EX-ZR200 offer
conspicuously lower quality than the other
cameras, which all capture 16:9 Full HD
footage.

Canon EOS 5D MK II

BenQ G1

Casio EX-ZR200

Olympus TG-820

HSVision MegaVis
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Twixtor is a plug-in designed for creating
speed-adjusted sequences from video clips
shot at normal speed. It is available as a free
trial version at revisionfx.com and for
US$330 at the manufacturer’s online store.
The trial version inserts a watermark into
processed clips. 

To create a high-speed clip from normal
footage, Twixtor generates new frames for
insertion between the existing ones by
tracking the movements present in the
action. This ‘motion estimation’ is easier to
achieve for simple, straightforward
movements but quickly reaches its limits
when confronted with complex or
multi-directional action.

The plug-in is compatible with a range of
popular editing applications and we
generated our sample sequence using
Adobe Premiere. The process is simple, but
the quality of the results depends very
much on the frame rate of your original
material.

Our original clip was shot at 60 fps in
1280 x 720-pixel HD. Our experiments
showed that footage shot at 25 fps showed
more obvious artifacts once processed than
footage shot at a faster frame rate,
especially if the original clip contained
complex background detail or movements.
This is because the software has to
generate more ‘in-between’ frames for
complex source material.

The following sections describe the steps
necessary to convert an original clip into a
slow-motion sequence using Twixtor. 

Once you have imported your original
material, open a new sequence with an
appropriate name (‘original_material’ for
example) and drag it to the timeline. 

Generating the new frames takes a lot of
computing power, so it is advisable to
select just a small portion of the original
film for conversion. To do this, generate a
selection from your chosen excerpt, copy it

and insert it several times into the timeline.
The total length of the copied excerpts
determines the length of the resulting
slow-motion sequence.

Now open another new sequence and
name it ‘twixtor’ (or something else
appropriate) and drag the
’original_material’ sequence to the ‘twixtor’
timeline. The raw material is then displayed
as a single new clip. Now select Twixtor
from the Effects panel (at bottom left) and
drag it to the clip in the timeline.

You can now customize the effect’s tool
settings. Make sure that the Input Field
option is set to None. Speed is set using 
the Output Control options – the Default
setting is 100% (i.e., the original speed), 
so setting it to 50% will create a new
sequence at half speed.

Once you have made your settings, the
new sequence can be rendered using the

Slow-motion Software

The selection for the slow-motion sequence is copied multiple times to the timeline
and the total length determines the length of the resulting clip
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Sequence > Render Effects in Work Area
command.

If the new clip repeats itself, this means
that the copied clips were too long. The
simplest solution here is to edit out the
part of the rendered clip that you need. If
the new clip is too short, you will have to
increase the number of clips in the
‘original_material’ sequence and repeat
the rendering process.

Each new clip presents Twixtor with a
unique set of challenges, so you will have
to experiment with the output options
until you find the combination that
produces the effect you are looking for.

Once you have created a new sequence you can apply the Twixtor effect to it. The new
slow-motion sequence then appears next to the original in the program window.

There are various parameters you
can adjust to optimize the look of

the final slow-motion sequence



When you switch to high-speed mode, the
camera takes a quick break and displays a
black monitor image before starting the
actual capture process, making it unsuitable
for capturing spontaneous slow-motion clips.
As with the Casio, the BenQ firmware sets the
aperture and focus settings automatically
before you begin shooting, but does allow
you to check your results immediately on the
camera monitor.

Casio EX-ZR200

Casio’s slow-motion effect is extremely good,
offering high image quality in spite of
relatively low (640 x480) resolution and overly
high contrast. Its high-speed frame rate can
be set to one of four speeds between 120 and
1,000 fps, although resolution decreases
steadily with increasing speed. At 1,000 fps,
resolution is a measly 224 x 64 pixels.

Apart from the material shot at the default
(30fps) frame rate, which can be played back
in 16:9 Full HD, the Casio’s other frame rates
can only be played back using a 4:3 aspect
ratio. The EX-ZR200 is the only compact we
tested that offers built-in speed ramping, and

its two settings (HS 30-240 and HS 30-120)
ensure smooth transitions between normal
footage and slow-mo sequences.

Sound is automatically switched off while
shooting in high-speed mode, although the
30fps parts of ramped sequences still record
sound.

Reaction time when switching to
high-speed mode is less than one second,
which compares favorably with the other
compacts and makes it possible to shoot
spontaneous high-speed clips when an
opportunity arises.

Focus can no longer be adjusted once you
have started shooting a high-speed sequence,
and aperture and focus are both set
automatically. The results are available for
in-camera viewing immediately after shooting.

Olympus TG-820

In contrast to the other two compacts, the
Olympus TG-820 doesn’t save its high-speed
sequences as movies, but instead saves a
sequence of 100 3-megapixel images shot at
an equivalent frame rate of about 60 fps.The
camera takes several seconds to save a

sequence before it is ready to shoot another. 
The recorded images have to be turned

into a video clip using computer-based
software such as Quicktime 7 Pro or Premiere
Elements. A sequence of 100 source images
played back at 25 fps equate to a four-second
slow-motion clip. This means that the TG-820
is only suitable for capturing short sequences
and requires more precise timing than the
other two compacts if you want to be sure of
capturing the right moment. The longer
sequences captured by the BenQ and the
Casio enable you to edit your sequence to
length post-shoot.

On the upside, the Olympus multi-image
approach allows you to create sequences in
16:9 Full HD quality, resulting in the best
slow-motion clip quality in our test. Its
contrast characteristics are very good and the
clips show good detail throughout the frame.

The relatively slow frame rate of 60 fps
means that the Olympus slow-motion effect
is not as pronounced as the one produced by
the other two cameras. The monitor can only
display individual images from the sequence,
and moving pictures are only available once
they have been processed on a computer.
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The Casio EX-ZR200 captures clean VGA slow-motion clips and
support speed ramping. Its overall video quality is acceptable.

The BenQ G1 captures VGA clips at 120 fps. The resulting
slow-motion sequences are smooth and detailed, although
they do include some blocky artifacts.

The Olympus TG-820
shoots a sequence of 100
3-megapixel images that
you have to convert to
video on a computer. This
approach means that the
resulting clips are very
short.

We used the pro-grade
MegaVis from HSVision to
shoot reference material. 
This high-end device can capture Full HD
footage at up to 2,128 fps.



HSVision MegaVis

The MegaVis served as our reference camera,
and delivered top-notch slow-motion
sequences to compare with our test
sequences. This pro-grade machine delivered
clips of much higher quality than our test
compacts, with less noise, greater dynamic
range and stepless shooting speeds of up to
2,128 fps at Full HD (1920 x 1080) resolution.

The MegaVis is controlled via a laptop
using custom software, and clips are saved as
a sequence of individual RAW images that are
converted to TIFF format before being
merged into a single sequence. This takes
longer than direct capture, but provides a
greater range of exposure settings and the
ability to adjust colors and tonal values after
shooting. This high-end device was designed
for industrial and commercial use and is often
used to produce advertising and music
videos. Complex handling and prices that 
start at around US$75,000 make it suitable 
for professionally-shot clips but not for
spontaneous, everyday use.

Canon EOS 60D with Twixtor

A combination of homogeneous
backgrounds, high frame rates and short
exposure times (to avoid motion blur)
produced perfectly good results from all of
our test compacts. Twixtor is a great
alternative way to achieve similar results,
allowing the user to set the playback speed
and generate speed ramps after a clip has
been captured. Processing footage takes time,
and you have to be willing to experiment with
the program’s various parameters if you want
to get the best out of the software (see the
Slow-motion Software section on page 114).
We processed our test sequence once using a
speed setting of 50% (i.e., half the original
speed) and again using a setting of 20% (one
fifth speed). The resulting clips show no
appreciable loss of quality compared to the

original, although the program had some
issues when dealing with extreme
movements. In such cases, the extra frames
that were generated to fill the gaps between
the originals were not generated cleanly and
produced artifacts at the bottom edge of the
frame, creating an effect that is similar to that
produced by early flat-screen TVs.

Conclusions

To capture high-speed video successfully, the
sensor in a compact camera has to be capable
of reading and saving data faster than it 
does when shooting in ‘normal’ video mode. 
To make this possible, our compact test 
models scrimp on resolution, leaving us with
a mere 640 x 480 pixels (4:3) at 120 fps. The
main effect of this reduction in quality is a
corresponding lack of quality in the
slowed-down clip. Viewed enlarged on a TV

screen, the clips showed obvious noise and
other artifacts. Generally, the clips shot using
the compacts are fine if viewed in a small
window on YouTube or other Web platforms.

Other than that, our slow-motion clips
displayed smooth, detailed movements that
were easy to follow in spite of the auto-only
shooting settings the cameras use. 

The Twixtor results are generally not as
smooth as the ‘real’ in-camera clips, but there
are various options for tweaking your material
once it is in the bag. The only prerequisite is that
the footage you process is captured using a
high-quality camera. The software also supports
the generation of custom speed ramps. The
only real downside is its US$330 price tag.

For photo enthusiasts, slow-motion video
clips are an interesting and creative way to
enhance sequences of still images, and they
also make a fun addition to anyone’s everyday
photographic repertoire. (pen)
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HIGHSPEED VIDEO CAPTURE
Manufacturer BenQ Casio Olympus HSVision RE:Vision/Canon

Model G1 EX-ZR200 TG-820 MegaVis Twixtor/EOS 60D

Sensor size 1/2.3" (CMOS) 1/2.3" (CMOS) 1/2.3" (CMOS) 22.2 x 22.2 mm APS-C (CMOS)
Stills resolution 14 megapixels 16.1 megapixels 12 megapixels 4 megapixels 18 megapixels
Lens 24-110 mm 24-300 mm 28-140 mm Interchangeable (Nikon F) Interchangeable
Max. video resolution 1920 x 1080 / 30 fps 1920 x 1080 / 30 fps 1920 x 1080 / 30 fps 2016 x 2016 / 1102 fps 1920 x 1080 / 30 fps, 1280 x 720 / 60 fps
High-speed frame rates 60 fps, 120 fps 120 fps, 240 fps, 480 fps, 1000 fps 60 fps (for approx. 2 s) 40 fps – 161,290 fps 

steplessly variable
Variable via software settings

Speed ramping – 30 > 120 fps, 30 > 240 fps – Custom, stepless Custom, stepless
Resolution at 120 fps 640 x 480 640 x 480 1920 x 1080 (60 fps) 2016 x 2016 1280 x 720
High-speed aspect ratio 4:3 4:3 16:9 1:1 or 16:9 16:9
Direct high-speed playback v v – v not applicable
Price (approx.) US$280 US$230 US$230 US$75,000 US$330 (software), US$900 (camera)

vˇincluded               –ˇnotˇincluded

We shot a sequence at 60 fps
with our EOS 60D and slowed it
down using the Twixtor plug-in
with Adobe Premiere

c
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Composing with Color
Shooting color photos means using the using the endless colors of life 
to capture a balanced image. The only way to succeed is to consciously
manipulate shape and color like a painter, and this article tells you how.

Vast numbers of people around the
world take photos every day, but only

rarely does anyone take the time to consider
the visual language that each image
‘speaks’ – a language that follows virtually
the same rules as classical painting.
Photographers who wish to compose their
images this way face an enormous challenge
in that the myriad colors that make up
everyday life often look chaotic and
discordant if they are simply recorded
without regard for composition. Success in
color photography depends on finding
excerpts from reality that present balanced

shapes and colors and a minimum of
superfluous detail.

This article demonstrates the similarities
between well-composed photographs and
paintings, whether the colors they contain are
‘loud’ and expressionistic (i.e., the primary and
secondary colors blue, red, yellow, green,
orange and violet), or ‘quiet’ and subtle. 

The most colorful photo is not necessarily
the best, because it is the juxtaposition of the
shapes and colors in an image that will
determine whether it is a triumph or a flop.

The following pages go into the theory and
practice of producing great color photos. 
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Colors are not merely instances of
electromagnetic radiation with wavelengths
between 380 nm (ultraviolet) and 780 nm
(infrared), they also have a powerful effect on
the psyche of both humans and animals. Tests
have shown, for example, that a racehorse will
unwind much more quickly after a race if it is
taken to a room that is painted blue rather
than red.

Red: It is well known that looking at the
color red boosts activity in the vegetative
nervous system. The color of blood, red is also
tradtionally seen as the color of love and, in
some cultures, the color of evil. A highly
symbolic color, it is often used in royal

garments, left-leaning political scenarios and
many other everyday situations that
immediately attract our attention.

Green: The painter Vassily Kandinsky
described green as “the most restful color ...
self-satisfied, immovable and narrow.”

Blue represents calm and relaxation too,
but also melancholy. In musical terms, if red
and yellow represent the major scale, blue
and violet clearly embody minor tones. Blue
symbolizes restfulness, loyalty and trust. It
is a matriarchal color that stands for the
bond between mother and child and is
often used for clothing in paintings of the
Virgin Mary.

Violet represents an escalation of blue to
a mystical, almost sacred color. Studies have
shown that violet is a favorite color among
ancient cultures such as that of the
indigenous peoples of central Brazil.

Yellow and Orange are the most joyful
colors and create a warm, cheerful and cozy
mood. Yellow is, after all, the symbolic color of
hope. 

Understanding how colors affect the
viewer‘s state of mind is a great aid to effective
photographic composition – for example, to
help associate a particular mood with a certain
product or brand.
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Colors Trigger Emotions

The robes worn by Buddhist
monks are often colored a
deep red similar to that of
Roman dignitaries’ togas.

Combined with yellow and
orange, this produces a

dignified but also friendly
and cheerful effect. 

Red is the most stimulating color in the visible
spectrum. This photo of the sky above Kathmandu
is quite dramatic and combining red with black
helps prevent it becoming kitschy. We will go into
why most red-tinged sunrises and sunsets look
clichéd later on. 
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Many people are unaware of the extent to which colors can affect their state of mind. 
Red is the most stimulating color, yellow the most joyful, green the calmest and violet the one that best
suggests depth. Blue can produce a sense of melancholy, while orange – like yellow – embodies vitality.



Colors can be combined harmoniously but
can also clash with one another. The color
wheel invented by Swiss painter, designer and
Bauhaus lecturer Johannes Itten helps to
identify which of these scenarios will be the
case. 

Itten’s invention is a schematic
representation of the three primary colors
(red, yellow and blue), the three secondary
colors (orange, green and violet) produced by

combining two primaries and the six tertiary
colors obtained by mixing primary and
secondary colors. 

Itten is also credited with inventing the
color contrast theory illustrated below. The
examples on this page demonstrate the
principles of cool/warm and complementary
color contrast, while those opposite
demonstrate qualitative and quantitative
contrast.
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How Color Contrast Works

The image on the right shows the summit of
Mount Annapurna in the Himalayas. The
orange-tinged sunlight and the blue of the sky
demonstrate the principle of cool/warm color
contrast. This is also an example of
complementary contrast, as the two colors are
located on opposite sides of the color wheel. 
The smaller image above also contains a
complementary contrast between the purple of
the door and the yellow of the wall. Goethe’s
Theory of Color speaks of the human need for
visual perfection and designates complementary
colors as opposites that provide ‘perfect’ colors
when mixed. This theory is backed up by
experience, which shows that if we look at a
color for long enough, our mind really does
convince us that we are also looking at its
complementary color.

Johannes Itten’s ‘Farbkreis’ (color wheel)
shows the relationships between primary,
secondary and tertiary colors
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These two images show examples of
quantitative contrast between yellow and
blue. In the left-hand image, yellow is
spatially and therefore also visually
dominant, while the right-hand image
shows a balanced contrast between the
yellow of the taxi and the blue of the early
evening light.

Quantitative contrast is based on the
strength, and consequent dominance, of a
specific color or colors. The effect is caused
by the amount of physical space taken up 
by the dominant color and the relationship
between the strengths of the colors
involved. Pairs of colors have varying relative
strengths and can be roughly expressed in
numbers as follows: yellow = 9, orange = 8,
red = 6, green = 6, blue = 4 and violet = 3. 

Qualitative contrast occurs when pure and impure colors are juxtaposed. Pure colors are
brighter than impure colors and thus dominate where both are present. This means that a
small area of pure color is much more striking than a larger area of impure color that
surrounds it. In the image above, for example, the neon artworks are much more obvious than
their surroundings even though they are quite small. 



Considered theoretically, a photographer’s
task is to create interesting compositions using
the colors of the visible spectrum. To do so
successfully, it is essential to understand how
fundamentally the time of day, the weather
and the season affect the impact of a color
photo. Daylight can have a whole range of
color temperatures. Its orange component is

particularly strong at sunrise and sunset, while
the periods just before sunrise and just after
sunset are dominated by cooler blue tones. 

Cloudy or overcast weather produces the
most accurate color rendition and is the
favorite of artists who wish to ‘objectify’ their
subjects as much as possible. On the other
hand, midday sunlight and blue sky have a

much stronger blue component and often
makes objects look pale and lifeless.

You can always use software to alter the
color temperature of an image after shooting,
but this often produces unnatural-looking
results. It is always more effective to keep an
eye out for particular lighting moods and use
them deliberately to create a specific effect.
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The Color of Light

Above: Unusual moods created by cloud and sunlight such as this scene
in Kathmandu, Nepal, are extremely short-lived and have to be captured
the moment they occur. Always take a quick handheld shot the moment
you see such a scene, even if the exposure parameters aren’t perfect. 
A steady hand and a wide-angle lens set to its maximum aperture can 
be used to capture spontaneous moments in sufficient detail. If the
situation allows, you can then take your time to compose a more
structured image using a tripod and a smaller aperture.

Below: In the Hoggar Mountains in Algeria, different light
produces two completely different effects. The soft orange
glow lighting the basalt of the mountains looks almost like 
bold brush strokes. The setting sun gives the forbidding
landscape a magical look that belies its true nature. 

Another way to make this landscape seem benign is to 
use backlight at sunrise. In the second photo, the same scene 
is bathed in blue-tinged early morning sunlight shining 
through thin cirrostratus clouds. The resulting effect is quite
other-worldly and is much less ‘gushing’ than traditional 
sunrise or sunset compositions.



123c’t Digital Photography 14 (2014)

Color Photography | Tone on Tone

We have already seen that it doesn’t always
make sense to shoot ultra-colorful images –
color photography is much more about using
the camera to filter reality so that the final
image comprises a consciously composed set
of colors. The well-known photographer
Robert Haeusser once said that painting is an
additive imaging process that compounds
colors and shapes to produce the final image,
whereas photography is a subtractive art form

that selectively extracts shapes and colors
from reality. In other words, we aim to capture
a range of colors that are located very close to
one another on the color wheel. Many
classical painters were aware of the
effectiveness of painting with just one or two
main colors. Rembrandt is famous for his
exploration of an amazing range of brown
tones that he used to frame his brightly lit
subjects, and Caravaggio and Rubens took a

similar approach. Modern artist Antoni Tàpies
covered huge canvases with subtle blends of
earthy tones. 

It is difficult to achieve such a degree of
abstraction in a photographic context, as it
involves freeing oneself from the material
world and extracting shapes and colors from
reality to form cohesive, visually satisfying
images. The images below show two
examples of this approach. 

Tone on Tone

Left: This shot, captured on the
island of Lanzarote, makes use of a
range of brown and ocher tones
combined with subtle highlights in
green and an orange sky. The way
the additional colors only become
apparent at a second glance is
exactly what makes ‘tone on tone’
compositions so appealing.

César Manrique, Lanzarote’s
most famous artist, once said that
his home plays host to an endless
range of shades of black. 

Right: When shooting landscapes in color, the
dominant blue of the sky often makes is difficult to

escape from postcard-style clichés. One way out is to
use a ‘tone on tone’ composition, like this one of a
vineyard in Heppenheim, Germany. The vines are

covered with blue netting to protect them from
marauding birds, and the artificial blue tones

combine perfectly with the natural color of the sky
to provide a fresh take on a familiar subject.



The addition of a single colored detail can
make images composed using largely low-key
colors much more effective.

It is never easy to filter the chaos of the
everyday world to compose an image with
precisely the right detail in exactly the right
place within the frame. 

As we have already seen, different colors
differ in intensity, and the primary and
secondary colors of the color wheel (see page
120) are more dominant than tertiary or other
mixed colors. Among the pure primary colors,

red, orange and yellow are more intense than
blue green and violet, so it makes sense to
mirror the techniques used by painters and
combine large, discreetly colored areas with
one or more carefully chosen primary colored
accents. 

Such accents should only take up a small
proportion of the frame if they are to be
perceived as accents rather than dominant
colored shapes. This type of composition
requires a special kind of visual perception,
rahter like the need to ‘see’ differently when

you are searching for the framework for an
image. Color photography requires you to
take the additional step of analyzing the
‘colorfulness’ of the world around you.

Renowned color photographer Ernst
Haas once said that he is actually a painter
who just lacks the patience to paint, which
is why he chose to compose his images
using a camera. Successful photos are often
structured using very similar rules and
notions to those used in the composition of
successful paintings.
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Using Colored Accents

Here too, the obvious red accent contrasts really
‘loudly’ with the otherwise downbeat colors. 
The color is actually part of an illuminated hoarding in
New York that only flashed completely red for a split
second. I composed the image in advance and simply
waited until the advert cycled to the right color. 

A fanfare in yellow: The two pipes form a
line that follows the Golden Ratio and the

sky provides a second, more restrained
colored accent. The remaining rather

washed-out gray and brown tones make
the colors seem more vibrant. 
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Reduction to a minimum is an important
aspect of many visual arts. At the turn of the
20th century, suprematist painter Kazimir
Malevich had already painted a monochrome
black canvas titled Black Square on a White
Ground. At the time, this was seen as a purely
provocative act, although Malevitch was
simply applying the tenets of the suprematist
movement, which entailed a continual
reduction in the variety of shapes and colors
used to construct images. 

‘Reduced’ images are often more powerful
than ones that are filled with excessive detail,

and shooting in black and white was long
considered the best way to make photographic
images less complex and more artistic. Many of
today’s best-known photographic artists have
switched to shooting in color, but they still use
a pared-down range of colors and tones. Even
the high-profile photographic artist Andreas
Gursky uses a computer to adjust the colors in
his images.

Generally speaking, color photography
offers the viewer too many visual stimuli, and
eliminating some of them is an important part
of mastering the art of color photography.

Shooting in dim light – an approach
successfully taken by Bernd and Hilla Becher –
is one way to make your images less colorful.
Shooting using backlight also effectively
reduces the number and breadth of colors,
but it does tend to make the sky look much
brighter than the foreground, especially in
landscapes. In such situations, using a
graduated filter (one of my favorite tools)
often helps to reduce contrast and darken the
sky. Remember too, that shooting pictures of
single-color objects is also an effective way to
reduce the amount of color in an image.

Using Fewer Colors

Gray skies often provide ideal conditions for
taking photos, especially at dusk when the

light takes on a subtle blue tone. Blue is the
only color in this image of a mountain peak

on the island of La Palma. It contains just
three tones: the black of the trees, the bluish

gray of the mountain and the lighter
blue/gray of the sky.

Using backlight is a great way
to reduce the range of colors in
an image and often produces a
slightly mystical effect, as here,
with the sun shining through
the mist. This seaside home in
Brittany looks almost like a
fairy-tale castle. Here, the sun
and its reflection form the
vertical axis of symmetry and
the horizon the horizontal axis.
The promontory on the left
and the waves on the right add
variety to an otherwise rather
static composition.



126 c’t Digital Photography 14 (2014)

Color Photography | Shape and Color

The largely abstract combination of shapes and
colors that makes up an image should itself be
capable of attracting a viewer’s interest,
regardless of the actual subject. A great way to
get a better impression of the basic form of an
image is to rotate it through 180 degrees. This
will help you to see the basic composition
separately from the objects portrayed. 

The painter Georg Baselitz paints many of
his subjects upside down to emphasize the

importance of the brush strokes rather than
the objects they depict. A good photo
should still have a pleasing effect when
turned on its head.

Fine color photos contain a balanced
combination of shapes and colors put
together in much the same way as a painting.
Shape and color can relate to each other in a
number of different ways, the most common
of which are: 

1. ˇShape dominates color.
2. ˇShape and color are perfectly balanced.
3. ˇColor dominates shape.

I strongly recommend that you take the
time to practice shooting images of all three
types. This way, you will discover for yourself
which situations suit a monochrome
approach and which would look better in
color.

Balancing Shape and Color

In this photo of a cityscape in Dubai,
shape dominates color. The strong
backlight makes the colors in the
buildings and the sculpture disappear
almost completely. Only the sky shows
a slight graduation from bluish gray to
washed-out orange. The detail in the
guitar sculpture ensures that the shapes
are interesting to look at and provides
an arresting silhouette that fills the
surrounding space perfectly.

Above: In the top photo, color dominates and the
shapes of the reflected lampshades take on a
secondary role. The primary yellow tone and larger
size of the center lamp also dominate the
secondary orange of the two smaller shades. 
The lower image shows two similarly shaped
oriental arches. The light color framed by the arch
in the fence in the foreground contrasts with the
darkness of the shadowed arch in the wall in the
background, providing a balanced juxtaposition of
shape and color. 
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The filters used most commonly in digital
photography are UV, skylight, polarizing and,
most importantly, graduated filters. 

UV and skylight filters have very little
effect on the amount of light entering the lens
and are often used primarily to prevent lens
damage in everyday use. However, any filter
is an additional optical element that has the
potential to reduce the quality of the resulting
image, so it is important to use the best filters
you can afford and to keep them as clean as
possible at all times.

A UV filter cuts out the ultraviolet light
that often causes a lack of sharpness in distant
details in landscape images.

A skylight filter has a virtually
undetectable pink tone that takes the color

temperature of the image down a notch,
providing pleasant warm tones, especially
under blue sky and in the midday sun.

Filters that provide greater changes in
color temperature are not generally used in a
digital photography context, as the digital
imaging process provides the option of
altering white balance either in the camera or
later during image processing. When shooting
digitally, polarizing and graduated filters are
the ones I reach for most often. 

Graduated filters are ideal for reducing
the contrast between the sky and the other
details in landscape images, especially in
backlit situations.

I usually use a two-stop neutral gray
graduated filter. Any details – skyscrapers or

trees, for example – that are unintentionally
darkened along with the sky can be lightened
to match the rest of the image at the
post-processing stage.

Used correctly, a graduated filter does
nothing more than bring out the existing
detail in a backlit sky. 

Polarizing filters are often used to reduce
reflections from non-metallic objects and to
increase the contrast between clouds and sky
by reducing the amount of non-polarized
light that enters the lens.

Using Filters

Left: A graduated filter helped preserve detail in the clouds
above this disused mine and prevented the highlights in the
sky from burning out

Above : In the photo on the right, a polarizing filter
was used to make the reflections in the windows less

obvious and increase the contrast in the sky
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Photography almost completely replaced the
visual language established by the naturalistic
style of painting favored in the 18th and 19th
centuries. From the advent of impressionism
onward, painting diverged from the
naturalistic style and established itself as a
completely independent – and often
abstract – way way of viewing the world, while
photography became responsible for
portraying the world realistically. 

In due course, photography, too, began to
escape from that constraint and developed

further to embrace the notion of abstraction.
Early examples of this approach were 
the work of Alexander Rodchenko 
at the turn of the 20th century and the famous
‘photograms’ created by László Moholy-Nagy
in the 1920s.

Nowadays, the broad photographic
genre includes all imaginable forms of
abstraction.

But what does ‘abstraction’ actually mean?
The dictionary defines it as ‘elimination of the
concrete’. In other words, abstract thoughts

separate themselves from the world of
everyday objects and begin to take on a life of
their own – and the same is true for images
and imaging processes.

Just as painting is an abstraction by
definition, photography necessarily
reproduces objective reality. Nevertheless,
abstract photography signifies a movement
away from a purely representational way of
thinking. In other words, as soon as the
abstract patterns in an image become its
actual content, photography is no longer

Abstract Photography

This simple shot of a white wall photographed looking
upward toward the blue sky over Lanzarote has its own

distinctive visual language that is worlds away from
traditional postcard-style clichés. Composed entirely of

white, gray and blue angular forms, it is not even entirely
clear which of the shapes embodies the positive and which

the negative aspect of the image, and our brain perceives
the blue of the sky as closer than the white wall.

The textures that have etched
themselves into this old door
over the years make fine
abstract art. Not even Kurt
Schwitters, master of the
abstract ‘decollage’ form, could
have painted a better picture.
Part of the aim of this image
was to retain a hint of
connection with everyday
reality. The composition is
strongly oriented around the
rules of the golden ratio and
the clear structure of the
individual elements contrasts
beautifully with the manifold
organic forms contained within
the frame. 
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concerned with reproducing reality. The
dilemma here lies in the fact that every subject
that we capture photographically has an
abstract structure as its basis. 

Most people are used to concentrating on
the content of an image, even if its
effectiveness depends on the strength of its
underlying structure. 

As we have already seen, you can check
just how effective this structure is by rotating
an image by 180 degrees to loosen its grip on
‘reality’. 

The abstract structure of an image
comprises all the lines, shapes, patterns,
textures and colors it contains. The painter
Vassily Kandinsky, who was a master of
abstract image composition, developed an
entire philosophy surrounding the way
shapes and colors relate to each other.
Kandinsky saw these deliberate
juxtapositions as a creative act.

The art of truly great photography lies in
the ability to see and interpret the abstract
patterns that underpin reality and to frame

each image so that these patterns form a
compelling structure for the image itself. The
subject can either dominate or form a
balance with the underlying shapes.
Alternatively, as shown in the images on
these pages, form can take priority over
content.

Macro situations provide many opportunities to
capture wonderful abstract images. In the image on

the left, the curves in the two fibers form a lovely
contrast with the edge of the palm leaf, which
follows the vertical golden ratio dividing line.

The right-hand image shows a complex shape and 
its shadow, made abstract by separating the details

from the surroundings. 

In the photo on the left, a
double exposure of an
unusual bus shelter and the
sky from an architectural
shot has produced an 
image that has a very cubist
feel to it. The analytically
minded cubist painters
deconstructed their subjects
and painted them viewed
from multiple angles in a
single image.
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Many hobby photographers are satisfied if
they end up with pictures of a sunset, their
kids or some nice, colorful flowers. However,
the more time we spend experimenting
with the photographic medium, the less
satisfactory such everyday images become.
One reason for this could be that sunsets
are simply such awesome events that a
photo of one can only ever be a poor
imitation.

Sunsets, flowers and similar subjects often
look ‘cheap’ or bland when captured in
photos. A department store postcard might
be technically well shot, but lacks depth when
compared with a landscape by Rembrandt or
van Ruisdael. Many photos simply lack ‘that
certain something’ – not in the sense of a
cheap punchline, but rather on an emotional
level that provokes deeper feelings than a
simple “Oh, that’s nice”. 

The French philosopher Roland Barthes
described ‘that certain something’ using the
notion of ‘punctum’, which describes images
that ‘pierce’ the viewer with their beauty.
This difference between bland and beautiful
could perhaps be expressed by the
difference between a person whose natural,
inner beauty shines through and one who
attempts to embody the latest ‘look’ with
the help of make-up or cosmetic surgery. 

Avoiding Clichés

How dull can a photo of an extremely pretty object
be? The photo of a hibiscus bloom above is a good
example, whereas the image on the right, with an
unusually shaped subject and shadows in the
background, is not so trite.

Abstraction is a great way to keep photos of
plants and flowers interesting, and can be achieved
either by heavy cropping or by using deliberate
defocusing effects. 
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Many photos of sunrises and sunsets 
bear witness to the photographer’s lack of
empathy with the subject, and provide a
simple reproduction of a scene that is
generally considered to be aesthetically
pleasing. 

However, it is also possible to
photograph ‘beauty’ in different and
interesting ways. The photographer Karl
Blossfeldt is a great example of an artist who

has developed a unique visual language in
his photos of plants and flowers. His
monochrome images are more reminiscent
of architectural and ornamental imaging
than of conventional floral photos, and are
anything but bland.

Of course, we all love the idea of idyll, but
could it be that ‘idyll’ is a concept based on
false claims? If you look carefully, every
‘paradise’ has its weak spots, just as successful

people have their weaknesses too. A great
photo can be compared with a novel that
reveals its characters’ imperfections, while 
an everyday snapshot is more like a cheap,
dime-store novella with superficial
protagonists and a clichéd story. 

Capturing the feel of
a sunset without

actually portraying 
the sun:

The bamboo leaves in
this mage look like part

of an oriental ink
drawing. The individual

leaves embody a wealth
of shapes, from thin to

full-bodied, overlapped
and forked. The smaller

leaf between the two on
the left provides an

extra detail that attracts
the viewer’s eye. 

Left: A sunset of the kind photographed
millions of times every day. The fact that
photos of sunsets are a dime a dozen
helps to make every such image appear
hackneyed to all but the least
experienced viewer.
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While color photography obviously involves
ordering colors within the the frame, we
cannot afford to neglect ordering shapes too.

Producing ordered images is most
difficult in the context of street

photography, represented here by the
ultimate challenge – the hubbub of a large
city in India. In this case, the architecture and
its inhabitants provide a chaotic, unordered
scene. The streets are overflowing with

pedestrians, bicycles, cars, rickshaws,
animals and carts. It often feels impossible
to produce balanced-looking images of this
type of scene, especially when using a
wide-angle lens. 

Bringing Order to Chaos

In the image on the right, the rickshaw driver and his
passenger are effectively embedded in the frame,
but the surroundings are simply too chaotic. The

driver is not distinct from the background and detail
in the people and buildings behind him adds to the
confusion. The pole in the background also appears

to be ‘growing’ directly out of his shoulder.

The structure in the image on the left is underpinned by
the emphasis on the central vertical axis of symmetry
(see the sketch above). The central pillar in the rickshaw’s
chassis continues the line formed by the telegraph pole,
bringing order to the otherwise random-looking mass of
cables, buildings and vehicles.
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Another way to ‘calm’ the chaos of a busy
city scene is to mount your camera on a
tripod and use a neutral density filter to
lengthen the exposure time. This approach

allows you to ‘melt’ some of the distracting
chaos into movement blur and gives an
image extra vigor.

Below: Varanasi, India. The two boys in the center stood stock still for
the entire three-second exposure while one of the country’s countless
sacred cows passed by in a wonderful whirl of blur.

In contrast, the boy doing a cartwheel in the image on the right
(shot in Timimoun, Algeria) was captured using an exposure time of
1/250 s to ‘freeze’ the action. The triangle formed by the three boys in
the background and the vertical line formed by the subject’s arm and
its shadow provide the basic structure of the image.
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Many people feel a successful portrait should
show young, smiling faces in well-lit
surroundings. However, such images often
appear superficial, and you need to
concentrate on more than just good lighting
to capture effective portraits. Every individual
has their own character and spiritual views, as
well as a relationship with their immediate
surroundings, which have played a key role in
shaping their lives. 

An effective portrait should reveal 
the subject’s character and include any
gestures and physical characteristics that
help to emphasize the context. For the
photographer, this means capturing a
moment that contains all these aspects of
the subject’s character. A quick smile is
usually not sufficient to reveal anything
meaningful about what is going on inside a
person, which is probably why there are so

few portraits of smiling people to be found
in the archives. 

‘Serious’ portraits can be captured both
from a distance and as part of a personal
dialog with the subject. It is always more
difficult to photograph people you don’t
know, and it is tempting to use a telephoto
lens to capture pictures of strangers from a
distance. However, you will always achieve
better results if you approach your subjects

Photographing People

These three images were all captured during conversations
with their subjects. 

While the young monk was explaining his Buddhist faith
to me over coffee, the shadow on his face provided an
interesting accent that successfully interacts with the dark
portion of the chair back on the right.

The lower image is of a Jordanian antique dealer in the
Kreuzberg, Berlin. The bright colors in the background
provided added punch and the tight crop that covers the
subject’s forehead gives the landscape-format image a
slightly unusual look. 

The image on the right shows a Nepalese laborer whose
face and hands bear witness to a life of hard work. Here too,
the color in the headscarf enriches the visual harmony
within the frame.
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and involve them in the image capture
process and engage them in conversation. If
you manage to ask a personal question or
two, your subject is much more likely to reveal
more of their inner self. Only take out your
camera and begin to shoot once you have
engaged your subject.

On a technical note, a 100mm (or
equivalent) lens is still the best choice for
shooting portraits because it allows you to fill

the frame with your subject’s face without
having to get too close. You can, of course,
shoot from greater distances using a longer
lens and, as Cartier-Bresson once said,
concentrate for just long enough to “level the
camera and trap the fleeting prey in your little
box”. 

It takes courage to point a camera at
strangers and you need to be able to get to
the nub of the situation quickly if you are to

capture the right moment without annoying
the subject. If you are ‘discovered’ 
when shooting from a distance, always
approach the subject, show them the image
and ask for permission to keep it. If the
person concerned doesn’t wish to be
photographed, you should delete the shot
immediately. (keh)  c

The young man in the portrait below is a
Canadian film-maker and fashion designer
who I photographed in Berlin. I took this
photo from below to emphasize his
charisma and strong personality. 

This photo of a little girl in a slum in the Nepalese capital,
Kathmandu, is loaded with emotion for me. I was amazed to

find that no-one here begged and everyone I met was
friendly to me. The entire situation moved me deeply.
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Genesis
Fragile Beauty 

Many of Salgado’s photos
of people seem ‘staged’
but this does not make

them any less captivating
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Genesis 

Sebastião Salgado 
Published by Taschen, Cologne 
520 pages 
10 x 15 inches, hardback with 17
fold-outs and a printed dust jacket 
US$49.99 
ISBN 978-3-8365-3872-5

In his previous work, Salgado always critiqued
the here and now. The photos of refugees on

the move and migrant miners in his highly
acclaimed books Migrations and Workers were
a means of expressing his disapproval at the
way things are.

This latest book of photos, Genesis, enters
new territory. Motivated by the success of his
reforestation work in Brazil, Salgado wanted to
get to grips with how mankind and nature can
coexist. The photos tell the story of his ‘time
travel’ back to where life began and his search
for answers from indigenous peoples whose
lifestyles are still largely beyond the reach of
modern society.

The five chapters chart Salgado’s travels to
far-flung corners of the earth, depicting more
than 30 places that he visited during the
eight-year project. Most of the photos are 
black and white and many are also strikingly
grainy, conveying a raw charm that effectively
complements the  awe-inspiring impact of nature.

This approach works particularly well for his
forays into cold, mountainous regions
dominated by snow and rock. Rich in contrast,
these areas are perfectly suited to the means he
has chosen to portray them. But some of the
other subjects, particularly a pair of parrots in a
primeval forest, cry out for color, despite the

fact that Salgado crafts his photos along artistic
rather than documentary lines. Stark contrast is
one of the primary features of these works and
gives some of the landscapes a hyper-real,
three-dimensional feel.

It is easy to criticize the obvious fact that
many of the photos of people in the book are
staged, but Salgado does not see himself as a
documentary photographer but rather as an
artist fashioning a tribute to Planet Earth. In fact,
the portraits are a large part of what makes this
such an entrancing book. Most of us have seen
countless nature photos of Africa and other
places in all sorts of styles, but Salgado’s
portraits – which allow us into the lives of
indigenous people and their relationship with
the natural world – touch us on another level
and make us pause to reflect.

At the cover price, we can definitely
recommended Genesis as excellent value, worth
purchasing even unseen. With 520 large-format
pages and weighing almost four kilos, 
it is certainly a heavyweight volume. For
black-and-white photography buffs, the book
offers dozens of beautiful photos that take us to
the uttermost parts of the earth and face us
with some of the destruction already wrought
by the human race and its terrible lack of
restraint. (tho)



137c’t Digital Photography 14 (2014)

Book Reviews

The importance and greatness of photo
books are often measured using abstract

values such as ’artistic depth’ or ‘relevance to
the contemporary scene’. Anyone taking a first
look at Urban Elements will probably end up
using more mundane criteria: it weighs in at
nearly eight pounds, is more than two feet wide
when laid out flat and takes up the viewer’s
entire field of vision when viewed at a normal
distance. This book makes a serious physical
impression before you even begin to consider
its contents.

A look inside quickly reveals that the book’s
sheer size is not an end in itself. David Koenig’s
photos show details of mostly modern urban
architecture, and each image is an individual
study captured with striking precision and
without any surrounding detail to betray the
actual location. Only locals or those in the know
will recognize the buildings, although the
comprehensive index reveals all to the curious
reader. 

The interchangeable nature of modern cities
is not a new subject and has been documented
extensively over the years. What makes 

this particular book so compelling is the
photographer’s skilled use of the elements of
aesthetic perception.

Koenig applies great expertise in his choice
of angles of view and his framing. His use of
shape and color inescapably draws the reader
into his images without any need for further
refection on their actual content. Once you
have fallen prey to this spell, you can set off on
your own search for your personal favorite
among these visual pearls.

Koenig’s uncompromisingly minimalist
compositions provide valuable insights that will
help many photographers to improve their
technique. 

A third, more speculative level of discovery
involves the question of whether the similarity
between many of the elements of modern
global architecture reveals something about
a culturally-based sense of aesthetics that
forms a bond between humans everywhere.
While it doesn’t deliver specific answers,
Urban Elements raises many intriguing
questions.

(Robert Seetzen/tho)

Urban Elements

David Koenig
Published by Prosperous Printing
235 pages, 137 color photos
Text in English and German
16.8 x 13.7 inches
US$50
ISBN 978-3-8640-7115-7 
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Koenig isolates distinctive
architectural features from

their surroundings and
presents them in a

remarkable new light

The Search for Detail
Urban Elements
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❚ˇOur latest in-depth workshop gives you
plenty of technical tips as well as helping
you to find the right subject for your own
nighttime experiments. As well as working
with conventional cameras, we also check
out a bunch of iOS and Android apps 
designed to keep you shooting when the
light gets low.

Similarity Searching

❚ˇIf you are on the lookout for duplicate
images or you need a photo that is similar 
to one you already have, you need a tool
that supports similarity searching. Visual
search tools also help in the fight against
copyright infringement. We take a look at
the latest search tools and test what they are
really capable of. 

GPS for Photographers

❚ˇIncreasing numbers of cameras have 
either built-in GPS modules or support for
accessory units. Geodata gives photos 
an extra digital dimension and we explain
how geotagging works. We also introduce
the hard- and software you need to tag your
own photos and show you how to work
around some common tagging pitfalls.

Coming up in Issue 15
• • • • •
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